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Welcome to Transform, a powerful, scientific visualization software application t
helps you graphically view and analyze large amounts of data. From color raste
images to contour plots, Transform lets you interact with your data to gain insigh
into it. You can also use Transform to create publication-quality images directly fr
your data.

With Transform, you can analyze and present data in dataset windows or in any
seven graphical display types:

• Color Raster Images

• Interpolated Raster Images

• Line Graphs

• Contour Plots

• Surface Plots

• Vector Plots
Transform Part 1: Introduction 21
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• Histogram Plots (Windows only)

• Polar Plots (Macintosh only)

Transform maintains a constant relationship between all types of graphs on the sc
so you get multiple, coordinated views of your data. Transform was designed to
you analyze two-dimensional data, that is, data with two independent variables (
as latitude and longitude) and one dependent variable (such as temperature or 
itation).

Transform is a highly interactive program with most features only a mouse click
keystroke away. Within Transform, however, is a powerful macro-scripting langu
that gives you explicit control over Transform functions, making it easy to autom
repetitive tasks, such as importing data, manipulating arrays, creating plots, add
labels, and exporting images and data. Transform minimizes the amount of prog
ming necessary to create custom macros by allowing you to convert existing im
into macros that may be directly applied to other datasets.

All of Fortner Software's data manipulation and visualization applications use th
Hierarchical Data Format (HDF), a public-domain, platform independent standa
format for the storage of scientific data, images, and auxiliary information. It is a
object-oriented, binary format capable of storing in one file many different kinds
data objects. Transform uses different HDF object types to store data arrays, no
about the data, images, and other plots. For more information about the HDF for
see Appendix D: HDF Reference.

Transform automatically reads two-dimensional HDF datasets, HDF images, AS
Special, TIFF, FITS, GIF, PICT (Macintosh only) and BMP (Windows only). With
only minor manipulation, it also reads MATLAB 4.0 files. In addition, Transform ca
import matrix and column data stored as ordinary ASCII text and as raw binary 

Transform can open 2D or 3D datasets and images stored in HDF files that wer
ated in Fortner Software's Noesys, a technical data processing application that 
you access, analyze, manipulate, visualize and organize large amounts of multi
mensional data quickly and conveniently.

In addition, macro commands can be sent to Transform from Mathematica, maki
possible to turn Transform into a visual data analysis post-processor. For more 
mation about using Transform with Mathematica® see Appendix B: MathLink to
Mathematica
Transform Part 1: Introduction
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Transform Lets You...

• Import data from virtually any source

• Display two-dimensional arrays in a spreadsheet-like format

• Scale and generate labeled color raster images from the data

• Generate labeled interpolated images from the data

• Create line graphs from any row or column of the data

• Generate labeled contour, surface, vector and histogram (Windows only) plo
from the data

• Overlay one type of plot onto another type of plot

• Re-sample data to a different array size

• Fill missing data points with interpolated values

• Find the data values that correspond to points on an image

• Create and save formulas, comments, and notations with the data to which 
apply

• Apply calculations from internal functions to data in order to generate derive
datasets

• Synchronize points among multiple datasets that have the same dimensions

• Copy rows or columns of data, together with their axis labels

• Export data and graphics
Transform Part 1: Introduction Transform Lets You...
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Getting Started with Transform

This section describes how to install and upgrade Transform.

Installing Transform

Transform is installed with Noesys from the Noesys CD-ROM. For more informa
tion, seeInstallation Guide for Windows and Macintosh included with your Noesys
CD-ROM.

Upgrading Transform

When upgrading Transform, an additional step is recommended. In addition to p
forming the normal installation described above, we recommend that you impor
preferences settings and custom macros from your previous version of Transfor
Importing the preferences settings and custom macros will enable you to upgra
Transform while retaining this information.

If you decide not to import the preferences settings and custom macros, the new
sion of Transform will use the factory default settings.

Windows - Upgrade Preferences from Fortner Software Transform

To import these settings, start Transform 3.4. Once Transform 3.4 is running, fo
the procedures below:

1. SelectPreferences-Settings... from the Edit menu.

2. SelectImport...  from the “Preferences Settings” window.

3. In the Import Preferences window, change the directory to where the previo
version of Transform can be found.

4. If the previous version of Transform is from Fortner Software, change the Fi
of Type pop-up menu to display .frl files. Select the file “Prefs.frl”.

5. SelectOpen.

After step 5, you will be prompted if you would like to import your custom macro
By selecting “Yes”, all of your custom macros from the previous version of Trans
form will be transferred to the new version of Transform.
Getting Started with Transform Transform Part 1: Introduction
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Windows - Upgrade Preferences from Spyglass Transform

The preference file for storing custom macros has changed with the upgraded v
sions of Transform. The old preferences file is called 'Prefs.spy' and it stores cu
macros from Spyglass Transform. The new preference file is called 'Prefs.frl' an
located in the 'Trnsfrm' directory.

If you have custom macros in Spyglass Transform, open Spyglass Transform, s
Edit Macros... from the Macros menu, highlight your macro and select theExport...
command. Export your macros to text files with a .txt extension. These text files
then be imported into Fortner Software's Transform 3.4, by selectingEdit Macros...
from the Macros menu, then choosing theImport... button from the Edit Macros dia-
log.

Power Macintosh - Upgrade Preferences from Fortner Software
Transform

Transform 3.3 stores its preferences and macros in the "Transform Prefs" file loc
in the "Hard Drive:System:Preferences:Fortner Research" folder.

Transform 3.4 also stores its preferences and macros in the "Transform Prefs" fi
which is now located in the "Hard Drive:System:Preferences: Fortner Software"
folder. To preserve your old preferences or custom macros you can simply copy
"Transform Prefs" file from the "Fortner Research" folder to the "Fortner Softwar
folder before you launch Transform 3.4. If you do not have a "Fortner Software"
folder you can create one or you can launch Transform 3.4, then copy the old file
the folder, replacing the one that is there.

Power Macintosh - Upgrade Preferences from Spyglass Transform

The preference file for storing custom macros has changed with the upgraded v
sions of Transform. The old preferences file is called ‘Spyglass Settings’ and it st
custom macros from Spyglass Transform. The new preference file is called ‘Tra
form Prefs’ and is located in the 'Fortner Software' folder inside the 'System:Pre
ences' folder.

If you have custom macros in Spyglass Transform, open Spyglass Transform, s
Edit Macros... from the Macros menu, highlight your macro and select theExport...
command. Export your macros to text files with a .text extension. These text files
then be imported into Fortner Software's Transform 3.4, by selectingEdit Macros...
from the Macros menu, then clicking theImport...  button from the Edit Macros dia-
log.
Transform Part 1: Introduction Getting Started with Transform
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About this Manual

TheTransform User's Guide and Reference Manual presents information in four
parts:

Part 1, Introduction, Chapters 1-2

Part 2, Tours, Chapters 3-8

Part 3, Reference Manual, Chapters 9-24

Part 4, Appendices, A-H

Part 1, Introduction , describes Transform's capabilities, how to use the manual, h
to install Transform, how to register, and how to contact technical support repres
tives.

Part 2, Tours, shows you how to use Transform. You should be able to complete
tour in an hour or two. Keep in mind that the tour provides only an introduction t
how the program operates. If you would like more detailed information on speci
features, please refer to the appropriate chapters in the reference and appendix
ters. After completing the tour, you should be able to proceed with your own dat
analysis on at least a basic level.

Part 3, Reference Manual, focuses on four main concepts:

• The data window and how to manipulate its settings

• Data formats and how to import files

• Image windows and how to create images from data

• Methods for preparing data and using macros

The Reference Manual details ways in which you can manipulate Transform to 
your needs. It also describes how to better analyze your data to take fullest adva
of Transform's capabilities.

Part 4, Appendices, further develop previously discussed ideas or introduce the
interaction of Transform with other available software.
About this Manual Transform Part 1: Introduction
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The Tour and Reference Manual use examples based on the following sample d
files, which are provided on the CD. These files can be found in the ‘Transform\S
ples’ folder.
Transform Part 1: Introduction 27
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Sample Data

This section describes the sample data used in the Tours. The files and director
described in this section are stored in the ‘Transform\Samples’ folder.

Monthly Temperatures

All the data in the ‘Monthly’ folder was obtained from the U.S. Weather Service. T
files contain a 12-column by 40-row array listing average monthly temperatures
Fahrenheit from 1936 to 1975. Included are four files:

• sprngfld.txt. This array shows the average monthly temperatures for Springfie
Illinois.

• Avg_S.txt. This array also contains a 12-column by 40-row array, but every r
is identical, containing the monthly temperatures for Springfield averaged ov
the 40-year timespan.

• chicago.txt. This array shows the average monthly temperatures for Chicago
Illinois.

• Avg_C.txt. This array also contains a 12-column by 40-row array, but every r
is identical, containing the monthly temperatures for Chicago averaged over
40-year timespan.

Thunderstorm

The ‘Tstorm’ folder includes four HDF files containing a slice of a three-dimen-
sional, numerical simulation of a thunderstorm. The slice is a horizontal cut thro
the base of the storm (near ground level). The grid is 75 km on an edge. The xvel
yvel.hdf, and zvel.hdf files are the X, Y, and Z components, respectively, of wind
speed on a horizontal slice from the thunderstorm simulation. The vort.hdf file re
sents the wind vorticity on the same slice. Authors: Dr. Louis J. Wicker and Prof
Robert B. Wilhelmson, National Center for Supercomputing Applications.

U.S. Weather

The ‘Weather’ folder contains an ASCII text file (weather.txt) of weather informati
from reporting stations across the United States on January 2, 1991. The first th
lines consist of descriptive information including the names of the data columns.
data has 694 entries, one per line. Each line has the location of a reporting stat
horizontal and vertical coordinates and 5 recorded values from that site. If no da
a particular type was available for a location, the value for that data type is entere
Sample Data Transform Part 1: Introduction
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-99. The columns are in order: horizontal map coordinate, vertical map coordina
temperature ( F), dewpoint ( F), pressure (mb), East-West wind speed (m/s), and
North-South wind speed (m/s).

• weather.txt. This is an ASCII Text column file of U.S. Weather.

• temp.hdf. A filled, interpolated version of the temperature data from weather
and includes contour and U.S. Map overlays.

• us_map.hdf. Consists of a blank dataset with an overlay of a continental US

Hydrogen Orbital (Macintosh only)

The file ‘hydrogen.hdf’ is in the 'Misc' folder. It contains a dataset and a polar ima
of a hydrogen orbital. The data represents a two dimensional slice through a pa
lar wave function of an electron in a hydrogen atom. The selected wave function
one of the 3D orbitals, where (n=3, l=2, m=0). The general equation used is

r^2 sin( ) cos( ) exp(-r/c)

where r is a radius,  is the angle in radians, and c is a constant.  This translates
following Transform expression:

Orbital=y(a)*y(a)*sin(x(a))*cos(x(a))*exp(-y(a)/20)

where a is a two dimensional array in transform with x (column scales) going from
to 2 , and y (row scales) going from 1 to 100.

M83 Radio Map

The file ‘m83.hdf’ is in the ‘Astro’ folder. This example, developed by S. Sukuma
and R.J. Allen at the University of Illinois at Urbana-Champaign and the Space 
scope Science Institute, is the visualization of a map showing the distribution of
polarized radio continuum emission around the spiral galaxy M83. The emission
were observed with the very large array radio telescope at a wave length of 20 c
The ‘Purple Haze’ color table is used to bring out features in this dataset.

Neutron Star

The ‘neutron.hdf’ file is in the ‘Astro’ folder. This file shows the results of a one-
dimensional time-dependent gas dynamic simulation of the accretion of gas ont
neutron star. The variable displayed here is density (in dimensionless units) as a
tion of radius (in units of the neutron star radius) and time (in seconds). At any pa
ular time in the simulation, the radial density profile would be a vertical slice throu
the dataset.
Transform Part 1: Introduction Sample Data
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Note the initial enhancement in density at large radii (this would be in the upper
hand corner of the image). Notice how this enhancement moves down over time
towards the neutron star surface. When this enhancement reaches the bottom o
grid the neutron star luminosity will increase. When the luminosity reduces to it'
normal value, the density enhancement will again move towards the neutron sta
face, starting the cycle over. The simulations were done on a Cray XMP at the
National Center for Supercomputing Applications at the University of Illinois.
Authors: Brand Fortner and Frederick Lamb, Department of Physics, University 
Illinois at Urbana-Champaign; Guy Miller, Los Alamos National Laboratories.

San Andreas Fault

The ‘fault.hdf’ file is in the ‘Misc’ folder. This is an image from a dataset represe
ing the calculated horizontal shear stress on a vertical slice across the San And
fault zone. The calculations are from a finite element model, which simulates th
accumulation and release of strain on a strike slip fault that cuts through an elas
viscoelastic earth model.

The vertical scale is somewhat exaggerated in the displayed image; the vertical r
of depths is 0 - 15 km, while the lateral width of the image is 200 km. The range
shear stress magnitudes displayed by the image palette is 0 -130 MPa (0 - 1300
The original model data were generated using a geophysical finite element cod
called ‘visco’, running on the Ames Research Center/NASA Cray Y-MP superco
puter. Authors: Gregory A. Lyzenga, Jet Propulsion Laboratory; Arthur Raefsky,
Stanford University.
Sample Data Transform Part 1: Introduction
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Understanding Window Organization

Transform consists of several types of windows and tools. The figure below sho
the menu bar and four types of windows that are commonly used in Transform: D
window, Notebook, and two image windows (interpolated image and a surface p
How the Transform application and its windows are organized is described belo

Title Bar

In Windows, the Title Bar bears the name of the application in the window, the M
mize, Maximize, and Close buttons, and the Transform Control-menu box. The a
cation window can be reduced to an icon by clicking in the Minimize button and c
be enlarged to fill the screen by clicking on the Maximize button. Single-clicking t
Control-menu box will raise a menu. Double-clicking will quit the application.

In Power Macintosh, the Title bar bears the name of the dataset in all windows, 
contains zoom and close buttons.

Figure 2-1: Transform Session
Transform Part 1: Introduction Understanding Window Organization
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Menu Bar

The Menu bar displays up to eight (Power Macintosh) or nine (Windows) menu
names. The Color Tables menu is unavailable with certain types of graphs and 
Clicking a menu name displays commands on the menu. Selecting a command
ries out an action.

Tool Bar

The Tool bar displays information and/or provides text fields for changing inform
tion about the data, and lists buttons that, when clicked, carry out an action. Too
buttons perform the same functions as commands by the same name in the Too
menu (Windows only). When clicked, a button's function is specified in the text p
tion of the Status bar (Windows only). The type of buttons available in the Toolba
controlled by the tool selected from the Tool Palette and the active window type

Tool Palette

When a file is open, the tool palette provides a number of buttons. Clicking on a
ton invokes a list of buttons in the toolbar and allows actions to be carried out in
dataset or image windows. The tool palette in Windows can be horizontal, vertic
floating, or hidden.

Image Window

The image window displays one of the several graphical display types that are g
ated from the Image menu.

Dataset Window

The dataset window is a spreadsheet-like display of the data.

Notebook

The Notebook is used to store comments or enter and execute macros. Both co
ments and macros can be saved with the HDF file.
Understanding Window Organization Transform Part 1: Introduction
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Status Bar (Windows)

The Status bar includes a Text Bar, Thermometer, and Color Bar. The Text Bar 
vides a brief description for an action about to be invoked. It also displays progr
status during long computations. The Thermometer is a graphical display of the
progress of a long computation. For windows that use color, the Color Bar shows
current window's color table.

Icon (Windows)

When you click an image or dataset window's minimize button, the window is
reduced to an icon and placed at the bottom of Transform's frame window. Each
dow type has a unique icon. Double click on the icon to enlarge the window aga
Transform Part 1: Introduction Understanding Window Organization
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Chapter 3:

Viewing Your Data
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To start the Transform program, double-click the Transform icon in the Transfor
program group or select it off the Start menu (Windows). If this is your first time 
Transform, the start-up screen will prompt you for your name, organization, and
istration number. This information is stored in the About Transform dialog.
Transform Part 2: Tours 37
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Opening a Dataset

ChooseOpen... from the File menu and open the file ‘sprngfld.txt’ in the ‘Sam-
ples\Monthly’ folder. This ASCII file is in a format called ASCII Special that is aut
matically recognized by Transform. The sprngfld.txt file contains a 12-column by
row array of the average monthly temperatures in Springfield, Illinois between th
years 1936 and 1975.

The Dataset Window

The data window that opens, ‘sprngfld_txt’, has a name slightly different from th
text file name, ‘sprngfld.txt’. In Transform, all non-alphanumeric characters in file
names are replaced with underscores. In the data window, numerical row labels
years and numerical column labels show months. If some of the data is not visib
scroll around the window using the scroll bars.

Changing Numeric Display Fonts

Transform for Windows displays values in floating-point format (e.g., 54.23) by
default. Power Macintosh displays values in exponential format (e.g., 2.120e+01
The display format is controlled by the Attributes... command from the Numbers
menu. ChooseAttributes... and the Attributes dialog shown in Figure 3-2 will
appear.

Figure 3-1: sprngfld_txt Data Window
Opening a Dataset Transform Part 2: Tours



Chapter 3: Viewing Your Data 39

dit

n
a data

-
ifies
tran
Note
In Power Macintosh, you can also double-click a data value to open a similar E
Data dialog.

The Attributes dialog has five components: the dataset name, row name, colum
name, data format, and the scale format. The Edit Data dialog lets you change 
value or change the format of the data display.

The Data Format (Array Data) pop-up menu specifies the format of numbers dis
played in the dataset window. The Scale Format (Row/Col Labels) pop-up spec
the format of numbers for row and column data scales in the dataset window. For
77 format specifications are used for numbers.

In the Attributes/Edit Data dialog, change the Data Format toF8.2and the Scale For-
mat toF5.0. Click OK  to close the dialog.

The dataset window displays in floating-point format and scales as integers.

Figure 3-2: Attributes Dialog
Transform Part 2: Tours Opening a Dataset
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Generating Images

It is difficult to gain insight into the data simply by looking at numbers. Transform
helps you understand your data using images, line graphs, contour plots, vector p
surface plots, polar plots (Macintosh only) and histograms (Windows only). Cho
Generate Imagefrom the Image menu to generate a simple image of the Springfi
dataset. If necessary, expand the window to see the entire image. The default c
table in Transform is 'Rainbow'. Your image should look similar to Figure 3-3.

Interactive Selection

Now compare your dataset window with the image window. Each number in the s
ple dataset is displayed in the new image window as a rectangular block of colo
Click on any part of the image, and note that a data value in the dataset window
selected. The pixel in the image corresponds to the value highlighted in the data
dow.

Figure 3-3: Raster Image of sprngfld_txt
Generating Images Transform Part 2: Tours
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Note that high values in the image are shown as red pixel blocks, and low value
shown as blue pixel blocks. You can see the relationship more clearly by looking
the color bar at the bottom of the image. This shows the mapping of data values
colors.

Image Tools

Transform has nine primary operating modes, represented by tools in the tool pa
Select, MinMax, Fiddle, Resize, Overlay, Axis, Label, Contour and Vector. Each t
provides a different selection of buttons, dialogs and controls.

You can select a tool by clicking on its button in the tool palette or by selecting i
name from the Tools menu (Windows only). Each tool has a toolbar configuratio
that becomes active when the tool is selected. In addition, the Windows status ba
display a small message about each button to help you determine what that but
does. Click on a button and hold the mouse down while reading the message from
status bar. If you do not want to perform the button's action, drag the mouse aw
from the button before releasing the mouse.

Figure 3-4: Data window and image window
Transform Part 2: Tours Generating Images
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Axes and Labels

By default, raster images are generated with labels, which can be modified usin
Axis tool. To do so, first click on theAxis tool in the tool palette. The toolbar now
displays options that let you configure how the column, row, color bar axes and im
title are displayed. Power Macintosh also provides the ability to change Axes fo
and size from the toolbar.

Click the Row Axis button (Row...)button to open the Row Axis/Axis Labels dialog

In the dialog, type 'Year' as the axis name, then type in numbers to specify axis
boundaries:1940 for the minimum and1970 for the maximum. Next click theIncre-
ment radio button (in Power Macintosh, click the left side of the double-arrow) a
in the box below it, change the value to 10. Now click in any text field and note t
the value for Intervals changes. (Alternatively, you can change the Intervals value
the Increment value will adjust accordingly.)

In the Minor Ticks per Major field, change the value from 1 to2. Scroll through the
choices for Label Format, and selectF5.0. Click OK to see the changes you made t
your image axis labels.

Now click the Column Axis (Col...) button and type 'Month' as the axis name. Also
type in Axis Labels of1 and12, Increments of1, Label Format ofF5.0, and Minor
Ticks per Major of1. Click OK  to return.

Next click on the Color Bar (Bar...) button and type 'Temperature' as the axis nam
Type in Axis Labels of20and80, Increments of10, Label Format asF2.0, and Minor
Ticks per Major of1. Click OK  to return.

Figure 3-5: Row Axis Dialog
Generating Images Transform Part 2: Tours
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Finally, click the Image Title (Title ) button and in the text field type 'Springfield, IL
Temperatures'. ClickOK to return. Your image should look similar to that in Figure
3-6.

Generating Interpolated Images

You can generate an interpolated image from the same dataset by selectingInterpo-
lated Image from the Image menu. Bilinear interpolation is used to calculate the
transition between the blocks of pixels, creating a smoother image.

Figure 3-6: Finished Raster Image with Axis Labels Changed
Transform Part 2: Tours Generating Images
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Manipulating Color

Many of Transform’s images and plots use color to represent data values, bring
out detail in the data.

In raster images, each pixel in the image is a color mapped from a data value in
array. Surface plots can use color to show the data values from one array comb
with a surface formed from the data in another array. Contour plots can be draw
color to reinforce the data value represented by each contour line. Dataset wind
notebooks, line plots, and vector plots contain no color.

Color Tables Menu

The easiest way to change the mapping of data values to colors is to select a n
color table. Each table in the Color Tables menu is designed to bring out differe
types of features from the image. Select one of the image windows that contain c
and chooseHot Metal from the Color Tables menu. Select different color tables fro
the Color Tables menu to see how data values map to color changes. When do
select theRainbow color table so your images match those shown in this chapter

Figure 3-7: Interpolated Image using sprngfld_txt
Generating Images Transform Part 2: Tours
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Fiddle Tool

Fiddle is so named because it lets you play with color mapping while looking for
interesting characteristics in your image. The Fiddle tool compresses and shifts
color range, allowing obscured data to become more visible. With an image win
active, click theFiddle button in the tool palette. Manipulate the color table by ho
ing down the mouse button and moving the cursor around in the image window.
Expand and compress the color table by moving the mouse up and down. Move
region of color compression left and right by moving the mouse left and right.

The figure below shows a pair of images before and after applying Fiddle. The im
on the left was generated using the 'Rainbow' color table. The color table for the
image on the right was compressed using the Fiddle tool.

In the Fiddle toolbar, you can change to any of the fiddle modes or restore the c
table to its previous unfiddled state. The Rotate mode shifts the colors left and r
without compressing the color range. It does not provide additional contrast, bu
can reveal important details in an image. Click theRotatebutton (or selectRotate
Colors from the Power Macintosh pop-up menu) button in the toolbar and use le
and right mouse movements to move the color table left and right. When you ar
done, click the Restore (Restore)button or selectRainbow from the Color Tables
menu to return to the default color table.

You can also change the mapping of data values to colors using the Min/Max to
This is described in the next section.

Figure 3-8: Using the Fiddle tool
Transform Part 2: Tours Generating Images
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Choosing a Data Range

In Windows, minimize, but do not close, your 'sprngfld_txt' windows. Now open 
sample file, 'chicago.txt' from the ‘Samples\Monthly’ folder and the 'chicago_txt'
dataset will appear. Use theAttributes ... command (Windows) or double-click a
value (Power Macintosh) to change the data format to F8.2 and the scale forma
F6.0. SelectGenerate Image to generate a raster image of the data, then select
GrayScale from the Color Tables menu. You will see an image similar to the one
shown below.

What went wrong? The entire image is black except for one white pixel block. Se
the white pixel and note that the corresponding data value for Column 11, Row 1
is 800.

Most likely, the temperature in Chicago was not 800 degrees in November. The
rect value is 36.0. This problem can be solved in several ways.

Figure 3-9: Raster Image of Chicago Temperatures
Choosing a Data Range Transform Part 2: Tours



Chapter 3: Viewing Your Data 47

ot.
t.

mall-
ues
, and

e

ch
r, the
is
Create a Histogram (Windows)

You can get a visual impression of the data scaling problem with a Histogram pl
ChooseHistogram from the Image menu to create a new window with the new plo
Your plot should look like Figure 3-10.

Transform has picked the data range to include all of the data. It goes from the s
est number, 13.3, to the largest number, 800. The problem is, all of the data val
that you want to see are clustered among the lowest 20 colors in the data range
they are all black!

Later we will change the data value from 800. First, let us see how to change th
color scaling without changing any of the data.

Changing the Data Min/Max (Windows)

Activate theMinMax  tool for your histogram window. In the toolbar enter14.5 for
the minimum value and86.2for the maximum value. This range was chosen to mat
the min/max range used to generate the Springfield image. When you press Ente
histogram redraws, showing you the temperature distribution in detail. To see th
distribution in color, selectRainbow from the Color Tables menu.

Figure 3-10: Histogram of Chicago Temperatures
Transform Part 2: Tours Choosing a Data Range
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In histograms, the outliers (data values outside the selected range, such as the 
value) are omitted. They fall off of the edges of the plot. In the toolbar, you have
count of the number of these outliers so that you know they are there. You should
a "1" in the box for outliers that are higher than the given data range. In images, o
ers are assigned their own special colors, described below.

Updating the Rest of the Images (Windows)

After finding the correct data range using a histogram, you need to transfer thes
ues to other windows, especially the raster image displaying most of its colors in
black. You could switch to that window and use the MinMax tool again to enter t
same data range and then repeat the process for each window. Instead, click th
Update All Windows button to change the data range for every window associat
with the dataset—all in one step. Now select theRainbow color table from the Color
Tables menu. The Chicago image, shown in Figure 3-14, should look similar to 
Springfield image. In particular, since they were generated with the same min/m
values, you can compare the colors in the two images directly.

Figure 3-11: Histogram with New Data Range
Choosing a Data Range Transform Part 2: Tours
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Change the Data Min/Max (Power Macintosh)

Click theMin/Max icon in the image window and click theColor Bar... button in the
image toolbar to open the following colorbar window.

Replace the minimum value (13.3) with 14.5 for the minimum value and the ma
mum value (800) with 86.2. then click theSetbutton next to ‘Set min/max to entered
values’ button,

Figure 3-12: Colorbar Window

Figure 3-13: Colorbar Window with Modified Range
Transform Part 2: Tours Choosing a Data Range
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When ready, click the close box. Make the Chicago image active then click the
Replot button in the toolbar. Now selectRainbow from the Color Tables menu. The
Chicago imageshould looksimilar to theSpringfield imageasshown in thefigurebe

Edit Outlier Colors (Windows)

The incorrect temperature value of 800 is now shown as a white block in the im
No matter which color table you select from the Color Tables menu, this value alw
displays in white. We can make it appear less obvious by changing the color us
display outliers. Select the Chicago image and, under theMinMax  tool, click on the
Edit Outlier Colors  button to bring up the dialog shown in Figure 3-15.

Figure 3-14: Chicago Temperatures with New Data Range
Choosing a Data Range Transform Part 2: Tours
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The 800 value is a High outlier because it is larger than the maximum value of t
data range. As we saw in the image, it is set to White. Change the setting toEnd
Color and clickOK . If necessary, click theUpdate All Windows button to transfer
the change to the other image windows for this dataset. Now the bad data value i
played in the highest color of the current color table. Select several color tables to
the effect.

Figure 3-15: Edit Outlier Colors dialog
Transform Part 2: Tours Choosing a Data Range
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Change the Data Value

Of course, we could just replace the bad data value. This works whenever your
dataset is small enough for you to edit one number at a time and you know the co
value. Click on the image at the spot representing the bad data value. The data
window highlights the corresponding data location.

In Windows, activate the dataset window and enter the correct value,36.0, in the Data
Value box in the toolbar and press Enter. In Power Macintosh, double-click the800
value in the spreadsheet to open the Edit Data dialog. Replace the 800 value w36
and clickOK . When you generate new images or cause the old ones to redraw, 
new value is used.

Note
Using the Fiddle tool is not a good method for dealing with data outliers, becau
Transform assigns 254 colors uniformly between the data minimum and data m
mum. In the example above, most of the colors would have been assigned to 
useless region between the true data maximum (86.2), and the bad 800 value
Change the Data Value Transform Part 2: Tours
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Managing Multiple Windows

SelectOpen... from the File menu to automatically import the files ‘avg_ c.txt’ and
‘avg_s.txt’. In each data window, select theAttributes... command from the Num-
bers menu (or in Power Macintosh, double-click a value to open the Edit Data dia
and change the Data Format to F8.2 and Scale Format to F6.0.

Next, chooseTile Windows from the Windows menu. Then selectSynchronizefrom
the Edit menu.

Your screen should now look like the figure shown below, depending on the size
the screen.

Figure 3-16: Images Synchronized
Transform Part 2: Tours Managing Multiple Windows
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SelectingSynchronizemeans that every time you click on an image or a data win
dow, the corresponding region of every data window and image from the differe
datasets will be selected. Note that although temperatures in Chicago and Spring
are similar, Springfield is usually slightly warmer. We will verify this in the next
chapter.

Note
Synchronize only works if the datasets have the same array size and the imag
have the Select tool active.

Another way to manage windows is to click the Minimize button in each window
(Windows only). The minimized windows reduce to icons. Double-clicking an ico
with the mouse will cause that window to be enlarged. In Power Macintosh, hidd
windows are not displayed, but their names are listed in italics under the Windo
menu. Selecting a hidden window from the Windows menu will cause that window
be displayed.
Managing Multiple Windows Transform Part 2: Tours
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The Notebook window allows you to enter text notes and store them with your d
You can also enter algebraic and macro expressions.
Transform Part 2: Tours 55
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Text in the Notebook

With the 'sprngfld_txt' dataset open, activate the dataset window and selectSee Note-
book from the Numbers menu. Then enter some descriptive text such as that sh
in Figure 4-1.

The text is stored in the Notebook, and will appear whenever you reopen the No
book window withSee Notebook.

Before proceeding, close the Notebook.

Figure 4-1: Notebook Window with Text Entered
Text in the Notebook Transform Part 2: Tours
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Calculations in the Notebook

You can also execute calculations and macros in the notebook.

Example 1 - Difference Calculation

With the 'sprngfld_txt' and 'chicago_txt' datasets open, and the 'sprngfld_txt' dat
window active, again selectSee Notebook from the Numbers menu. Note that the
text you entered in the Notebook window earlier is still there. On a new line, enter
following expression to calculate the difference between temperatures in Spring
and Chicago on corresponding dates:

difference = sprngfld_txt - chicago_txt

Note
 This example assumes the bad data value in the Chicago dataset for Novemb
1955 has been changed from 800 to 36. See Chapter 3 for more information o
changing this value.

Make sure the cursor is in the same line as the expression, then selectCalculate
From Notesfrom the Numbers menu. A new dataset window will appear. Now sele
Generate Imagefrom the Image menu. Your new window should look similar to tha
shown in Figure 4-3.

Figure 4-2: Notebook Window with New Text Entered
Transform Part 2: Tours Calculations in the Notebook
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The new dataset called ‘difference’ is equal to the difference between the tempe
tures measured at Springfield and those at Chicago for the same months and y

Note that Springfield was warmer than Chicago in the 30’s through the 50’s, but
nearly equal to Chicago in the 60’s and 70’s.

Example 2 - Deviation Calculation

Return to the Notebook window and enter this on a new line:

Sdif = Sprngfld_txt - Avg_S_txt

Note
To avoid typing errors, select the dataset name(s) from the Datasets pop-up me
the Toolbar (Windows only) or in the Notebook (Power Macintosh only). To pla
the dataset name in the Notebook at the location of the cursor, in Windows se
the dataset name that you want, then press Enter; in Power Macintosh, simply s
it off the pop-up menu.

Make sure the cursor stays on the same line as the expression and selectCalculate
From Notes from the Numbers menu.

Figure 4-3: New image generated
Calculations in the Notebook Transform Part 2: Tours
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The dataset ‘avg_s.txt’ consists of a 12-element row of numbers copied 40 times.
numbers correspond to the monthly temperatures for Springfield, IL averaged o
the entire time period. The dataset ‘Sdif’ is therefore equal to the monthly devia
from this average.

Other Possibilities

You could do the same calculation for Chicago and compare the deviations. It m
also be interesting to subtract the two deviations to see the difference in deviatio
between the two sites. Or perhaps compare the two averaged datasets, or conv
data to an absolute temperature scale.

Example 3 - Wave Function (Windows only)

This advanced example visualizes an analytical function, a combination of two w
sources, of the form y=sin(2r)/r. To try this example, type the lines listed below i
your Notebook window, exactly as they appear. You may omit, however, the com
ment lines, which are preceded by an '*'. Because Transform is shipped with thi
macro, you may also simply selectMakeWaves from the Macros menu.

Once you've entered these lines, place the cursor at the beginning of line one o
expression, then drag to the remainder. Then selectCalculate From Notesfrom the
Numbers menu.

Figure 4-4: Notebook with Wave Function Macro Entered
Transform Part 2: Tours Calculations in the Notebook
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This creates a 66 x 60 dataset, where row scales run from 0.01 to 12.38 in step
0.19, and column scales run from 0.01 to 12.36 in steps of 0.21. Several interme
datasets are used to create the final 'waves' dataset. An interpolated image is c
from this dataset, and the intermediate datasets are closed.

The 'waves' dataset window and corresponding interpolated image window, simil
those shown in Figure 4.5, should appear on your screen.

You can enter just about any algebraic expression in the notebook window, usin
dataset names as your variables. There are also numerous functions such as sin(
exp(q) available. See Chapters 22 and 23 for more detail.

Before continuing to the next chapter, close all windows except the Springfield
dataset and image window.

Figure 4-5: New dataset and image created from macro expression
Calculations in the Notebook Transform Part 2: Tours
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Line Graphs
In Transform, line graphs are useful for displaying profiles through a two-dimen-
sional array. For this chapter, we again use the 'sprngfld.txt' file.
Transform Part 2: Tours 61
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Generating Line Graphs

Minimize the interpolated image window, but keep the simple image and the dat
window visible. SelectLine Graph from the Image menu to create a line graph. No
selectLine Graph again to generate a second line graph. Then, resize or move y
windows so that all four are clearly visible.

Horizontal and Vertical Line Graphs

You should now have two identical line graphs, both representing a row of data 
ues from the dataset array. Click one of the line graphs and, with theSelect tool
active, click theVertical  (radio) button. This plots data along a column instead of
along a row. Your line graphs should now look like those in Figure 5-1.

The line graphs in Figure 5-1 are for the row '1936' and the 'January' column. T
vertical axis of both graphs represents the temperature. The horizontal axis sho
years in the row plot (left) and months in the column plot (right). You can click o
value in the dataset window or a rectangle in the image window to plot different 
and column graphs. To change the format of axis labels and titles, click on the A
tool and proceed as you did in Chapter 3.

Figure 5-1: Vertical and horizontal line graphs
Generating Line Graphs Transform Part 2: Tours
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Synchronizing Windows

For each of the four windows, activate theSelect tool (Macintosh only has tools
available in the image windows). Click anywhere in the data window, and you w
see a horizontal and vertical profile through the data at that point.

The corresponding region in both line graphs and the raster image is selected. Y
can also see the value of a particular point in a line graph by clicking on part of 
line graph. The corresponding data value will be highlighted in the other window

Comparing Line Graphs

Note that when you select Column 7, the difference between the highest and lo
monthly temperature in July (Column 7) is shown in the Selection Min/Max to be
about 15 degrees, but the difference between the highest and lowest monthly te
ature in March (Column 3) is almost 30 degrees.

To see this comparison graphically, activate the horizontal line graph window, th
click theVertical  (radio) button.

Figure 5-2: Example of Selected Areas Highlighted
Transform Part 2: Tours Generating Line Graphs
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In Windows, click the padlock button on the toolbar. In Power Macintosh, click th
Locked checkbox in one of the line graph windows to freeze that line graph. Now
select Column 7 (July) using the arrow keys or the data window. You can compa
line graph profiles by usingCopy andPaste Overlay.

Select the unlocked line graph window and click theAxes tool. Deselect theShow
Axesbutton (or checkbox) to turn off the axes, then selectCopy from the Edit menu.
Click theShow Axes button/checkbox again to turn the axes back on.

Now click theSelect tool in that window, and use the arrow keys to select Column
again. Now selectPaste Overlay from the Edit menu, and your window should loo
like the figure below.

The window consists of a live line graph, here displaying Column 3, with a graph
pasted on top of the line graph from Column 7. Notice that the spikes in the Mar
and July line graphs only slightly correspond with one another.

The ability to compare line graphs as overlays is a good example of how Transf
helps to lend insight into your data.

Figure 5-3: Overlaying July Temperature Line Graph on March Temperature Line
Graph
Generating Line Graphs Transform Part 2: Tours
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This chapter introduces the use of contour and vector plots through two exampl
The first example shows you how to generate a contour plot of Xvel and overlay i
a color interpolated image of the same dataset. The second example explains h
generate a vector plot and to create a composite plot by overlaying vector and con
plots on a color interpolated image.
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Contour Plots

Close all the files you have open by selecting theClose All command. Then open the
following files in the 'Samples\Tstorm' directory: 'vort.hdf', 'xvel.hdf', 'yvel.hdf', an
'zvel.hdf'. Now selectInterpolated Image for the Zvel and Vorticity datasets.

Activate the 'Vorticity' dataset window and selectContour Plot from the Image
menu. In Windows, the contour plot will be generated automatically, in Power M
intosh the Contours dialog (the Windows equivalent of this dialog is called “Conto
Levels”) will appear. Power Macintosh users may proceed to the next section “C
tour Levels/Contours Dialog.”

How to Make Contour Plots in Transform for Windows

Maximize the contour plot that is displayed in the new image window. Now click
theContour tool in the Tool Palette. Four toolbar options will be displayed: Dashe
Smoothed Lines, Color, and Contour Levels. Click on theDashes button to display
all contours below 0 as dashed lines. Your image should look like the figure sho
below.

Figure 6-1: Contour Plot
Contour Plots Transform Part 2: Tours
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Contour Levels/Contours Dialog

In Windows, click theContour Levels button to activate the Contour Levels dialog,
as shown on the left side in Figure 6-2. The Contours dialog shown on the right
of the figure is displayed when Contour Plot is selected from the Image menu in
Power Macintosh.

The Windows Contour Levels dialog opens with a default contour specification l
-600:1200@600 which means “draw contour lines from -600 to 1200 in increme
of 600”. Across the bottom of the dialog is a line display of the specification. The l
display indicates the minimum and maximum values in the dataset and where th
contour lines will be drawn.

The Power Macintosh Contours dialog opens with a default contour specificatio
-400:1200@400 which means “draw contour lines from -400 to 1200 in increme
of 400.” The box at the top of the window shows where the contour lines will be
drawn given the current minimum and maximum values.

Change the line in the Contour Levels/Contours text box to read -850:1600@500.
Click theUpdate button (Windows) orShow Lines button (Power Macintosh) to
see your changes to the text box recorded on the line display. In Power Macinto
click Dashed Lines checkbox to display all contours below 0 as dashed lines. Cli
OK  to draw the lines.

Note you can also draw contours interactively. Simply click on theContours button,
then click on the plot at the position you want the contours to be drawn. Add a f
more contours by clicking on the plot, then click on theContour Levels button
(Windows) or selectContour... from the toolbar (Power Macintosh) to open the Co

Figure 6-2: Contour Levels dialog
Transform Part 2: Tours Contour Plots
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tour Levels/Contours dialog again. You will see that the new contours you created
now specified in the text box, with each new contour level separated by comma
You can add new levels separated by commas, or you can delete a level simply
editing it out of the list.Delete the extra levels you added interactively and clickOK .

Contour Label Tool

Your contour plot is now complete except for labels. Click theLabel tool, then click
on any of the contours to add labels to the contour plot interactively. (To delete a
label, click on it again.) The larger your contour window, the more clearly the co
tours will be delineated.

In Windows, the default number format and the Font button are displayed in the
bar. In Power Macintosh, the default Font, Size and Format are contained in pop
menus. From the Format menu, change the number format toF6.0.

In Windows, click theFont button to invoke the Font dialog. Change the characte
type toTimes New Roman and the size to8. In Power Macintosh, make these
changes using the pop-up menus. Your image should look like the figure below.

Figure 6-3: Contour Plot with Labels
Contour Plots Transform Part 2: Tours
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Making an Overlay

The next step is to overlay the contour plot on the image. Before proceeding, hide
axes on the contour plot by first activating theAxis tool, then clicking theShow/Hide
Axes button (Windows) or theShow Axes checkbox (Power Macintosh).

Now, selectCopy from the Edit menu; activate the 'Vorticity.interpolated'' window
and selectPaste (Windows) orPaste Overlay (Power Macintosh). Your image
should look like that in Figure 6-4.

If the size of the contour plot in the overlay does not match that of the interpolat
image, click on theOverlay tool in the tool palette, then click theSize to Match but-
ton in the toolbar.

Before continuing, close the Vorticity.interpolated1 image, but leave the Vortic-
ity.contour1 image window open. You are going to use this image later in this chap
If you wish, minimize this window.

Figure 6-4: Overlay of Vorticity Contour Plot on Vorticity Interpolated Image
Transform Part 2: Tours Making an Overlay
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Vector Plots

In this section, we first explain how to generate a vector plot of the X and Y com
nents of wind speed. We then explain how to overlay a contour plot of wind vortic
and the X/Y vector plot on a color interpolated image of the Z component of win
speed.

With the 'Xvel' dataset active, selectVector Plot from the Image menu. When the
Select toolis active, the horizontal component is set to 'Xvel' and the vertical com
nent is set to one of the other open datasets. For this example change the vertic
component to beVertical (V) = Yvel.

You can modify the appearance of the vectors. Click theVector tool, and in the tool-
bar, change the number of vectors across from 22 to15 (‘# Across: 15’) and the scale
from 1.0 to1.5 (‘Scale: 1.5’). In Windows, pressEnter; in Power Macintosh, press
theReplot button.Your plot should look similar to like that in Figure 6-5.

Combining Plots (Windows)

Minimize all dataset windows. Bring up the 'Zvel.interpolated1' image by selectin
from the Windows menu.

Figure 6-5: Finished Vector Plot
Vector Plots Transform Part 2: Tours
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SelectTile from the Windows menu. You should have three windows displayed: 'V
ticity.contour1', 'Zvel.interpolated1', and 'Xvel.vector1'.

Now you are ready to build a composite image. Now activate the 'Xvel.vector1' w
dow, turn off the axes, selectCopy from the Edit menu, make the
‘Zvel.interpolated1’image active and select thePaste command from the Edit menu
to paste it to the 'Zvel.interpolated1' image. Next, activate the 'Vorticity.contour1
window and selectCopy from the Edit menu.

Now activate the 'Zvel.interpolated1' window and selectPaste from the Edit menu.
Your finished product should look like the image in Figure 6-7 on the next page.

Combining Plots (Power Macintosh)

Bring up the ‘Vorticity1.contour’ plot. SelectCopy from the Edit menu. Make the
‘Xvel.vector1’ plot the active window and select thePaste Overlaycommand from
the Edit menu. Your image should look like the figure below.

Minimize the dataset windows. Bring up the 'Zvel.interpolated1' image by selectin
from the Windows menu.

You should have three windows displayed: 'Vorticity.contour1', 'Zvel.interpolated
and 'Xvel.vector1'.

Figure 6-6: Combined Image
Transform Part 2: Tours Vector Plots
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Now you are ready to build a composite image. Activate the 'Xvel.vector1' windo
turn off the axes, click theSelect tool, then selectCopy from the Edit menu.

Note
Power Macintosh: if you copy a contour plot with the Option key selected, whe
pasted your overlay will have white lines instead of black.

Now activate the 'Zvel.interpolated1' window and selectPaste Overlayfrom the Edit
menu. Your finished product should look like the image in Figure 6-7.

Again, if the size of the contour and vector plots do not match the color image
exactly, select theOverlay tool then click theSize to Match button.

This will force the overlay to exactly match the current image.

The composite image that you just created is a visualization of four separate 2D
arrays (X, Y, Z velocity and vorticity)! You may want to select a different color tab
for this image to improve the contrast between the color image, contours and vec

Figure 6-7: Overlay of Vorticity.contour1 and Xvel.vector1 on Zvel.interpolated1
Image
Vector Plots Transform Part 2: Tours
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Surface plots are a three-dimensional representation of a two-dimensional data
array. The height of each point on the surface is determined from the data value
the array.

For our surface plot examples, we again use 'Xvel.hdf'. So close all open files a
open 'Xvel.hdf'.
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Create a Surface Plot

With the 'Xvel' dataset window active, chooseSurface Plot from the Image menu; a
small, wireframe image like that in Figure 7-1 should appear. You may want to
enlarge the window and move the image, as explained below.

Image Angle, Position and Size

The tool bar offers a variety of options for translating, orienting, and sizing the
image. Choose theSelect tool, then click on the surface plot and hold down the
mouse button (left mouse button on Windows). Move the mouse left and right to
rotate the image on a horizontal plane and up and down to tilt the plot toward an
away from you. While rotating the image, it changes to an orientation cube, as sh
in Figure 7-2.

Figure 7-1: The X Component of Velocity
Create a Surface Plot Transform Part 2: Tours
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In Power Macintosh, you can hold down the Option key while dragging to reposit
the mouse without spinning the plot.

Notice that the X, Y, and Z angles are reflected in the toolbar. In Windows, you c
also change the angles by typing new values in their respective text fields. In Po
Macintosh, this is done by clicking theSurface... button then selectingEdit
Angles....

Sizing and Moving the Surface Plot (Windows)

Next, make theResize toolactive. Instead of showing the angles of the cube, the to
bar now displays the size of the X, Y, and Z axes. Click on the surface plot, hold
down the mouse button and move the mouse. The image again changes to a cu
shown in Figure 7-2) and the mouse now resizes the plot.

The same actions with the Control (Ctrl) key depressed allow you to resize the s
face in just X and Y coordinates. As you resize the image, the toolbar displays
changes in the size of the X, Y, and Z axes.

To move the surface plot on the page without rotating or resizing it, click theMove
Surface button from the toolbar, then click the surface plot to move it on the pag

Figure 7-2: Orientation Cube
Transform Part 2: Tours Create a Surface Plot
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Sizing and Moving the Surface Plot (Power Macintosh)

To size the surface plot interactively, first click on theAxes tool. Next click in the
center of the image window and hold down the mouse button. To increase and
decrease the size of the X and Y axes, move the mouse left and right. To increas
decrease the Z axis size, move the mouse up and down.

You may also need to use the Resize tool to increase the size of the image area
the surface plot is drawn on. Note that theFit to Window  button on the Axes tool
resizes both the surface plot and the image area.

When you are done, release the mouse button and the surface plot will render i
new size that you selected. Note that when the Select tool is highlighted, mouse
movements change the surface plot orientation. When the Axes tool is highlight
mouse movements change the surface plot size.

Hold the Command key down while dragging the mouse to reposition the surface
without spinning it.
Create a Surface Plot Transform Part 2: Tours
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Surface Parameters and Types (Windows)

Now go back to theSelect tool and click on theSurface Parameters... button. The
Surface Parameters dialog prompts you for information regarding the surface pl
grid, plot parallax, and color variable. By default, grid lines are enabled for both ro
and columns; you may disable either one but not both. Change the spacing for 
to 2 and for Columns to 8; notice that the number for Count changes proportional
relation to the dataset dimensions. When you are comfortable with the settings, c
OK , and note the changes in the plot.

Surface Types

When you generate a surface plot, the Wireframe surface type is selected by de
This is because it generates faster than the other surfaces. If you select Hi-res B
& White or Hi-res Color Surface, the image takes longer to render when you mov
make changes to the image. Note that if your current color table is set to GrayS
you won't see color in the color surface types. SelectRainbow from the Color Tables
menu. Now test the different surface types, but when you are finished, return to
with a low resolution (e.g., Wireframe).

Figure 7-3: Surface Parameters Dialog
Transform Part 2: Tours Surface Parameters and Types (Windows)
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Axis Tool

After moving, stretching, and rotating the surface plot, you will need to adjust th
axes labels. Click on theAxis tool. The toolbar displays a number of options.

The first three buttons (from left to right) activate dialogs for labeling your row, c
umn, and data axes. Click on theRow button and change the Label format to F6.0.

The fourth and fifth buttons control the color bar below the image. (The color bar
tons are inactive with wireframe and black and white surface types selected).

Surface Decorations

The last six buttons are specific to surface plots. Click on theSurface Decorations
button and enable Skirt, Backstop, and Gridlines in the dialog that appears. Skir
a value of 1, specifying the color to be the same as the first in the color table yo
chose from the Color Tables menu. Changing the skirt value from 1 to 256 chan
the skirt to a special value for gray. Enter0 to make the skirt white. The same expla
nation applies to Backstop; leave the Backstop at 256.

Use the last five buttons in the toolbar to specify the placement of axes labels. T
first of these removes all the axes, leaving only the surface plot. The last four pl
the data axis in the origin, on the left, the right, and both the left and right, respe
tively. Click on theRight Data Axes button (second to the last button).

Figure 7-4: Axis Toolbar
Surface Parameters and Types (Windows) Transform Part 2: Tours
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Now return to theSelect tool in the Tool Palette, then select theHi-res Color Sur-
face button from the toolbar. Your surface plot should look similar to the one in F
ure 7-5.

Figure 7-5: Finished Surface Plot using Xvel
Transform Part 2: Tours Surface Parameters and Types (Windows)
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Surface Parameters and Types (Macintosh)

Select theAxes tooland then click theLabels...button. SelectRight Data Axis from
the popup menu in the dialog. Also selectSurface Skirt and give it color number0
(white) and selectBackstopand give it color number of256, a special value for gray.
Finally, setGrid Lines on. Several of these options may already be selected, dep
ing on how your Transform program is configured.

After making these changes, click onRow.... In the dialog, change the Label Forma
to F5.0.

Make whatever additional changes you wish to the label increment, label name,
When you are done, select theColumns (X) dialog via the popup menu, and make
your changes to the Label Format, etc. there. Likewise, make your changes to t
Data and Colorbar dialogs. When you are done, clickOK  to return.

Next, return to theSelect tool and selectHi-res Framed Color Surface from the
popup menu at the bottom of the image window.

Now that you have your surface plot in the size and orientation that you want, a
have the labels exactly the way you want, the final step is to increase the numb
lines in the surface plot. We save this step until the last because a high resolution
face plot takes much longer to render.

Figure 7-6: Surface Plot Labels Dialog
Surface Parameters and Types (Macintosh) Transform Part 2: Tours
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Click on theSurface... button, and change the 'Lines Every' fields for rows to 2 an
columns to 8 in the surface dialog. Click onOK  to return.

Depending on your choice of labels, size and orientation, your surface plot shou
now look similar to the following (we used the ‘Rainbow’ color table).

Figure 7-7: Surface Dialog

Figure 7-8: Completed Surface Plot
Transform Part 2: Tours Surface Parameters and Types (Macintosh)
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Create an Image Macro

Any image you create can be saved as a custom macro, which can then be app
other datasets. To see how image macros work, we will create a macro for the su
plot you just created. We also use the file 'Yvel.hdf'.

Maximize the 'Xvel.surface1' window you just created. With the surface plot wind
active, selectCreate Macro... from the Macros menu. Transform will prompt you to
name the macro. For our example, clickOK  to accept the default name. The macro
will be saved and its name will be listed under the Macros menu.

Now open 'Yvel.hdf' and keep its dataset array window to the front. Under the M
ros menu, select the macro you created from the 'Xvel' dataset. You should see
face plot that looks like the one you created, except that it uses the 'Yvel' data an
the 'Xvel' data.

Note
Windows displays the Yvel data scales where Power Macintosh displays the d
scales for Xvel.

Figure 7-9: New Surface Plot using Yvel
Create an Image Macro Transform Part 2: Tours
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To edit your macro, selectEdit Macros... from the Macros menu. The dialog shown
below will appear.

Select your macro, then clickEdit.... You will see a line-by-line listing of your
macro, like that in Figure 7-11.

Change Scales

In Windows, select the linedata_autominmax=trueand change it to
data_autominmax=false.

In Power Macintosh, these settings are correct. No action is required.

Figure 7-10: Edit Macro...Dialog

Figure 7-11: Macro Editor Listing
Transform Part 2: Tours Create an Image Macro
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Change Data Axis Title

As a last step, modify both occurrences of the following line in the macro for the d
axis and color bar:

axis_title = "Xvel"  to beaxis_title = "Velocity" .

Click OK , thenClose/Done to return to the main window. Make the 'Yvel' dataset
window active, and select the macro from the Macros menu again. You will see y
changes in the new image that is created.

Change the Plot Title

Click theAxes tool. Click thePlot Title (Windows) orLabels... button, then the
Title... button (Power Macintosh) and enter the title ‘Velocity Component’ in the d
log. Your axes labels may look different from those in Figure 7-12, since Transfo
uses the same font, font size, and spacing specifications of the last image that y
generated.

Chapters 22 and 23 give more information on macros, along with additional exa
ples and a listing of macro language subroutines, functions, and reserved variab

Figure 7-12: New Surface Plot Created from Edited Macro
Create an Image Macro Transform Part 2: Tours
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Transform only works with 2D matrix data. If your data is in text column format,
Transform will import and convert the text column data to matrix data. Transform
grids the data into a regularly spaced grid, based on the parameters you set in t
import dialogs described in this chapter.

In this chapter, we show you how to work with text column data. You will first impo
the sample column dataset 'weather.txt'. Then you will manipulate the data, and
ate an image with a map overlay.

Before you start this part of the tour, close any open windows.
Transform Part 2: Tours 85
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Importing Column Data

To start, selectOpen...from the File menu. Then select and open the file 'weather.t
in the ‘Samples\Weather’ folder. The Import File Format dialog will appear.

In the Import File Format dialog, selectText Columns, then clickOK . The Text Col-
umns dialog will appear. Note that Transform has scanned the text file and ente
dimensions for Header Lines, Rows, and Columns in the dialog.

Verify that your numbers are the same as shown in Figure 8-2. To preview the d
click View File... shown in Figure 8-3.

Figure 8-1: Import File Format Dialog (Windows and Macintosh)

Figure 8-2: Text Columns Dialog
Importing Column Data Transform Part 2: Tours
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Use the scroll bars in the View File dialog to scroll through the data. The first thr
lines of the data file are comments, called header lines. The last header line has
for columns.

With that noted, clickClose/Doneto return to the Text Columns dialog.

Now, make sure that you select the option ofHeader titles (or Last header line con-
tains column titles). This tells Transform to use names found in the last header l
as the dataset names, rather than using column numbers to name datasets. CliOK
to go to the Select Column(s) dialog.

Specifying the Columns and the Target Matrix

Now that you have indicated how the data is formatted, you must specify two co
umns as the independent variables and another column as the dependent variab
our example, make sure the X column is 1, the Y column is 2, and the Data colum
3: Temp(F).

Figure 8-3: View File Dialog
Transform Part 2: Tours Importing Column Data
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Now, make sure the Target Matrix size is 100 by 100. If it is not, click theConfig-
ure... button next to Target Matrix to bring up the Target Matrix Parameters dialo
shown in Figure 8-5. Enter 100 for # of Points in both X and Y, then clickOK  to
return to the Select Column(s) dialog.

Figure 8-4: Select Column(s) Dialog

Figure 8-5: Target Matrix Parameters Dialog
Importing Column Data Transform Part 2: Tours
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Next, clickSpecify... to choose how to place your data values into the matrix. The
Data Placement dialog in Figure 8-6 will appear.

In this dialog, be sure that you selectuse last value encountered (Windows) or
Replace Previous Value (Power Macintosh), and that you set the Background Fil
Value to-99 (which is the same number used in the dataset itself to specify a miss
data value). ClickOK  to return to the Select Columns dialog.

Next, clickMethod... to specify the matrix filling method. The dialog shown in Fig
ure 8-7 will appear.

Figure 8-6: Data Placement Dialog

Figure 8-7: Column Import: Matrix Fill Dialog
Transform Part 2: Tours Importing Column Data
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Click No Fill (in Power Macintosh, also set the Missing Data value to-99). Click OK
to return to the Select Columns dialog. The dialog should now look like Figure 8

Finally, clickOK  to convert and import the data into Transform.

First, Transform calculates the range of X and Y values in columns 1 and 2. Tra
form then divides these ranges into 100 intervals in X and 100 intervals in Y. Th
new 100 x 100 matrix is then filled with ‘-99’, the specified fill value. Finally, all th
actual data values from column 3 are placed in the matrix in the closest X-Y locat
replacing the -99 in those locations.

Figure 8-8: Select Column(s) Dialog with all Entries Made
Importing Column Data Transform Part 2: Tours
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Note that the name of the resulting dataset (Figure 8-9) has been changed from
‘Temp(F)’ to ‘Temp_F_’. This is because parentheses are not legal characters fo
variable or dataset array names.

In Power Macintosh, chooseAttributes... from the Numbers menu and change the
Array Data toF8.2 and the Row/Col Labels toF9.1

With the new dataset window up, selectGenerate Image from the Image menu.

Select theAxis tool and click theShow/Hide Axesbutton. Your image should look
like a squeezed scatter plot of the United States. The background fill values of -99
displayed as purple (the lowest color).

Figure 8-9: New Dataset Window

Figure 8-10: Image Corresponding with the New Dataset Window
Transform Part 2: Tours Importing Column Data
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Modifying the Aspect Ratio

We will now try to make a better image by first fixing the aspect ratio, the squee
of the image.

Aspect Ratio Button (Windows)

Select theResize tooland press theAspect Ratiobutton. Your image should now be
adjusted to look like that shown in Figure 8-11.

Calculating the Aspect Ratio (Power Macintosh)

We will now try to make a better image by first fixing the aspect ratio, the squee
of the image. To generate an image with the proper aspect ratio, enter these line
the notebook window, select all three lines, and then selectCalculate From Notes
from the Numbers menu.

image_v = 200
image_h = 200 * abs( colrange(Temp_F)/rowrange(Temp_F) )
call image(currentdataset)

Figure 8-11: Image with Corrected Aspect Ratio
Modifying the Aspect Ratio Transform Part 2: Tours
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The reserved variablesimage_vandimage_hspecify the vertical and horizontal size
of images. The functionscolrange() androwrange() calculate the horizontal and
vertical numerical ranges of the specified dataset, socolrange()/rowrange() is the
image aspect ratio. The subroutine linecall image(currentdataset)generates a raster
image of the current dataset. The resulting image should look like the following.

Figure 8-12: New Image
Transform Part 2: Tours Modifying the Aspect Ratio
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Modifying the Data Minimum and Maximum

The colors are being mapped between a data minimum of -99 to a data maximu
76, even though the lowest valid data value is actually -15 (recall that -99 is the b
ground fill value).

Calculating the Data Minimum and Maximum (Macintosh)

You can see this by clicking on theMin/Max tool on the raster image, and then click
ing on theColor Bar... button. You should see the dialog shown below.

Enter-15 for the lowest value, then click theSet button next to 'Set min/max to
entered values'. Your dialog should look like the figure below.

Figure 8-13: Color Bar Window
Modifying the Data Minimum and Maximum Transform Part 2: Tours
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Close this window, then clickReplot. Your image will now be more accurate.

Adjusting the Data Minimum and Maximum (Windows)

The colors are being mapped between a data minimum of -99 to a data maximu
76, even though the lowest valid data value is actually -15 (recall that -99 is the b
ground fill value).

To adjust the range, select theMinMax tool  and enter-15 in the Data Min field and
press Enter. Notice how the contrast in your image is enhanced.

Figure 8-14: Changes to the Color Bar
Transform Part 2: Tours Modifying the Data Minimum and Maximum
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Figure 8-15: Image Contrast Enhanced
Modifying the Data Minimum and Maximum Transform Part 2: Tours
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Filling Missing Data Values

We will now fill in all of those -99 data points. With the Temp_F dataset the activ
window, selectFill Missing Data... from the Numbers menu. The Fill Missing Data
dialog, shown in Figure 8-16, will appear.

SelectKernel Smoothing (the fastest and smoothest method here) and be sure th
'Missing Data’ is ‘equal to'-99. Click OK  to produce an interpolated version of the
dataset, named ‘Temp_F__md’.

In the interpolated data set, the true data values have been used to fill in the ful
matrix of values. The original data elements have been smoothed along with the
data elements, to generate a smooth dataset.

Now selectInterpolated Image from the Image menu to create an interpolated
image as shown in Figure 8-17. We turned off the axes and corrected the aspect
as described earlier.

Figure 8-16: Fill Missing Data Dialog
Transform Part 2: Tours Filling Missing Data Values
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Add Graphics Overlay

Next, open the file 'us_map.hdf' in the ‘Samples\Weather’ directory. The file cons
of a blank dataset with an overlay of a continental U.S. map. Make the
‘US_Map_Overlay.contour1’ (Windows) or ‘Blank_Data.image1 (Power Macintos
image window active. You are going to copy the graphic of the United States tha
appears in this window as shown below.

Figure 8-17: Interpolated Image
Filling Missing Data Values Transform Part 2: Tours
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In Windows, selectCopy As...from the Edit menu to open the Copy As dialog. In th
left-hand list in this dialog, selectTop Overlay, and clickOK  to copy the overlay
(only) to the clipboard.

In Power Macintosh, select theOverlay tool, then select theCopy Overlay com-
mand from the Edit menu.

Now make the interpolated Temperature image window active, and selectPaste
(Windows) or Paste Overlay(Power Macintosh) from the Edit menu. A very large
U.S. map will be overlaid on the image.

To make the map the proper size, select theOverlay tool and click theSize to Match
button, which appears in the toolbar. The overlay tool lets you independently size
position the graphics overlay. In any case, the resulting smooth image with the o
lay should look like the following:

Figure 8-18: Overlay
Transform Part 2: Tours Filling Missing Data Values
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Because this particular overlay has virtually the same boundaries as the data, it
matched the image with little adjustment. In general, however, you may have to
fully size and position an overlay to match your other image.

Figure 8-19: Final images
Filling Missing Data Values Transform Part 2: Tours
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Transform can import many file types, including HDF, TIFF, generic binary, gene
text, GIF (Windows), BMP (Windows), PICT (Power Macintosh), PBM, FITS, XWD
and MATLAB 4.0 files. Some file types are imported automatically, others requir
you to provide information to describe the file. This chapter specifies all of the ty
and describes the dialogs used for importing data.

All Fortner Software visual data analysis products use the Hierarchical Data For
(HDF) as their primary data storage format. HDF is a scientific data file format de
oped at the National Center for Supercomputing Applications (NCSA) at the Un
sity of Illinois at Urbana-Champaign. It is a machine-independent binary file form
standard for storing matrix, column, and polygonal data from a wide variety of d
plines. HDF files can store floating point data, scaling information, color images,
annotation, and data objects (for more information, see Appendix C).
Transform Part 3: Reference Manual 103
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Opening the Data File

Use theOpen...command from the File menu to begin the import process. If the fi
format is automatically recognized, Transform opens the file and reads the data
into memory. It then creates a dataset window to display the data. If images or n
were saved with the dataset, they are also displayed. If the file type cannot be
detected automatically, you are prompted for more information about the file and
way the data is stored (see below).

For files with multiple data records and files with three-dimensional arrays of da
Transform allows you to select which portion of the data to read into memory.

Automatic Import File Types

Transform reads the first part of the data file to try to determine its type. The foll
ing file types are automatically recognized.

Transform HDF Files

HDF files created or saved from Transform can contain two dimensional datase
notebook information and images.  When Transform opens a file of this type, th
dataset, Notebook and any images that are in the file are opened automatically.
Transform HDF file has been edited in Noesys, a dialog will appear on import giv
you the choice to import the file into a new Transform-specific HDF file or open 
file as a Transform file at the risk of losing HDF data objects not supported by Tr
form.

Transform can read slices from three-dimensional datasets stored in HDF files. 
axis-parallel slices are supported. Information about reading slices from three-di
sional arrays is discussed later in this chapter.

Other HDF Files

When opening HDF files that were not originally created in Transform, the multi
record selector will appear (described later in this section) with a list of all the H
objects that are in the file that can be read by Transform. Those objects are the
into a new HDF file that can be manipulated and saved.

In Power Macintosh, if you open an unsigned integer*1 dataset, or file, Transfor
opens the dataset and automatically creates an image from the data. This is be
Transform assumes that all unsigned integer*1 data is image data (e.g., TIFF o
PICT).
Opening the Data File Transform Part 3: Reference Manual
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HDF Images

Imported 8-bit images are read as two-dimensional arrays of 8-bit data values a
converted to a normal dataset with values between 0-255.

HDF Vset (Power Macintosh only)

HDF Vset datasets may be read as column data. The first Vgroup is read and e
Vdata record is used as one column of data. Refer to the Select Columns dialog
gridding and filling options.

ASCII Special

ASCII Special is a Transform-specific format for a text file that represents a two
dimensional array with row and column scales. Usually ASCII Special files are
detected automatically, but if your file contains header lines, you may need to re
in as a text file. ASCII Special text files should be in the format shown in Table 9

#rows #cols
max_value min_value
row1 row2 row3 row4 . . . .
col1 col2 col3 col4 . . . .
data1 data2 data3 data4 . . . .

Table 9-1: Format for ASCII Special File

The ASCII numbers may be in integer, floating point, or exponential format, sep
rated by spaces, tabs, or end-of-lines. Maximum and minimum values define th
range of number values in the region of interest. If set to 0 and 0, Transform wil
culate the minimum and maximum for you. Table 9-2 shows a sample ASCII spe
dataset with 5 rows, 10 columns, and 50 data points.

5 10
9.9e0 0.0e0
10.0 20.0 30.0 40.0 50.0
1 2 3 4 5 6 7 8 9 10
0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1.0
1.1 1.2 1.3 1.4 1.5 1.6 1.7 1.8 1.9 1.0
3.1 3.2 3.3 3.4 3.5 3.6 3.7 3.8 3.9 1.0
6.1 6.2 6.3 6.4 6.5 6.6 6.7 6.8 6.9 1.0
9.1 9.2 9.3 9.4 9.5 9.6 9.7 9.8 9.9 1.0

Table 9-2: Sample ASCII Special Text File
Transform Part 3: Reference Manual Opening the Data File
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Note
For ASCII Special text files, the data MUST be in this exact format for it to be re
correctly. There are no optional fields. If you do not care about numerical row 
column labels, then use the simpler text matrix import instead.

Microsoft Windows BMP (Windows only)

Microsoft Windows Device Independent Bitmap (BMP) files can contain images t
are 1-, 4-, 8-, or 24-bits per pixel. The 1-, 4-, and 8-bit images have color maps, w
the 24-bit images are direct color. These files store low byte first and have no w
alignment. Each file contains a file header, a bitmap header, a color map (unles
image is 24-bit direct color), and the image. Four- and eight-bit images may use
optional RLE compression scheme, otherwise the data is uncompressed. Bits ar
ically stored a row at a time, and each row is padded to a multiple of four bytes.
rently, Transform supports only 4- and 8-bits-per-pixel, uncompressed BMP files

FITS Files

Flexible Image Transport System (FITS) is the bitmap file format universally used
astronomers to store and transfer astronomical images. Originally, the FITS form
was designed for magnetic tapes, but it is also used on disks and CD-ROMs. The
in a Basic FITS file is an N-dimensional array. Every FITS file must contain SIM
PLE, BITPIX, NAXIS, and END cards, in that order, and can contain other recor
interspersed among them. Transform supports FITS files containing two- or thre
dimensional arrays of 8-bit unsigned, and 16-bit and 32-bit signed integer value
well as 32-bit and 64-bit floating point data. The data is scaled according to the
BZERO and BSCALE keywords before import. The ASCII header, which contain
information on the data, is placed in the notebook window. For Transform to rea
FITS file, SIMPLE must be present, BITPIX is required, and NAXIS must be equ
to 2 or 3. BZERO and BSCALE are optional and are used to control the scaling

GIF Files

Graphics Interchange Format (GIF) files are bitmap (raster) image files common
used for on-line transmission of graphics data across networks. GIF images are
into Transform as an array of 8-bit data values, which are then used to create a no
dataset. Transform supports 2-, 4-, 16-, 32-, 64-, and 256-color GIF images, in ’
or ’89a’ format.
Opening the Data File Transform Part 3: Reference Manual
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TIFF Files

Tag Image File Format (TIFF) is a (raster) bitmap image type used for data excha
for desktop publishing and related applications. It is independent of a computer
architecture, operating system, and graphics hardware. TIFF 1, 2, 4 and 8-bit im
are read as an array of 8-bit data values, which are then used to create a norma
dataset. TIFF 24-bit images are converted to 8-bit before import. Transform does
support multiple-strip TIFF images or compressed TIFF images.

PICT (Power Macintosh only)

PICT images are drawn as an array of 8-bit data values, which are then used to c
a normal dataset. An image window is automatically created to display the imag
PICT 24-bit images are converted to 8-bit before imports. Note that some 8-bit
images use 256 color entries, whereas Transform uses only 254 colors, so in ra
cases you might see a minor color shift.

PICS Files (Power Macintosh only)

PICS files are made up of multiple PICT images. Transform lets you select any P
image or images from the PICS file to import. See the description later in this cha
for details on selecting from multiple-record files.

PBM Files

Portable Bitmap (PBM) files are drawn as an array of 8-bit data values which are
used to create a normal dataset. An image window is automatically created to dis
the image. 24-bit PBM images are approximated as 8-bit images before being c
verted to data. PBM, PNM, PGM and PPM file formats are supported.
Transform Part 3: Reference Manual Opening the Data File
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Import Files with Multiple Records or Objects

Some MatLab, HDF, and all PICS files contain multiple records or objects. For th
files, the Multiple Record dialog appears, shown below. For HDF files, you see a
of HDF objects and sizes, by name. For MatLab or PICS files, you see a list of n
bered records and their sizes.

In the scrolling list, select any or all of the records listed. Use theSelect Allbutton to
choose them all. ClickOK  to proceed. Transform imports each of the selected
records as a separate dataset.

Note
Transform saves one dataset in each file. Attempts to save a dataset with the 
file name as a previous dataset will overwrite the previous file. However, by us
the HDF libraries in a program of your own, you may create a file with more th
one array of data.

Importing Slices from 3D Arrays

For 3D datasets, you have to choose which 2D slices to import. Each slice is op
as an independent 2D dataset. When you select a 3D array, the Slices/Select S
dialog appears.

Figure 9-1: Choosing Record(s)
Opening the Data File Transform Part 3: Reference Manual
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The radio buttons on the left give you a choice of axis direction for the slices. Th
scrolling list displays one number for each slice in that axis direction. For one of
X-Y planes, Transform skips to the appropriate location in the file and reads one
slice. For Y-Z or X-Z planes, Transform must read the entire file to extract the
requested information; this may take some time.

You can select a range of slices by selecting the first slice, and then shift-selectin
last slice. You can select a series of noncontiguous slices by holding down the c
mand key as you select additional slices.

Importing Files that Require Additional Information

Transform requires additional information when importing text matrix, binary matr
text column, binary column, XWD or MATLAB datasets. If Transform does not au
matically recognize the selected file type, the Import File Format dialog (Figure 
appears. The following sections provide a brief explanation for binary vs. ASCII te
column vs. matrix, and each of the acceptable import file types.

ASCII Text vs. Binary

ASCII text files contain human-readable text and numbers. You should be able 
open them in a word processor and read the numbers. Binary format files can be
only by machines and fall into one of the following types: byte, short integer, lon
integer, floating point, or double-precision floating point.

Figure 9-2: Slices Dialog
Transform Part 3: Reference Manual Opening the Data File
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Matrix vs. Column

Transform only works with 2D matrix data (note that Fortner Software's 'Noesys' d
management application works with multidimensional data). If your data is in tex
column format (Table 9-3), Transform will import and convert the text column data
matrix data. Transform grids the data into a regularly spaced grid, based on the
parameters you set in the import dialogs.

In Figure 9-3 you see a scatter plot of the text column data.

Table 9-3: Text Column Data

Figure 9-3: Scatter Plot of Text Column Data
Opening the Data File Transform Part 3: Reference Manual
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Figure 9-4 shows you how Transform places the real data values into the neares
position.

Notice that the value at X = 0.9 and Y = 0.9 does not correspond to any data value
Figure 9-5. This is because three of the data values fall into the same grid locat
Transform averages those values (0.4911, 0.2422, 0.0714) to produce the value
see (0.2682). You could also set Transform to “use last value encountered” (Win
dows) or “Replace Previous Values” (Power Macintosh), or to “sum values”.

Note also that at X = 0.3 and Y = 0.9, and X=0.9 and Y = 0.3 there is a data val
-1. This is the fill value for areas where there is no real data. If you look at these a
in Figure 9-5, you will see there is no data there.

Text Matrix Files

Text Matrix files contain data in a two-dimensional matrix. The numbers start wi
the first row, going from left to right, and continue row by row from top to bottom
Any number of points may be on one line, as long as the data is in order. For m
information, see the section on Importing Text Matrix files.

Binary Matrix Files

Binary matrix files contain binary data in two-dimensional matrix format. The nu
bers start with the first row, going from left to right, and continuing row to row fro
top to bottom. The data may be byte, short integer, long integer, floating point, o
double precision—signed or unsigned. For more information, see the section on
Importing Binary Matrix files.

Text Columns Files

Text column files contain text data arranged as columns giving the X-location, Y
location and data values. Each line of the file represents one data point. Multiple
values may be included for each X,Y location. Several gridding and filling option
are available. For more information, see the section on Importing Text Column fi

Figure 9-4: Transform Matrix
Transform Part 3: Reference Manual Opening the Data File
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Binary Columns Files

Binary column files contain binary data arranged as columns giving the X-locati
Y-location and data values. Each line of the file represents one data point. The d
may be byte, short integer, long integer, floating point, or double precision, signe
unsigned. For more information, see the section on Importing Binary Column file

MATLAB Files

MATLAB files contain data saved in the default format for MATLAB version 3.5 o
4.0. You can choose any dataset from the file to read as an array of double-prec
floating point numbers.  If you are using MATLAB 5.0, you will need to export da
using  the -v4  flag to save into a version 4.0 format. For more information, see 
“Frequently Asked Questions” section of Appendix G: Troubleshooting.

XWD

Transform also reads X Window Dump (XWD) files which are commonly used o
Unix workstations. The image (any bit depth) is read from the file and converted i
a floating point dataset. 24-bit images are converted to 8-bit images before being
verted to data. No other intervention is required for X Window Dump files.

Transform ASCII Special Files

Usually ASCII Special files are detected automatically, but if not, you may force
Transform to try and read it in this form. See the previous section for more infor
tion on this format.
Opening the Data File Transform Part 3: Reference Manual
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Select the Import File Type

The Import File Format dialog shown below allows you to import the file types
described above.

The dialogs associated with importing text and binary matrix, text and binary co
umns are provided in the remaining sections of this chapter.

Importing Text Matrix Files

SelectingText Matrix  in the Import File Format dialog invokes the Text Matrix dia
log shown in Figure 9-6.

Figure 9-5: Import File Format Dialog (Windows and Power Macintosh)

Figure 9-6: Text Matrix Dialog
Transform Part 3: Reference Manual Select the Import File Type
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3D Matrix

Select3D Matrix  if you have a three-dimensional array of data in the file.

Table Format

SelectTable Format if your files contain scale values at the top of each column a
at the beginning of each row. Table 9-4 shows the same array as Table 9-2 but in
format.

1 2 3 4 5 6 7  8 9 10
10.0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1.0
20.0 1.1 1.2 1.3 1.4 1.5 1.6 1.7 1.8 1.9 1.0
30.0 3.1 3.2 3.3 3.4 3.5 3.6 3.7 3.8 3.9 1.0
40.0 6.1 6.2 6.3 6.4 6.5 6.6 6.7 6.8 6.9 1.0
50.0 9.1 9.2 9.3 9.4 9.5 9.6 9.7 9.8 9.9 1.0

Table 9-4: 2D Text Matrix in Table Format (Scaled Matrix)

Header Lines

Header lines contain comments about your files and cannot be read into Transf
Enter the number of lines of text for Transform to skip. These text lines will autom
ically appear in the Notebook that is associated with the imported dataset.

Estimate Sizes

Click on this button to have Transform estimate row and column size. Transform
assumes that all the numbers for each row are on that same line of the file. If th
not the case, you must override the incorrect estimates.

Rows (Y) and Columns (X)

Here enter the number of rows and columns of data to read from the file. If you
selected the 3D Matrix checkbox, you also need to enter the number of layers fo
third dimension.

View File

This option lets you view the data in the file before you import. The View File dialo
is discussed at the end of this chapter.
Select the Import File Type Transform Part 3: Reference Manual
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Importing Binary Matrix Files

SelectingBinary Matrix  from the Import File Format dialog invokes the dialog
shown in Figure 9-7. The options on this dialog are described below.

For raw binary files, you can specify the rows and column in the file name itself,
off by parentheses. For example, myfile (200 x 300). The Binary Matrix dialog w
use these numbers for the row and column sizes. This also works for 3D files w
you specify (layers x rows x columns).

Number Type

Select the number type from the menu, shown in Figure 9-9.

3D Matrix

Select3D Matrix if you have a three-dimensional array of data in the file. When yo
are finished with this dialog, the Select Slices dialog (described later in this chap
prompts you to choose which two-dimensional slices to import.

Figure 9-7: Binary Matrix Dialog

Figure 9-8: Number Type Menu
Transform Part 3: Reference Manual Select the Import File Type
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Swap Bytes

Select the optionSwap Bytesif your data comes from a computer where binary da
is stored with the reverse byte order (Intel byte order).

Skip Bytes

Enter the number of bytes for Transform to skip before reading data.

Rows (Y) and Columns (X)

Here enter rows and columns of data to read from the file. If you selected the 3D
Matrix checkbox, you also need to enter the number of layers for the third dimens

View File...

This option lets you view the data in hexadecimal format before you import.

Importing Text Column Files

Importing text column files is a three-step process. First, from within the Import F
Format dialog, selectText Columnsand clickOK ; second, after designating prefer
ences inside the Text Columns dialog, clickOK ; third, choose preferences within the
Select Columns dialog. SelectingText Columns invokes the dialog shown in Figure
9-9. The options on this dialog are described below.

Delimiters

Select the desired text delimiter from the menu, shown in Figure 9-10.

Figure 9-9: Text Columns Dialog
Select the Import File Type Transform Part 3: Reference Manual
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Importing Fixed Field Column Files

SelectingFixed Fieldsfrom the Delimiters pull-down menu changes theView File...
button toSet Columns.... Click this button to specify your fixed field columns in th
dialog shown below.

Click and drag anywhere in the data portion of the window to select each colum
data to import. The listing at the bottom shows you the exact character positions
the columns you select. You may also enter column specifications directly in this
ing. Use the formfirst:last , wherefirst:last  are the first and last charac-
ter positions for that column. The column specifications are separated by comma
you overlap a new column onto an existing one, the earlier one is replaced with
new entry.

Figure 9-10: Delimiter Types

Figure 9-11: Fixed Columns Dialog
Transform Part 3: Reference Manual Select the Import File Type
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Strict Delimiter (Windows) or
Separate column for each delimiter (Power Macintosh)

Select this option if you have data columns with missing data, indicated, for exam
by two tabs in a row. If you have a data value in each column, leave the box em

Header Titles (Windows) or
Last header line contains column titles (Power Macintosh)

Click on this checkbox if your text columns file has a name listed at the top of ea
column and those names are separated by the same delimiters as the data.

Header Lines

Enter the number of lines of text for Transform to skip. The number includes the
header line containing the titles.

Estimate Sizes

Click to have Transform estimate row and columns size, given your choice for de
iters. Transform assumes that all the data values for a row are on the same line. I
is not the case, you must override the incorrect estimates.

Number of Rows and Number of Columns

Here, enter the number of rows and columns of data to read from the file.

View File...

This option lets you view the data in the file before you import. The View File dialo
is discussed at the end of this chapter.

OK and Cancel

Click OK  to go to the Select Columns dialog, described after the “Importing Bina
Column Files” section. ClickCancel to exit the import dialogs without importing.
Select the Import File Type Transform Part 3: Reference Manual
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Importing Binary Column Files

Importing binary columns files is a three-step process. First, selectBinary Columns
in the Import File Format dialog and clickOK ; second, after designating preference
inside the Binary Columns dialog, clickOK ; third, choose preferences within the
Select Columns dialog (described in the next section).

Number Type

Select the number type from the menu.

Swap Bytes

Select this option if your data comes from a computer where binary data is store
with the reverse byte order.

Skip Bytes

Enter the number of bytes for Transform to skip before reading data.

Number of Rows and Number of Columns

Here enter the number of rows and columns of data to read from the file.

View File...

Lets you view the data in hexadecimal before you import. The View File dialog i
discussed at the end of this chapter.

OK and Cancel

Click OK  to go to the Select Columns dialog, described in the section below. Cli
Cancel to exit the import dialogs without importing the file.

Figure 9-12: Binary Columns Dialog
Transform Part 3: Reference Manual Select the Import File Type
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Selecting Columns

If you are importing either text or binary column data, the next step is the Select
umn(s) dialog, shown in Figure 9-13. The options on this dialog are described b

X-Y Columns (Windows) or
Coordinates Columns (Power Macintosh)

Select which column contains the data for Dimension 1 (X) and Dimension 2 (Y
These are the two independent variables in the matrix.

Data Columns

All of the columns are listed, along with the column names if available. Choose 
data column or columns from the list. Use the Shift key for continuous selection
the Ctrl (or Command) key for discontinuous selection. For every data column th
you select, Transform will generate a separate dataset. If you select column 0, ‘
Data Column’, as your data column, Transform assumes that every X, Y pair ha
value between 0 and 5.

View File...

Lets you view the data before you import. The View File dialog is discussed in th
next section.

Figure 9-13: Select Column(s) dialog
Select the Import File Type Transform Part 3: Reference Manual
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Configure...Target Matrix

Click theConfigure...button to define the grid that Transform will use in convertin
your column data into matrix format.

Minimum and Maximum —To specify the minimum and maximum values for the X
and Y numerical scales of the target matrix, enter values inside the boxes to the
of the designated columns. The minimum and maximum values that Transform fo
in the selected X and Y columns are posted above each box in which you enter
ues. You may want to reduce the X and/or Y range to omit data values that lie out
your region of interest.

Increment and # Points—Specify the X and Y numerical scales spacing of the targ
matrix. If you change Increment, then # Points changes, and vice-versa.

Data—For the data columns, you can set minimum and maximum data values o
interest. Any values outside the range specified for that column are omitted. The
actual data column minimum and maximum appear directly above these fields.
Change the number in the Data box or use the arrows to cycle through the eligi
data columns.

Rounded Scales and Actual Scales—Enters the exact minimum and maximum X
and Y values found in the column data. Click on Round Scales to have Transfor
suggest X and Y scale values with a rounded increment.

Figure 9-14: Target Matrix Dialog
Transform Part 3: Reference Manual Select the Import File Type
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Specify... Data Placement

Click theSpecify... button in the Select Columns dialog to open the Data Placem
dialog. This dialog lets you establish a method for handling multiple values per c
and the value for cells that receive no data values.

Use Last Value Encountered (Windows) or
Replace Previous Value (Power Macintosh)—Second or succeeding data values
simply replace earlier entries.

Sum Values—Later values are summed so each cell contains the total of all data
points that mapped to that cell.

Average Values—Each cell gets the average of all data points that are placed in 
cell.

Background Fill Value—Specifies the data value to use for cells that get no data
ues. Transform attempts to provide a suitable fill value by default.

Method... Fill Matrix

Click theMethod...button in the Select Columns dialog to open a dialog that lets y
specify what interpolation method you want Transform to use to fill out the matr
from your scatter data. ClickNo Fill  to just place your scatter data and leave the re
of the Target Matrix set to the Background Fill Value. Fill methods are discussed
detail in Chapter 11: Data Preparation.

Note
For large datasets, we recommend that you import using theNo Fill  option, save
your dataset as HDF and then fill the data using the algorithms available from 
Numbers menu as described in Chapter 11.

Figure 9-15: Data Placement Dialog
Select the Import File Type Transform Part 3: Reference Manual
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View File

In most of the import dialogs, you have the opportunity to view the contents of y
data file with the View File dialog. It lists all of the data in your file with row and co
umn numbers to help you fill in the required fields for importing. If this dialog dis
plays data that you cannot read, you may be trying to import binary data as text

The binary form of the View File dialog is shown below. It lists each data byte in
hexadecimal, 16 values per line. On the right side, it lists the ASCII equivalent o
each byte, if any. If you can read all the text on the right side, you are probably try
to import text data as binary data.

Figure 9-16: View File Dialog - ASCII

Figure 9-17: View File Dialog - Binary Data
Transform Part 3: Reference Manual View File
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When you load or create a dataset, Transform creates a dataset window that show
values formatted as a spreadsheet. If you have notebook information stored wit
dataset, Transform also opens a Notebook window.
Transform Part 3: Reference Manual 125
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Data in Transform

Transform works with two-dimensional arrays of IEEE floating point numbers.
Transform’s working representation of a dataset has the following properties:

• Single-precision, 32-bit floating point numbers are used for all values.

• Each array can be defined in terms of three variables: two independent varia
that correspond to the row and column labels, and a dependent variable that
value at every point in the array.

• The names of the variables are stored and used when appropriate. The depe
variable name also functions as the name of the dataset window and is used
notebook calculations.

• A list of numbers exist for each of the independent variables. One list has an
entry for each column and defines values along the width of the grid. The ot
list has an entry for each row, and defines the values along the height of the

• Transform stores the grid size as number of rows (rows) and columns (cols)

• The values of the dependent variable are located inside the grid, one at eac
point. The total number of values is rows*cols.

• Fortran format fields are maintained for the variables. When the floating-poin
numbers appear in the dataset window, they are printed in the specified form

The floating point values stored by Transform are 4-byte, 32-bit IEEE standard fl
ing point numbers. 24 bits are used for the mantissa.

Significant precision: 7 to 8 digits

Maximum positive number: 3.4E+38

Minimum positive number: 1.2E-38

Maximum negative number: -1.2E-38

Minimum negative number: -3.4E+38

Infinity: INF

Not a Number: NaN (divide by 0, log of zero)

Table 10-1: IEEE Floating-point Values
Data in Transform Transform Part 3: Reference Manual
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Open/Create New Datasets and Attributes

This section describes the commands used to open a file into a dataset window, c
a new array and modify the dataset display.

Open... Command

SelectOpen... from the File menu to choose a file to open in Transform. If the file
type is automatically recognized by Transform, the dataset window appears, as
shown in Figure 10-1. If the file type is not automatically recognized, refer to Chap
9 for information on file types, data types, and how to ensure that your data can
read into Transform.

New... Command

Use theNew... command from the File menu to create a new array of all zeros or o
without opening a file. The New Dataset dialog shown in Figure 10-2 appears. E
a new name or leave the default name of “Untitled” in the first edit box. In the ro
and columns boxes, enter the desired size for your new array or accept the defa
20 rows and 20 columns. The smallest size is 1 by 1 and the largest size is limit
only by available memory. Two radio buttons allow for the choice of all 0’s or all 
for the data values in the array.

Figure 10-1: Dataset Window
Transform Part 3: Reference Manual Open/Create New Datasets and Attributes
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Click OK  to create and display the new dataset in its own window.

Attributes... Command

The name of the dataset, the printing formats used in the dataset window and o
settings can be changed in the Attributes dialog. To access the Attributes dialog
the current dataset, chooseAttributes... from the Numbers menu.

The name displayed in the lower right of the dialog is the filename associated w
the current dataset. You can only change the dataset name in the Attributes dialo
the name of the file. To save the dataset with another filename, use theSave As...
command.

Figure 10-2: New Dataset Dialog

Figure 10-3: Attributes Dialog
Open/Create New Datasets and Attributes Transform Part 3: Reference Manual
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Names

Transform uses the dataset name as the title for the dataset window and the pre
name for all windows associated with this dataset. You will also use this name in
macros to refer to this dataset. If you change the name using this dialog, the ch
will be reflected immediately in the name at the top of the data window and all a
ciated windows.

The Row and Column names are labels for the row (Y) and the column (X) dime
sions of the dataset. These entries appear as labels for the selection region prin
image windows, as the axes text labels in plots, and in printouts.

Display Formats

Data Format specifies the printing format for all array data in the dataset window
Scale Format specifies the printing format for the row and column scale labels i
dataset window. All formats are specified in Fortran-77 format, which are descri
in Table 10-2. When you clickOK , the dataset window redraws with the formats yo
specify. This only changes the printing format of the numbers, not their accurac
image generation or calculations.

Format Specifications

Display format specifications are used for array data, for row/column labels, for
numerical scales on the plots, and for labels on contour plots. The options are:

In  Integer format where ‘n’ is the number of digits allowed in the num-
ber. There are no decimal points or exponents printed for integers.

Fm.n Floating-point format where ‘m’ is the total number of characters
allowed, including the decimal point and minus sign (if negative). ‘n’
is the number of digits to follow the decimal point. Exponents are not
printed.

Em.n Exponential format where ‘m’ is the total number of characters
allowed, including the decimal point, sign, and exponent. ‘n’ is the
number of digits which are to follow the decimal point.
Transform Part 3: Reference Manual Open/Create New Datasets and Attributes
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Table 10-2 shows the value of pi printed in several example formats. The ¤ char
shows where spaces occur.

I5 ¤¤¤¤3

F5.0 ¤¤¤¤3

F5.2 ¤3.14

F10.5 ¤¤¤3.14159

E9.2 3.14e+000

E20.6 ¤¤¤¤¤¤¤¤3.1415593e+00

Table 10-2: Value of pi Printed in Different Fortran-77 Formats
Open/Create New Datasets and Attributes Transform Part 3: Reference Manual
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Tools in the Dataset Window (Windows only)

When a dataset window is active in Transform for Windows, the tool palette sho
two tool icons, Select and MinMax. Each of these tools gives you data manipula
options for the current dataset.

Select Tool

The Select tool for dataset windows brings up a toolbar which shows you the loca
of the current selection region and allows you to change individual data values. 
example of the toolbar is shown in Figure 10-4. If multiple rows or columns are
selected, the boxes display the entire range of selected data.

To change a single data entry, select the value you wish to change, click in the D
Value text field, then type a new value. (Data selection is discussed more fully in
Chapter 20.) Press Enter to make the new value take effect.

MinMax Tool

The MinMax tool for dataset windows brings up a toolbar which displays the min
mum and maximum values in the current selection region, the current minimum
maximum settings for the dataset, and three button options. An example is show
Figure 10-5.

Figure 10-4: Select Toolbar

Figure 10-5: MinMax Toolbar
Transform Part 3: Reference Manual Tools in the Dataset Window (Windows only)
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The first button invokes the Dataset Min/Max dialog; this dialog allows you to chan
the current dataset min/max settings. The second button resets the current data
to the actual minimum and maximum data values. The third button updates all im
windows that are dependent on this dataset with the new minimum and maximu
settings.

Dataset Min/Max Dialog

Click the Dataset Min/Max button in the toolbar to bring up the dialog shown in F
ure 10-6.

The Dataset Min/Max dialog displays both the actual and the current data range
you know that certain data values are invalid or are outside your range of intere
change the current settings for the minimum and maximum to include only your
desired data values. These values are used whenever images or plots are gene
from the Image menu. You can also use the MinMax tool for each image individua
to set the data range. See Chapter 13 for more information on how the data ran
used and controlled.

Reset

Click this button to reset the current data range to the actual smallest and largest
bers in the dataset.

Update All WIndows

After you have set your current data range, you can update all associated imag
dows at once. Click this button to redraw all images and plots that depend on th
dataset. The effect is the same as entering the identical data range into the Min
tool of each individual window.

Figure 10-6: Min/Max Dialog
Tools in the Dataset Window (Windows only) Transform Part 3: Reference Manual
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The Notebook Window

The Notebook window in Transform is a place to add comments about your data
to enter and execute macro commands. An example of a Notebook window with
is shown in Figure 10-7. For a description of using the notebook for calculations
examples, see Chapter 22.

If a Notebook window does not exist for your current dataset, you may create on
selectingSee Notebookfrom the Numbers menu. A blank window will appear,
where you can type and edit information about the dataset. In Windows, text font
size for the window are set in the Preferences dialog. In Power Macintosh, the t
font and size for the window are set with theFont... command from the Edit menu.

If you save a dataset for which you had opened a notebook window, that notebo
window is automatically saved when you save the file. When you subsequently re
the dataset, the notebook window is loaded and opened automatically.

Note
There is a size limit of 32K to the contents of a Notebook window.

Figure 10-7: Notebook Window
Transform Part 3: Reference Manual The Notebook Window
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Several of Transform’s commands manipulate data, creating new datasets base
old ones. This chapter describes the commands and methods used to manipula
fill data.
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Data Manipulation Methods

This section describes the data manipulation commands available from the Num
menu.

Extract Selection

You can create a new dataset by extracting a region from an existing dataset. T
this, select the desired region of values in a data or image window. Then choose
Extract Selectionfrom the Numbers menu. A new data window will appear with ju
the selected data values. The new dataset has the name of the original dataset w
‘_x’ extension added. The corresponding row and column scales are automatica
extracted.

Change Data Entry

To change a single data entry or the format in which data points or scale labels
appear, on Windows use the text fields provided in the toolbar when the Select to
active.

In Power Macintosh, select a data point, choose theChange Data Entry...command
from the Numbers menu or double-click on any data value. The Edit Data dialog
appear, as shown below.

The row and column number of the selected data point are shown. Enter a new
for the data element in the box.

Figure 11-1: Edit Data Dialog (Power Macintosh)
Data Manipulation Methods Transform Part 3: Reference Manual
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Array Data:

Here you can specify the format for all data elements in Fortran-77 floating point
exponential formats. Select the desired format from the pop-up menu. If none o
these prepared formats suits your purposes, you may enter a custom format usin
Attributes dialog discussed in Chapter 10.

Row/Col Labels:

Same as above, but for the row and column labels.

Generate Scales

To change the scales of an existing dataset, use theGenerate Scales... command.
from the Numbers menu to invoke the dialog shown in Figure 11-2.

In this dialog, you may choose new starting and ending values for the row or colu
scales or both. If you enter a new start or end value, the interval field automatica
updates to show you the new interval. Scales may either increase in value with 
itive interval or decrease in value with a negative interval. Swapping the axis dir
tion can be done by simply switching the start and end values for the scales.
Generate Scales... can create only evenly spaced scales.

When you clickOK , a new, copied dataset is created with the new scale values. 
new dataset has the name of the original dataset with a ‘_s’ extension added.

Figure 11-2: Generate Scales Dialog
Transform Part 3: Reference Manual Data Manipulation Methods
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Smooth Data

To smooth your data, selectSmooth Data... from the Numbers menu to bring up the
dialog in Figure 11-3.

Specify the number of smoothing passes to be performed, then clickOK . The
smoothing is done by averaging every point with its eight neighbors. This proce
repeated for the specified number of passes. Transform creates a new dataset 
smoothed data. The new dataset has the name of the original dataset with a ‘_s
extension added.

Resample Data

To create a new dataset of a different size from an existing one, choose Resample
Data... from the Numbers menu to display the dialog shown in Figure 11-4.

The options in this dialog are described below. When done, clickOK  to create the
new dataset. The new dataset has the name of the original dataset with a ‘_rs’ e
sion added.

Figure 11-3: Smooth Data Dialog

Figure 11-4: Resample Data dialog
Data Manipulation Methods Transform Part 3: Reference Manual
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Zoom, New Size

Specify the size of the new dataset by clicking on the up or down arrows to chan
the Zoom or by just entering the new number of rows and columns.

Because resampling is done on inside values only, doubling the size of the data
reduces the interval by a little more than one half. The new array is one number
big for an exact match. Subtract one from the new size if you want the new scal
interval to be exactly one half the old scale interval.

Interpolation Method

Choose whether the interpolation should use a bilinear, bi-quadratic, or a bicubic
mulation. Data values are interpolated first along rows and then along columns.
interpolation method is used only when resampling to a larger dataset. For resa
pling to a smaller dataset, an averaging method is used. Every data point in the
nal dataset that maps to a single point in the result is averaged to calculate the 
value.

Select Grid...

If you are resampling to create a different data distribution, clickSelect Grid.... The
dialog shown in Figure 11-5 appears.

Choose whether to use a linear scale or produce one or both scales with axis va
distributed along a logarithmic scale. In this case, the dependent values are red
uted according to a logarithmic scale within the matrix.

Figure 11-5: Select Grid dialog
Transform Part 3: Reference Manual Data Manipulation Methods
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Note
Even if one or both scale axes are distributed logarithmically,Generate Imagewill
not create an image with a logarithmic effect because Transform takes the new
arithmic scale into account when the image is generated. To see a logarithmic
image, use theGenerate Scales... command to force the scales to be uniformly
spaced (linear) before generating an image.

Because resampling is done on inside values only, doubling the size of the data
makes the array two numbers too big for an exact match. subtract two from the 
size if you want the new scale interval to be exactly one half the old scale interv
Data Manipulation Methods Transform Part 3: Reference Manual
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Fill Missing Data

Transform'sFill Missing Data... command is used to replace unwanted data value
with estimates of what those data values should be based on neighboring data.
Unwanted values usually represent background values or omissions in the data w
are set to some arbitrary number, like -999. In Transform, the methods for repla
missing data values can be accessed either from theFill Missing Data... command on
the Numbers menu or when importing a data file. The Fill Missing Data dialog, wh
accessed as a menu command, appears as shown in Figure 11-6 below.

When you clickOK , the fill process produces a new data window with the missin
data values removed. The new dataset has the name of the original dataset with
‘_md’ extension added. The options in the dialog are discussed below.

Matrix Fill Methods

Transform offers six methods for replacing missing data values with values inter
lated from true data values: No Fill, Nearest Neighbor Interpolation, Kernel Smo
ing, Linear Interpolation, Weighted Fill, and Kriging. Some methods are faster,
easier, and less accurate, like kernel smoothing; others take longer but are more
rate, like kriging. All of the methods become less accurate as the number of mis
values increases.

Figure 11-6: Fill Missing Data Dialog
Transform Part 3: Reference Manual Fill Missing Data
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No Fill

This option is only available when theMethods... button in the Select Columns dia-
log is pressed during import. Select this option to bypass Fill Missing Data durin
import. The option is not available from the Numbers menu.

Nearest Neighbor

The easiest method of filling missing data values is the nearest neighbor fill met
which replaces each missing value with exact copies of the value of its nearest 
missing neighbor. The nearest neighbor method always preserves the true data v
and does not average the values.

Linear Interpolation

The linear interpolation method replaces each missing value with a linear interp
tion of its nearest neighbors (i.e., data values in the same row, the same column
both). Select Rows to interpolate from left and right neighbors, Columns to inter
late from above and below neighbors, and Rows and Columns to do both interp
tions and then take the average. Linear interpolation tends to show horizontal a
vertical streaks but always preserves the true data points. The linear interpolatio
method is ideal when there are only a few missing data values.

Kernel Smoothing

To calculate the value of a missing data point, kernel smoothing uses the avera
the missing value’s eight neighbors. Multiple passes are used until no more mis
data points remain. This method has a heavy smoothing effect on not only the m
ing data values but also on known values. Hence, your original data values are 
preserved.

Weighted Fill

In the weighted fill method, each missing data element is set to the weighted ave
of a region surrounding the missing data element. Known data values that are clo
the missing data element are weighed heavily, while those far away are weighe
lighter. See the section below on Weighted Fill Parameters for more details.

Kriging

Select this option to used Kriging to fill each missing data value with a statistica
weighted average of neighboring points. See the Kriging and Kriging Parameters
tions below for more explanation and available parameters.
Fill Missing Data Transform Part 3: Reference Manual
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Preserve defined data point values (Power Macintosh)

Select this checkbox to guarantee that all true data values are preserved. If this o
is not selected, the original data values may be modified by the filling process. O
the resulting dataset is smoother with this option deselected (for use with Weigh
Fill only). Nearest Neighbor, Linear Interpolation and Kriging always preserve th
original values. Kernel smoothing never preserves the original values.

Note
On Windows, this option is available in the Weighted Fill Parameters dialog
described in the next section.

Missing Data

The combo box at the bottom of the dialog and the edit field next to it specify wh
values are to be treated as missing data. These numbers are background, or und
and need to be eliminated from the dataset. There are three menu choices: equ
integer, less than, and greater than. You may choose an exact value if all of your
ing data values are set to the same number (-999 for example). Otherwise, miss
data can be defined as all numbers less than the indicated value or all numbers g
than the indicated value.

If you are importing a column dataset, this choice is not available. During import,
background value is already specified in the Data Placement dialog.
Transform Part 3: Reference Manual Fill Missing Data
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Weighted Fill Parameters

In the Fill Missing Data dialog, click theParameters... button next to the Weighted
Fill option to display the dialog shown in Figure 11-7. In weighted fill, each miss
data value is set to the weighted average of its nearest true data values. The we
depend on the distance of the true values and on a distribution function that you
ify. The selections for distribution function and range of the spatial distribution fu
tion are discussed below.

Linear

When you use the Linear Distribution Function method, weights drop off linearly
(1/d) with distance from missing data value.

Spherical

The weights drop off as the reciprocal of the distance squared (1/d^2) with dista
from the missing data value.

Exponential

The weights drop off as an exponential (e^-d) with distance from the missing da
value.

Gaussian

The weights drop off as a normalized Gaussian distribution with distance from t
missing data value.

Figure 11-7: Weighted Fill Parameters Dialog
Weighted Fill Parameters Transform Part 3: Reference Manual
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Range

Range specifies the distance from the missing data value to look for true data va
in column/row index number units. The default distance is based on the percenta
missing data values in the dataset, given by the following formula:

dist = 2 * sqrt (#_of_pts/(#_of_pts - #_of_missing_pts))

If you want a smoother fill, increase the fill distance. For more accuracy, reduce
distance. A distance of ‘1’ means no averaging takes place.

Preserve Defined Data Point Values (Windows)

Select thePreserve Defined Data Point Values checkbox to guarantee that all true
data values are preserved. If this option is not selected, the original data values
be modified by the filling process. Often the resulting dataset is smoother with th
option turned off.

Note
On Power Macintosh, this option is available in the Fill Missing Data dialog.
Transform Part 3: Reference Manual Weighted Fill Parameters
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Kriging

Kriging is the most accurate fill method, especially if the spatial continuity of the
attribute (sample values) is more continuous in some directions than in others. F
example, if the spatial continuity is more continuous in horizontal than vertical dir
tions. In order to “krig” unsampled locations, the kriging algorithm must know ch
acteristics of the spatial continuity associated with the sample data. This informa
is supplied through a variogram model or Sill, Nugget, Range, and model type.
Together, these parameters describe the spatial continuity.

Kriging estimates the value of an attribute at unsampled locations by computing
weighted linear combination of the neighboring sample values. Kriging uses spa
continuity information to compute “optimal” weights. What are optimal weights?
Consider a number of estimates that were calculated using an identical data co
ration. There will be an estimation error associated with each of these estimates
Although we do not know these errors, they exist and cannot be eliminated. The
solution is to “minimize the variance” of these errors which is precisely what krigi
does. This is why kriging is said to be the most accurate linear estimator.

For additional kriging information, see the following publication:

Isaaks, E.H., & Srivastava, R.M. (1989).An Introduction to Applied Geostatistics.
Oxford University Press.

Kriging Parameters

In the Fill Missing Data Dialog, click theParameters... button next toKriging  to
invoke the Kriging Parameters dialog shown in Figure 11-8.

Figure 11-8: Kriging Parameters Dialog
Kriging Transform Part 3: Reference Manual
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Spatial Distribution Model

Each of these models describes how the spatial continuity changes with separa
distance. Usually, the model is chosen that best fits the sample variogram calcu
from sample data. Figure 11-9 shows examples of the spherical, exponential an
Gaussian models with the same range and sill.

• Linear — The equation for the linear model is given by:

(h) = a * h

whereh is a distance vector, anda is the slope. Note that this model has no sill

• Spherical — This is perhaps the most widely used model of spatial continuity.
equation is given by:

(h) = 1.5 *h/R - 0.5 * (h/R)3 for h > 0 and h < R

= 1.0 forh  R

= 0 forh = 0

• Exponential — The equation for the exponential model is given by:

(h) = 1 - e-3 h/R

• Gaussian — The Gaussian model is characteristic of extreme spatial contin
Since earth science data is usually not noted for its extreme continuity, this m
is used less frequently than the others. Its equation is given by:

(h) = 1 - e -3 (h/R)2
Transform Part 3: Reference Manual Kriging
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The range specifies the distance at which the variogram model achieves the sill
Figure 11-9). When entering range values, higher numbers correspond to a high
relation between data points, whereas lower numbers indicate the opposite. The
higher the range value, the further the weighting average for calculating missing
ues will extend. Since range is a directional feature, the range in the direction o
increasing column numbers may be different from the range in the direction of
increasing row numbers. Figure 11-10 shows an example where the column ran
12 while the row range is 2. The ratio of the column to row range is called the an
ropy ratio. This feature is most useful when the spatial continuity of the attribute
under study shows stronger spatial continuity in some directions than in others.
example, the sample values in Figure 11-10 show a much stronger correlation i
direction of increasing columns than in the direction of increasing rows. Note that
kriged values also tend to reflect this anisotropy.

Figure 11-9: Three Commonly used Variograms Models - the Spherical,
Exponential, and Gaussian Shown Here with the Same Range and Sill
Kriging Transform Part 3: Reference Manual
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The sill is the plateau (if any) that the variogram reaches (see Figure 11-9). Usu
the sill is constant for all directions. Note that the sill value is usually similar to th
variance of the input data. Thus, the variogram sill can usually be standardized 
value of 1 by dividing by the variance of the input sample data.

The examples above illustrates a matrix fill using kriging with an anisotrophic mod

Note
The Column Range, Row Range, and Sill fields must be greater than zero whe
Kriging. Also, the Nugget field must be greater than or equal to zero and less t
the Sill value.

Figure 11-10: Anisotrophic Model
Transform Part 3: Reference Manual Kriging
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Nugget

The nugget effect is an apparent discontinuity at the origin of the variogram. Th
may be a combination of both sampling error and genuine short-scale variability
very small distances.

Desired Sample Size Per Kriging Pass

If the actual number of data points exceeds this value, the Kriging routine will th
divide the dataset into multiple regions and krig each region individually. You sho
use the largest possible sample size to get the greatest accuracy. However, larg
ple sizes (>100) are very computational intensive.

Construct Variance Matrix

If selected Transform produces two datasets instead of one. The second datase
tains the kriging variance for each kriged point in the matrix. The variance data 
has the name of the original data set with a '_var' extension added.

Display Kriging Statistics

If selected, a dialog of statistical information about the kriging operation is display
Kriging Transform Part 3: Reference Manual
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Transform helps you look at your data using images, line graphs, and contour, s
face, vector, polar (Macintosh), and histogram (Windows) plots. Each image wind
is built on a similar foundation and has similar tools. Throughout this chapter an
image window is used to illustrate the attributes shared by all image types.

The Reference Manual dedicates one chapter for the discussion of each image
The image commands and the chapters in which they are discussed are listed b

• Generate Image (Chapters 12 and 14)

• Interpolated Image and Polar Plot (Chapter 14)

• Line Graph (Chapter 15)

• Contour Plot (Chapter 16)

• Vector Plot (Chapter 17)

• Surface Plot (Chapter 18)

• Histogram (Chapter 19)
Transform Part 3: Reference Manual 151
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Create Images and Plots

Images are generated by selecting the image command from the Image menu. 
example, to generate a simple image, activate a dataset window, then select theGen-
erate Imagecommand from the menu. A new window displaying that image is au
matically generated.

The window name in the title bar displays the name of the dataset that Transfor
used to create the image. It includes a suffix that matches the image type and a
ber (e.g., waves.image1). Beneath the image is the canvas—the imaginary surfa
image rests on. Scroll bars control the position of your view onto the canvas.

Figure 12-1: Simple Image
Create Images and Plots Transform Part 3: Reference Manual
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The Tool Palette

The tool palette is located along the left-hand side of the image window. The tool
ette has space for nine tool buttons: Select, MinMax, Fiddle, Resize, Overlay, A
Vector, Label, and Contour. These tools are shown in Table 12-1 and are describ
detail in this and later chapters. The tools available depend on the image type.

Windows
Tool Icons

Macintosh
Tool Icons

Tool
Name Description

Select Sets the selection region

MinMax
Sets the minimum and maxi-
mum data values

Fiddle
Manipulates the color
table

Resize
Resizes or moves the image
region

Overlay
Resizes or moves the overlay
(if present)

Axis
Controls axes labels and
titles

Label
Places text labels for levels on
contour plots

Contour
Places a level on contour
plots

Vector
Controls appearance of
arrows on vector plots

Table 12-1: Tool Palette
Transform Part 3: Reference Manual The Tool Palette
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The Select Tool

The default tool for all new image windows is the Select tool, which allows you t
define a selection region for an image by clicking and dragging. All plot types, exc
the surface plot and histogram (Windows), allow selections that are coordinated
between windows. Clicking the Select tool provides additional options in the tool
(Windows) or the bottom margin of the image window (Power Macintosh).

In Windows, the coordinates of the current selection region are displayed in the
bar. TheShow Selection button in the Select toolbar toggles the display of the sel
tion region in the image.

In Power Macintosh, the coordinates of the current selection region are printed a
left side. The checkbox next to the selection range toggles the display of the sele
region. For all color plot types a color bar appears just below the image. From le
right, the colors in the bar represent increasing data values from the smallest to
largest displayed in the image.

Tip
Power Macintosh: to quickly return to the Select tool after using a different tool, u
the Escape key (Esc).

The arrow cursor keys on the keyboard can be used with the Select tool to chang
position of the selection region. Each arrow direction key (up, down, left, and rig
moves the entire selection region one data element in that direction. The select
region size always remains the same size. If the region bumps against the edge
array, the arrow key in that direction is ignored.

Figure 12-2: Select Tool Options (Windows and Power Macintosh)
The Select Tool Transform Part 3: Reference Manual
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The MinMax Tool

The MinMax tool displays and allows you to change the minimum and maximum
data values Transform uses for the color, height, contour, or vector scaling of the
rent plot. In Windows, any values outside the range shown are either ignored or
replaced during the image generation process; in Power Macintosh, values outs
the range are either skipped, ignored or smoothed over. The Windows toolbar a
bottom margin of the image window (Power Macintosh) for the MinMax tool are
shown in Figure 12-3.

The MinMax tool allows you to specify values for high and low data outliers (Win
dows), reset data minimums and maximums, and update other windows. By spe
ing a minimum and maximum data value, you can focus your analysis on a partic
range of interest. Transform allows you to associate a range with the dataset. All p
or images created will respect the dataset's range of interest. In addition, you ca
modify the range of individual plots or images. The range of interest is generally
modified with the MinMax tool. (MinMax and outliers are discussed in more detail
Chapters 3 and 13.)

Windows MinMax Toolbar

In Windows, in addition to showing the range of interest, the toolbar shows the ra
of data values in the selection region.

Reset Data Min/Max

Clicking onReset Data Min/Maxresets the data min/max to the absolute min/ma
of the entire dataset.

Edit Outlier Colors

Editing the color values for high and low data outliers is discussed in Chapter 13

Figure 12-3: MinMax Options (Windows and Power Macintosh)
Transform Part 3: Reference Manual The MinMax Tool
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Update All Windows

When you have more than one window open and want to change the data range
of them simultaneously, click on theUpdate All Windows button. This changes the
data range for all associated windows.

Power Macintosh MinMax Options

The bottom margin of the image window displays and changes the minimum an
maximum data values Transform uses for the color, height, or vector scaling of 
current plot. Edit the value range and invoke the new values with theReplot button
(you also can activate the new values by pressing Enter). Transform recalculate
entire plot using the new min/max values, and then re-displays it.

When theColor Bar... button is available (all except vector plots) click this button t
bring up a Color Bar window, the same as using theColor Bar command from the
Image menu. Any new values you set in the color bar window while the Min/Max
tool is active are copied to the active edit boxes in the image window. When you c
Replot, the new values take effect.
The MinMax Tool Transform Part 3: Reference Manual



Chapter 12: Image Windows 157

ol-
he

ed

aps
cen-
rag-
r
ging
, the

data
lor

ck
ves,

e of
Fiddle Tool

The Fiddle tool allows you to interactively change the current color table.  The to
bar (Windows) and bottom margin of the image window (Power Macintosh) for t
Fiddle Tool is shown below.

Fiddle buttons for Windows and pop-up menus for Power Macintosh are discuss
below.

Fiddle Colors

Fiddle Colors lets you play with the color mapping while looking for interesting
aspects of your image. Technically, Transform takes the mouse position and rem
the current color table by compressing or shifting the color range. Clicking at the
ter of the image leaves the colors where you started. Clicking the mouse at (or d
ging to) a position to the left or right shifts the color range left or right. Clicking o
dragging above the center expands the color range. Conversely, clicking or drag
below the center line compresses the color range. With the GrayScale color table
effect is quite like adjusting the contrast and brightness on a black-and-white TV
screen. Note that while the color mapping is changing dramatically, the original 
array is not affected in any way. The color scaling equation of original data to co
numbers is unchanged; you are only changing the color assignments.

Rotate Colors

Rotate Colorsshifts all of the colors to the left or right as you move the mouse. Cli
anywhere in the image and drag the mouse to the left or right. As the mouse mo
the colors move at the same rate. Note that the colors which fall off the right sid
the bar are brought in at the left side (and vice versa).

Figure 12-4: Fiddle Options (Windows and Power Macintosh)
Transform Part 3: Reference Manual Fiddle Tool
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Change Colors

Change Colorsselectively changes any color or range of colors to white or black
Windows, or to white on Power Macintosh. Click on the image at any location to
change that color entry.

If you drag the mouse after a click, Transform changes only the color under the
mouse to white or black. Holding down the Ctrl key (Windows) or Shift key (Mac
tosh) restores the original color at the point under the mouse. Holding down the s
key while dragging has a cumulative effect—all the color numbers between the 
pixel color and the current pixel color are changed to white or black.

Drag Colors (Windows only)

Drag Colors lets you use the mouse to take a color from any position in the colo
table and copy it to any other position in the color table. Click on a color in the ima
With the mouse button depressed, drag the mouse to any other location in the i
and release the button to drop the initial, copied color into the new location, replac
the color that was there.

Restore

Restorechanges the color table in your image to what it was before you fiddled w
the colors.

Note
Power Macintosh: if you choose a new color table from the Color Tables menu, r
in an image from disk, or load a color table from disk, the previous table canno
restored.

When you save, only the modified table is saved with the image.
Fiddle Tool Transform Part 3: Reference Manual
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Resize Tool

This tool is used to change the size and location of the image. Figure 12-5 show
example of a toolbar (Windows) and bottom margin of the image window (Powe
Macintosh) for the Resize tool. The current position and size of the image are sho
In Windows, you may type new values directly into any of these fields and have
image size automatically recomputed. Buttons provided access the image size d
fit the image to the current window size, and force the image aspect ratio (Wind

The resizing options for both Windows and Power Macintosh are described belo

Fit to Window

To change the size of the image to the currently visible canvas area in the windo
first resize the window to the desired size, then clickFit to Window.

Rectangle Size

To set the image size of a currently active image, click on the Rectangle Size... but-
ton. The Image Size dialog shown in Figure 12-6 appears.

Figure 12-5: Resize Tool Options (Windows and Power Macintosh)

Figure 12-6: Image Size dialog
Transform Part 3: Reference Manual Resize Tool
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The Zoom boxes let you change image size by specifying an expansion factor t
applied to the dataset dimensions. The New Size (Windows) or Pixels (Macintos
boxes let you specify image size directly; the values in these boxes match the im
size displayed in the toolbar or at the bottom of the image. You can also set the si
a future image, by choosingImage Size...from the Image menu to invoke the Image
Size dialog. The new size takes effect for the next image generated.

1. Fix Aspect Ratio (Windows)

TheAspect Ratiobutton changes the image size so that the aspect ratio of the im
matches the dataset. The aspect ratio is calculated from the dataset’s scale ran

Interactive Sizing and Moving

In Windows, to interactively size the image, click on any of the eight black rectang
surrounding the image and drag the rectangle frame to a new size. When you re
the mouse, the image is recalculated at its new size and location.

In Power Macintosh, click in the small white size box at the lower right of the ima
and drag the rectangle frame to a new size. When you release the mouse, the im
recalculated at its new size to fit the new frame. To maintain the aspect ratio of 
image while resizing, hold down the option key during the resizing operation.

To move the image, click the mouse inside the image and drag the entire frame
new position on the canvas. The size and location display are updated as you m
and stretch the image.
Resize Tool Transform Part 3: Reference Manual
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Overlay Tool

The Overlay tool lets you paste Windows Meta File (WMF) or PICT (Power Mac
tosh) images on top of an image display. An overlay may be a collection of arrow
boxes, and other annotations, or the outlines of a map, or a plot created within T
form itself. Figure 12-7 shows the Windows and Power Macintosh options when
Overlay tool is selected.

Fit to Window

Clicking theFit to Window  button changes the size of the pasted overlay to matc
the currently visible canvas area in the window.

Size to Match

Clicking theSize to Match button changes the size of the pasted overlay to matc
that of the underlying image. The size and location fields are updated as you m
and resize the overlay.

Note
In the case where contour plots are overlayed onto images, the contours will be
(1/2) a pixel smaller than the image on the edges.

Figure 12-7: Overlay Options (Windows and Power Macintosh)
Transform Part 3: Reference Manual Overlay Tool
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Creating Overlays

Window Meta File (WMF) or PICT (Macintosh) images can be copied to the Clip
board and pasted on top of an image display in Transform. Though overlays can
pasted from other applications, an overlay is typically a plot from another Transfo
window.

The image used for an overlay can be any image copied to the clipboard. After 
ing the desired image, select the image window that will receive the overlay and
choosePaste/Paste Overlayfrom the Edit menu. Transform draws the overlay on
top of the existing image.

You can also display multiple overlays—a vector plot and a contour plot on a ra
image, for example.

See the discussion of the Overlay toolbar earlier in this section for information o
how to resize overlays.

Delete Overlay

To delete an overlay in the currently selected image window, select the Overlay
then chooseClear/Clear Overlay from the Edit menu. In Power Macintosh, you can
also press the Delete key from the keyboard. In some modes, the Delete key is 
used for other functions, so you may have to switch to the Select tool first.

Figure 12-8: Overlay of a Contour Image on an Interpolated Image
Overlay Tool Transform Part 3: Reference Manual
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Raster Overlays

Some overlays, notably raster images created in Transform, are opaque. Becaus
completely obscure anything drawn beneath them, they are not very useful as o
lays.

Color in Overlays (Power Macintosh)

When the Macintosh display is set to 256 colors, a raster image created with Tr
form generally uses all 256 colors. There are no colors left over to share with th
overlay, so a color overlay, whether it contains color lines or a raster image, ma
be drawn with authentic colors. In cases like these, the colors are approximated t
closest available colors.

Either match the required colors between your color overlays and the image un
neath or use a monitor setting with more than 256 colors (usually 24-bit color w
16.7 million colors). With black and white line drawings, you should not experien
any of these problems.

Double Overlays (Power Macintosh)

An example of a double overlay would be a contour plot on top of a vector plot on
of a raster image. Since there is only one overlay displayed per image window, 
ond step is required to accomplish a double overlay. Start with the top layer, the
tour plot, in this example. Prepare the plot and copy it to the Clipboard. Now prep
the vector plot and paste the contour plot into the vector window as an overlay. 
the Selection tool active, copy the contents of this window to the Clipboard; the 
tour plot is copied along with the vector plot. Next, generate the raster image an
paste the double overlay into the new window.

A similar maneuver can be used with an external drawing program to double up
maps and annotations. Add another layer to the double overlay to create a triple
lay or even more. Chapter 6 walks you through an example of multiple overlays
Transform Part 3: Reference Manual Overlay Tool
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Axis Tool

The Axis tool controls the appearance of the title, axes, and color bar annotation
the image window. The toolbar (Windows) and bottom margin of the image wind
(Power Macintosh) for the Axis tool is shown in Figure 12-9.

Surface plot windows have their own separate axis controls, described later in t
section on surface plots.

Show Axes

TheShow Axes button/checkbox toggles axis annotations for the image on and o
including the title, tickmarks, axis labels and the color bar (especially useful for 
ating overlays).

Row, Column, and Color Bar Axis Labels

Click theRow button,Col button orBar button to change the axis labels or tick-
marks for the corresponding axis. The dialogs that open when you click any of t
buttons is discussed later in this chapter.

In Power Macintosh line plots, theBar... button changes toData... to allow modifica-
tion of the data axis labels. Depending on the type of line plot, horizontal or vertic
eitherRow... or Col...will be inactive (grayed out).Bar... is unavailable for plots
which do not use color.

Enable Color Bar (Windows only)

Change the toggle setting for Enable Color Bar to turn on and off the display of 
color bar in the image window.

Figure 12-9: Axes Options (Windows and Power Macintosh)
Axis Tool Transform Part 3: Reference Manual



Chapter 12: Image Windows 165

e
ge.

s
 in
Image Title

Click the imageTitle ... button to bring up a dialog for entering the plot title. The titl
will be displayed in the current font and text size. It will be centered over the ima

Font and Size (Power Macintosh)

TheFont andSize popup menus set the default font for the window. This setting
applies to the axis labels, axis names, and the image title

Axis Labels Dialog

Clicking one of the row, column or color bar axis buttons from the Axis tool allow
you to edit all of the characteristics of that axis in the Axis Labels dialog, shown
Figure 12-10.

Figure 12-10: Axis Labels Dialog (Windows and Power Macintosh)
Transform Part 3: Reference Manual Axis Tool
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Axis Name

This name is displayed next to the axis labels. For the horizontal axis, the name
appears just beneath the labels. For the vertical axis, the name appears rotated
the left of the labels.

Data Range

Displays the actual range of values for this axis. This cannot be changed.

Plot Bounds

Displays the range of values for this axis that are plotted. These numbers canno
changed from the Axis dialog for the Row(Y) and Column(X) axes on color imag
contour plots, and vector plots. If you want your data to be scaled differently, cho
Generate Scales... from the Numbers menu.

You can change these numbers on the Row and Column axes for surface plots, w
you can use it to truncate your surface plot. The plot bounds for all color bars, and
the data axis on surface and line plots, are identical to the data minimum and m
mum values available from the MinMax tool.

Axis Labels

Displays the starting and stopping value for axis labels. You can edit these valu
start and stop labels at values other than the plot boundaries.

Axis Label Increment and Intervals

These boxes let you enter either the spacing for axis labels in the increment box o
total number of intervals in the intervals box. One box automatically updates the
other when changed. In Power Macintosh, click the double-arrow between the b
to switch the active box.

Auto Range Calculation

When Auto Range Calculation is enabled, Transform will calculate the axis mini
mum and maximum values for you. Transform uses the desired number of inter
and the plot bounds to calculate a nice increment and bounds for the labels. Wi
Auto Range turned on, you will be able to change the number of intervals, but y
cannot change the label bounds or the increment.
Axis Tool Transform Part 3: Reference Manual
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Note
If Auto Range Calculation is turned on, you can still enter a number of interval
However, your actual number of intervals may turn out to be slightly different th
what you entered, so the label spacing stays at a 'nice' number

Major Ticks Per Label

This box lets you specify the number of intervals to divide each label interval. Th
are marked with major tickmarks.

Minor Ticks Per Major

This box lets you enter the number of intervals to divide each major interval. Th
are marked with minor tickmarks. The first minor tickmark is drawn at the major tic
so it is not visible.

Label Format

You can enter a custom format in the box or select a format from the combo box/
up menu.

Tickmarks...

TheTickmarks ... button provides access to the Tickmarks dialog, shown in Figu
12-11. This dialog lets you set size and style of tick marks and grid lines.

In  - Clicking this check box draws tickmarks from the axis toward the center of t
plot (inside tickmarks).

Figure 12-11: Tickmarks dialog
Transform Part 3: Reference Manual Axis Tool
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Out - Clicking this check box draws tickmarks from the axis away from the plot (o
side tickmarks).

Grid Lines - Clicking this check box draws a grid line across the plot for each ma
tickmark.

Mirror  - Clicking this check box draws identical tickmarks on the opposite edge
the image area (top and bottom, left and right).

Major andMinor - Entering values in these text fields sets the lengths and widths
major and minor tickmarks, in points. The sizes may be in fractions of a point (e
0.5 point).

Copy From Column (Power Macintosh)

Click this button to copy the printing format, label intervals, major intervals, mino
intervals and tickmark characteristics from another axis record. If you are editing
Row axis, then the button copies information from the Column axis, otherwise th
button copies from the Row axis.

Other Tools

Three additional tools apply to specific plot types, and are discussed in the chap
for those plots. These are the Vector tool, Label tool, and Contour tool.
Axis Tool Transform Part 3: Reference Manual
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apter
Most of Transform’s images and plots use color to represent data values. This ch
describes the color options and use of color in Transform.
Transform Part 3: Reference Manual 169
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Visual Data Analysis

Grayscale images reflect a very simple way of displaying data values visually. Hig
numbers are assigned lighter shades of gray and lower numbers are assigned d
shades of gray. The maximum data value in a dataset maps to white, and the m
mum value maps to black. Because your eye recognizes this scale of intensities
becomes an intuitive system for interpreting, at a glance, the relative data value
the array. The color table for this mapping is named 'GrayScale'.

People are also accustomed to interpreting the rainbow of colors that make up th
ible light spectrum. Hence, images generated in Transform are assigned the 'Ra
bow' color table, by default. This table has a smooth transition from indigo and b
colors that represent low values, to orange and red colors that represent high va
Other color tables may not be so intuitive but can be equally powerful as you inter
data. The 'Rainbow-Banded' color table has darker bands of color equally space
along the spectrum to help create a contour effect. The 'Purple Haze' table has 
cutoff points to mark specific data values of interest.

In raster images, each pixel in the image is a color derived from a data value in 
array. Surface plots can use color to show the data values from one array comb
with a surface formed from the data in another array. Contour plots can be draw
color to reinforce the data value represented by each contour line.
Visual Data Analysis Transform Part 3: Reference Manual
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Color Scaling Equation

Transform uses a linear scaling equation to calculate color numbers from the arra
data values. Colors on the left side of the color bar are mapped to the low value
colors on the right side of the color bar are mapped to the high values of the arr

As an example, take the case of color numbers assigned to shades of gray proce
from color number 1 (black) to color number 254 (white), and a data array with n
bers between 100 and 25,400. The number 21,824 would be assigned color nu
218 (light gray). The number 154 would be assigned color number 1 (black).

Simple Version - Scaling Equation

A simple scaling equation that produces these mappings is shown below. Using
default color range of 1 to 254, the calculation of the colors to use for each pixe
evaluated for every pixel in the array. Themaximum andminimum  values referred
to in the equation are the maximum and minimum values in the data to be scale

range = maximum - minimum
colorvalue = 1 + 253 * (datavalue - minimum) / range

The assignment of a color table determines which colors you see on the screen
color table matches a visible color with each of the numbers from 1-254. In Win
dows, if a calculated color value is <1, it is treated as a "low outlier." If the value
>254, it is a "high outlier." Outliers are handled specially and are assigned black
white, the first color from the table, or the last color from the table (see below).

Full Version - Scaling Equation

The full scaling equation includes the minimum and maximum color values. The
256 colors from 0-255 are not required to create images. You can change minim
and maximum color numbers to a smaller range. The final equation produces a
early scaled set of color values fromcolor_min to color_max. In Windows, outliers
are any data values which fall outside of this color range.

range = maximum - minimum
colorrange = color_max - color_min
colorvalue = color_min + colorrange * datavalue - minimum) / range

For interpolated images, each pixel color is determined by the same equation. Be
the pixel is colored, a smoothed value is calculated with bilinear interpolation. T
interpolated data value calculates the color instead of the exact data values in the
Transform Part 3: Reference Manual Color Scaling Equation
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Modify the Data-Image Correspondence

Here are four ways you can change how colors are used to represent data valu

• Change the data min/max

• Transform the data using notebook calculations

• Choose a different color table

• Change the colors used for low and high outliers

Change Data MinMax

If some of your data values lie outside your range of interest, you can change the
min/max settings. Outliers will not be eliminated from the dataset—just handled
cially during image generation. Use theMinMax tool  or Color Bar window (Power
Macintosh) to change these values.

Transform Data

You can transform the data using built-in expressions and theCalculate From Notes
command under the Numbers menu. For example, if you wanted logarithmic sc
of the colors in your image, you would need to transform the data using Transfo
log( )  function (since color is scaled linearly). See Chapter 22 for more detail

Choose Different Color Table

Choosing a different color table changes the colors you see in the image. The sc
of data values to color numbers is not affected by the choice of color table; only
matching of color numbers to the colors changes. Choose the table that best fits
data you are trying to analyze. Use the ColorTables menu or theCustom Color
Tables... (Windows) orLoad Color Table... (Macintosh) command to change color
tables.

Edit Outlier Colors (Windows)

For outliers, data values outside the selected min/max range, you may choose h
those values are displayed in images. Under the MinMax tool, click the Edit Out
Colors button to bring up the dialog shown in Figure 13-1.
Modify the Data-Image Correspondence Transform Part 3: Reference Manual
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For low outliers (values less than the minimum) and high outliers (values greater
the maximum), you may choose black, white, or end color to display those value
End color is the first or last color in the current color table. Low outliers use the 
color, high outliers use the last color.

Note
Whenever you have outliers, there are multiple data values being displayed with
same color. Take this into account during analysis.

Figure 13-1: Edit Outlier Colors dialog
Transform Part 3: Reference Manual Modify the Data-Image Correspondence
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Color Tables Menu

The mapping of numbers to colors can be changed in any image with the use o
Color Tables menu. Select any one of the color tables from this menu to assign
colors to the currently active image.

Many color tables are available in the Color Tables menu; some are briefly discu
below.

Note
Power Macintosh: 24-bit images imported into Transform are resampled to 8-b
using the24-Bit Sampled color table on the Color Tables menu. to get the most
accurate approximation of the original image, use this color table.

Figure 13-2: ColorTables Menu (Windows)
Color Tables Menu Transform Part 3: Reference Manual
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GrayScale—From black to white, increasing levels of gray.

Rainbow—The color spectrum or hue that includes the following colors: blue, cya
green, yellow, orange, red.

Rainbow-Banded—The rainbow table with bands of darker colors spaced throug
out the spectrum.

Apricot, Ether, Lava Waves—Each of these tables contains many colors with ba
ing effects to bring out contours in the data. They can be misleading in some ca
but can also be effective in bringing out hidden data features.

Purple Haze—An example of a table with sudden transitions in the scale, which
mark specific cutoff points in the data.

Note
To get more than one image to reflect the same colors, select the same new c
table for each one of the images. When two images are set for different color tab
the colors in the front-most image window will take precedence; the colors for 
other image window are ignored. This does not apply to monitors set to greater
256 colors. 16 million (24-bit) colors can simultaneously display multiple image
with different color tables.

Most Recent Custom Color Table (Windows)

The second entry in the Color Tables menu contains the name of the most rece
used custom color table. As described below, the Fiddle tool, opening a saved fi
and importing a color table, all can create a custom color table. Any time one of th
tables becomes active, its name appears in the menu. It remains in the menu u
another custom color table becomes active.
Transform Part 3: Reference Manual Color Tables Menu
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Custom Color Tables... Command (Windows)

Custom color tables are created by using the Fiddle tool, opening certain saved
or importing color table files. TheCustom Color Tables... command keeps track of
and gives you access to these tables. Transform remembers the list of custom c
tables until you exit the program.

Using the Fiddle tool modifies the color table used for the current image window
This modified color table is named and kept as a custom table. Color tables mod
in Fiddle mode are named 'Windowname.fiddle', where 'Windowname' is the nam
the window used. Rotate, Change to White, Change to Black, and Drag modes c
a new color table with a name of the form 'Windowname.change'.

Any color table imported from a file (see Import below) is also remembered as a
tom color table. And, when you open a file with a color table other than one of th
built-in tables, that table is kept.

ChooseCustom Color Tables... from the Color Tables menu to bring up a list of
stored custom tables in a dialog, as shown in Figure 13-3.

This dialog lists all of the custom color tables you have created or accessed since
ning Transform. Select any table from this menu and click Apply to apply this co
table to the current image window. When you do apply the table, it appears as the
ond entry in the Color Tables menu.

Figure 13-3: Custom Color Tables dialog
Custom Color Tables... Command (Windows) Transform Part 3: Reference Manual
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Import...

Transform can load new color tables from files on disk. Included with Transform i
directory with several more example tables to choose from. Click theImport ... but-
ton in the dialog to identify the file to open. These files may be HDF or binary co
table files (see below for more information).

Export...

Transform can also export any of these tables. Select the table you wish to expo
Click theExport ... button to save a copy of the table in a file. You may export eit
HDF or binary color table files by choosing the type from the save file dialog.

HDF Color Tables

Color tables are stored in HDF files as a separate type of data object, whether o
any other kinds of data are in the file. The files in the color tables examples direc
are HDF files which contain only one color table each.

When Transform saves an image window, a color table also is saved with the fil
Therefore, color tables can be obtained from HDF data files created by Transfo
and other programs. As long as an image has been saved in a Transform save 
Transform can retrieve its color table from the Custom Color Tables dialog.

Binary Color Tables

If the color table file is not an HDF file, Transform assumes it is a binary color ta
file. These files must be unsigned byte, exactly 768 bytes in length. The first 25
bytes represent the red color table entries, the second 256 bytes the green, and t
256 bytes the blue. These numbers are interpreted as 8-bit components for a 25
entry look up table.
Transform Part 3: Reference Manual Custom Color Tables... Command (Windows)
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Load Color Table... Command (Macintosh)

Transform can load new color tables from files on disk. Included with Transform i
folder with several additional example tables to choose from. Use theLoad Color
Table...command from the Color Tables menu to identify the file to open. These fi
may be HDF, KLUTZ, or binary color table files.

HDF Color Tables

Color tables are stored in HDF files as a separate data object, whether or not an
other kinds of data are in the file. The files in the color tables examples folder ar
HDF files which contain only one color table each.

When Transform saves an image, a color table also is saved with the file. There
color tables can be obtained from HDF data files created by Transform and other
grams. As long as an image has been saved in a Transform save file, Transform
retrieve its color table with theLoad Color Table... command. If the file contains
more than one color palette, Transform loads the first palette it encounters.

KLUTZ Color Tables

Transform can load a color table from any color table file with the file type of 'CLU
(the type saved from the desk accessory called KLUTZ). These files contain col
table resources of type 'clut' that Transform can read and apply to the current im

Note that he KLUTZ color tables mentioned here are identical to the PICT color
tables that you can save in the View Utility (described later in this chapter).

Binary Color Tables

If the color table file is neither HDF nor CLUT, Transform assumes it is a binary
color table file. These files must be exactly 768 bytes in length. The first 256 by
represent red color table entries, the second 256 bytes green, and the last 256 
blue. These numbers are interpreted as 8-bit components for 256-entry look up

Macintosh System Color Table

Some programs work best when the image uses the Macintosh default system 
table (provided on disk), but this table does not contain a smooth gradation of c
needed to be useful for most Transform imaging. Other color drawing or presenta
programs use different predefined color tables, so in the sample color table files
vided with Transform we have included some for matching with these programs
Load Color Table... Command (Macintosh) Transform Part 3: Reference Manual
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Color in Images and Plots

Raster images, surface plots and contours all use color in the manner just desc
Raster images are based on the idea of representing values with color; each pix
displayed using the color associated with an array data value.

Color in Surface Plots

Color is optional in surface plots because a perspective view of height is used to
resent data values. The colors can be drawn from the same dataset, reinforcing
surface height with color, or another dataset may be used to show two arrays of
at the same time: one array contributing the values for the surface height and an
array contributing the data values for the color. For more information on the use
color in surface plots, see Chapter 18: Surface Plots.

Color in Contour Plots

Color also is optional for contour plots. The lines can be colored according to th
given data values. For more information on color in contour plots, see the Chapte
Contour Plots.
Transform Part 3: Reference Manual Color in Images and Plots
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Color Bar Window (Macintosh Only)

Because Transform uses color to represent data values from your 2D array, the
matching of colors to numbers becomes very important. The Color Bar window
makes the process of generating a color image from the array of numbers easie
comprehend, and lets you set specific scaling factors to be used in the process.

To create a Color Bar window for the current dataset, selectColor Bar from the
Image menu. Transform first calculates a histogram of the distribution of data in
dataset, then displays it in a new window. When you change the maximum and 
mum settings as discussed below, the histogram is recalculated from the source
and is re-displayed as necessary.

Another way to access the Color Bar window is from theMinMax tool . A button for
it is provided in the bottom margin of an image window when the MinMax tool is
active. A color bar invoked from an image window is no different than one genera
using the menu command. The parts of the Color Bar window are discussed in 
following paragraphs.

Color Bar

The color bar is the central feature of the Color Bar window. This sequence of c
lines represents the smallest numbers in the dataset on the left, continuously in
ing to the largest numbers on the right. The labels below the color bar are autom
cally scaled to the values in the data to display how the numbers in an image are
converted into colors when the image is generated.

Figure 13-4: Color Bar Window
Color Bar Window (Macintosh Only) Transform Part 3: Reference Manual
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Histogram

Above the color bar is a histogram of the distribution of data values in the datas
is scaled to fit the space provided, with the height of each color line representin
relative frequency of occurrence in the data. The histogram is automatically red
when changes are made to the region of interest.

Min/Max Controls

Below the color bar are the controls for the three methods of setting the minimum
maximum values for the region of interest. Changing these settings lets you con
color scaling for image creation and for the histogram display. There is more inf
mation about the manipulation of min/max settings later in this chapter.

Note
If you have a large dataset, you can press Command-period to abort the calcul
of the histogram in the Color Bar dialog. If you do this, not only will the display
histogram be incorrect, but the displayed Min, Max values will be incorrect.

Color Information Dialog

Click Info  to bring up the Color Information dialog shown in Figure 13-5. This dia
log documents the specifics about the histogram in the Color Bar window.

Number of points Number of rows times the number of columns

Number of low outliers Number of data points that fell below the minimum
value selected for the histogram

Number of high outliers Number of data points that were greater than the
maximum value selected for the histogram

Most frequent color # Color in range 1-254 used the most often according
to the scaling calculation used by Transform

Frequency scale Number of points that were mapped to the most fre-
quent color number
Transform Part 3: Reference Manual Color Bar Window (Macintosh Only)
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Color Min/Max

Also in the Color Information dialog are settings for the minimum and maximum
color numbers to use. For most operations, you should use the full capabilities o
your Macintosh's 256 color screen—the range from 1 to 254. This is the maxim
range of scaled values Transform can use because the generation of images us
byte of memory per screen pixel. The usable color range does not include color
color 255.

Note
If the color min/max is set to other than 1/254, then labeled color bars will be d
played with incorrect colors.

To increase compatibility with other programs on the Macintosh or to create spe
images, you can reduce the number of colors you want to use in the images gene
in Transform.

Note
When importing PICT files, the best image is generated when the data min/ma
matches the color min/max. You can set the data min/max of an image using t
Color Bar window. You can set the color min/max using the Color Information D
log. Note that changing the color min/max affects only new images, not curren
images.

Figure 13-5: Color Information Dialog
Color Bar Window (Macintosh Only) Transform Part 3: Reference Manual
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Copy Color Tables to/From Color Bar Window

Color tables can be copied and pasted to and from the color bar window. With a f
most Color Bar window, choose Copy Colors from the Edit menu to copy a color
table to the Clipboard. This table can be pasted into other image and Color Bar 
dows.

Save Color Bar Information

The significant settings from the color bar window (color table used and min/max
tings) are saved when an image window is saved. However, the color bar windo
itself is not stored when the dataset is saved; nor is it automatically recreated w
the dataset is opened.

Note the Color Bar window is not included when windows are tiled.

Min/Max Data Value Settings

This section explains how you use the Color Bar window to set the minimum an
maximum values for your region of interest. Setting min/max values directly contr
how the 254 colors in the color table are to be used to create meaningful image

For most datasets, Transform finds the minimum and maximum values and use
color range 1 to 254 for all images. When an image is created, the resulting line
scaling of values covers all of the values in the dataset. None of the values are co
ered outliers because they all are within the min/max range.

With the data min/max settings, you can spread colors out across your region of
est and not waste any on outliers that are uninteresting or wrong.

Example - Suppress Outliers Display

For example, suppose you have a temperature-monitoring instrument that repor
temperatures from 65 to 72 degrees in your office building during the week. This
week, it failed for an hour and reported 0 degrees for several readings. When T
form finds the minimum and maximum values, it will report 0 and 72 as the limit
values, and scale all of the useful readings at the upper end of the range of color
prevent this, use the Color Bar window to set the minimum value for consideratio
65 degrees. Now the image generation process can assign colors in the image 
appropriately.
Transform Part 3: Reference Manual Color Bar Window (Macintosh Only)
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Mask Outliers

In color images, values that are below the region of interest (low outliers) are
assigned color 1, the bottom color on the scale. Values that are above the maxi
(high outliers) are assigned color 254. The outlier areas of the resulting image wi
represented by just those two colors, yet may represent many different data valu
this causes problems, reset the region of interest to the minimum and maximum
ues of the entire dataset.

Note
If you need to make sure that the color outliers are unique, set the color range in
Color Information dialog to [2, 253] so that no values inside the region of intere
will be assigned the same colors as the outlier values.

User Larger Region of Interest

It is possible, sometimes preferable, to set the minimum and maximum to values
side the range of data in the dataset. Settings these values to exact numbers in
color bar window gives you direct control over the scaling equation. When you
choose a larger range, some colors in the color bar will be unused. The histogra
shows which color numbers become unused in this case.

Min/Max Controls - Direct Setting

Below the color bar in the Color Bar window are the controls for two methods of s
ting the minimum and maximum values for the region of interest.

Figure 13-6: Color Bar Window
Color Bar Window (Macintosh Only) Transform Part 3: Reference Manual
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The first method is a direct setting on the box provided in the center of the wind
The left side of the box represents the smallest value in the actual dataset (com
for you) and the right side is the largest value. Click on either the minimum or th
maximum marker. Hold the mouse button, drag the marker to its new location, a
release. You should be able to see a floating marker as you drag it from side to 
The setting takes effect immediately and the histogram will be redrawn accordin
the new value.

While you are dragging across the screen, any values that fall within the current c
bar are reflected on the color bar with a small indicator. This may help you adjus
your settings and line up your desired values with particular locations on the his
gram.

Min/Max Controls - Second Method

A second method for changing the min/max settings involves the two edit boxes
below the color bar.

Displayed in the left edit box is the current minimum value of interest, and in the
right box is the current maximum value of interest. Click on either box to activate
then enter your desired minimum or maximum value. For these new values to ta
effect, you must press the Set button.

Using the Selection Region

Select the region of interest in the data or image window then use the Color Bar
dow's Set button to set the min/max range to the smallest and largest values in 
selection region.

Note
The first button may be dimmed because you have not yet entered any values
the edit boxes.
Transform Part 3: Reference Manual Color Bar Window (Macintosh Only)
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View Utility (Power Macintosh only)

The View Utility, located in the 'Transform:Extras' folder (see the on-line manual
the 'Manuals' folder), displays images (HDF, PICT) and PICS animations. The V
Utility also contains a color table editor for creating and editing color tables. You c
save them as HDF files and apply them to Transform images using theLoad Color
Table command from the Color Tables menu. You can also save color tables as
binary files, import them into Transform and add them permanently to the Color
Tables menu using the macro language. See Appendix G: Troubleshooting for s
cific instructions.
View Utility (Power Macintosh only) Transform Part 3: Reference Manual
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 In raster images, each data point in the array is assigned a color according to i
value. Then, as in paint-by-numbers, each pixel in the image is filled in, one color
data value. Raster images are the basis of discussion in Chapter 12. Please ref
that chapter for more information.
Transform Part 3: Reference Manual 187
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Types of Raster Images

Transform can create the following types of color raster images: simple, interpola
and polar (Macintosh). Note that line graphs, histograms, surface, contour and ve
plots are described in separate chapters.

Simple Image

Once your dataset is loaded, simple images like Figure 14-1 are created with th
Generate Image command in the Image menu.

When the data array has fewer points than the number of pixels to display, each
point is enlarged to a rectangle of pixels. For example, one data value may beco
square of 3 x 3 pixels, all set to the same color. This creates a chunky or jagged e
in simple images.

You can count one block of color for each data value. When pixels are replicate
Transform takes into account the distances between points on the grid. Most dat
have evenly spaced numerical rows and numerical column labels so there is no
unusual effect; the blocks of color are all the same size. When you use unevenl
spaced scales, the blocks are larger where the scale values indicate the data poi
further apart and smaller where they are closer together.

Figure 14-1: Raster Image using sprngfld_txt
Types of Raster Images Transform Part 3: Reference Manual
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Interpolated Image

TheInterpolated Image command in the Image menu creates from the current
dataset an interpolated image similar to the simple, scaled image. The same pai
number process is used where each data value is mapped to a particular color c
to represent that value. The difference is that if the image is enlarged, bilinear in
polation causes a gradual transition in the colors of the intervening pixels betwee
data points so there is no chunky effect.

The interpolated (smoothing) effect takes into account the distances between p
on the grid when the numerical row labels or numerical column labels are uneve
spaced. Where the scale values indicate the data points are farther apart, more
polated pixels are placed between them. Where they are closer together, fewer
smoothed pixels are used.

Figure 14-2 shows an interpolated raster image generated from ‘sprngfld_txt’, th
same dataset as used in Figure 14-1. Unlike the simple image, in the interpolate
image, the blocks of color for data values are smoothed together.

Figure 14-2: Interpolated Image using sprngfld_txt
Transform Part 3: Reference Manual Types of Raster Images



190 Chapter 14: Raster Images

.
ddi-
olar

ated
values
ith

.

 is
hown
Polar Image (Power Macintosh only)

For creating polar images, use the Polar Image command from the Image menu
These images use the simple, scaled method of generating the image with no a
tional smoothing. To create the polar effect, the pixels are placed according to a p
interpretation of the row and column scaling information. The row scales are tre
as the set of radius values and the column scales are treated as the set of angle
in radians. By default, the angle is measured clockwise from the horizontal axis, w
the origin at the center of the window.

The angle values in a polar image are limited to a range of 2 , one full circle. An
example is shown below.

Select Polar Image Values

The Select tool for rectangular images is described in the image window section
Polar images, however, have a different shape for the selection area.

When you select a region of data values from a data window, an annular region
highlighted in the associated polar image, rather than a Cartesian rectangle, as s
below.

Figure 14-3: Polar Image
Types of Raster Images Transform Part 3: Reference Manual



Chapter 14: Raster Images 191

pter.

nges

val-
fault
tor
olar
e cir-

ars
Polar Image Size

The Resize tool for rectangular images is described in the Image Reference cha
For polar images, the options displayed in the window include aCircle Size...button
instead of aRectangle Size... button. These options correspond to theRectangle
Size... andCircle Size... commands in the Image menu.

Note
Changing the image size interactively using the size tool on Polar images cha
not the image size but the clipping region. Click on theCircle Size... button to
change the size of the image.

Polar data is defined on a circle with angles (columns) from zero to 2 ,and radius
ues (rows) from zero to the maximum radius. When you choose to change the de
size for a polar image that you will be generating, you choose an expansion fac
that determines the final size of the image. In addition to changing the size of a p
image, you also can choose the direction of the zero angle and the portion of th
cle to view.

1. Choose Circle Size... from the Image menu or click on theCircle Size... button
from the size tool for a polar image. The Polar Size Selection dialog box appe
(Figure 14-5).

Figure 14-4: Polar Data Selected
Transform Part 3: Reference Manual Types of Raster Images
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2. If you want to change the direction for the zero angle, select one of the direc
buttons (North, East, South, West). Angles proceed clockwise from the sele
direction.

3. Drag out a rectangle within the picture frame to select a viewing region. Wh
you generate the image, the relative portion of the image inside your viewing
rectangle is visible in the window. The size of the circle in this window represe
the scaled size of the maximum radius value (row label) given in the dataset

4. Specify an expansion factor to be applied to your viewing rectangle, by selec
the up or down arrow labeled ‘Expansion Factor’ or by entering a positive va
in the text box between these arrows. For your reference, the numbers labe
‘Window Width’ and ‘Window Height’ indicate the size of the resulting window

5. SelectOK  or press Return to set the new size. If this was accessed from a m
command, the new size takes effect for the next polar image to be generate
accessed from the Resize tool in a polar image window, the new size takes e
immediately and the image is redrawn.

Figure 14-5: Polar Size Selection Dialog
Types of Raster Images Transform Part 3: Reference Manual
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Transform’s line graphing capabilities plot either a row or column of data from th
dataset versus the scales for the appropriate axis. The values of any row or colum
the dataset can be plotted by selecting the desired row or column.
Transform Part 3: Reference Manual 193
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Create a Line Graph

Choose Line Graph from the Image menu to open a line graph window. A line plo
representing a row of data values from the array is initially drawn in the window;
scales printed on the horizontal axis are from the row or column scale values, an
scales printed on the vertical axis reflect the current minimum and maximum setti

Figure 15-1: Line Graph
Create a Line Graph Transform Part 3: Reference Manual
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Select Tool

When the Select tool is active, the toolbar (Windows) or bottom margin of the ima
window (Macintosh) appears as shown in Figure 15-2. Each of its buttons is
described below.

You can select regions of data values in line graph windows. As you select diffe
rows or columns in the data window or select points on an image, the line is auto
ically replotted to reflect the new selection. However, you can select regions in o
one dimension at a time, horizontally or vertically.

Single Value Selected

If a single data point is selected, the horizontal line graph plots the data values 
left to right along the row that contains the selected data value. On this line, a s
selection rectangle appears on the graph to mark the relative position of the col
that contains the selected point.

If a column plot is requested, the plot is drawn from left to right representing the d
values from the top to the bottom of the column that contains the selected value.
selection rectangle in the line graph window shows the position of the row for th
selected value.

Region Selected

When the selection consists of more than one value and a row plot is requested
top row of the selection region is plotted. When a column plot is requested, the 
column of the selection region is plotted.

Clicking in a line graph window selects a region of data values, just as it does in o
types of windows. You can click and drag a selection across the graph to include
tiple values in the selection region.

Figure 15-2: Line Graph Options (Windows and Macintosh)
Transform Part 3: Reference Manual Select Tool
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Note
For a row plot, the left and right columns of the selection region are specified by
user but the top and bottom settings are fixed. For a column plot, the top and bo
rows of the selection are specified by the user and the sides of the region are 

Show/Hide Selection Region

Show/Hide Selection button (or checkbox at the left of the bottom margin in Pow
Macintosh) turns the visible selection box on and off as it does for all image type

Lock Selection Region

Locked button/checkbox keeps the window from updating when you do not wan
replotted. Normally, a line graph window is updated and replotted every time a n
selection is made in the dataset.

To compare more than one row plot or column plot on the same screen, create the
line graph and lock it. Then create the second line graph and pick a new row in 
dataset to change the line graph to the new profile. Figure 15-3 shows a compa
of two rows from the same dataset.

Figure 15-3: Comparison of Two Rows
Select Tool Transform Part 3: Reference Manual
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Column and Row Plots

To plot a column of values (a column plot), click on theVertical button in the toolbar.
Click on theHorizontal  button to plot a row of values (a row plot). Figure 15-4
shows two line graph windows from the same dataset. One plots the values from
row of data and the other plots the values from a column of the same dataset.

Line Graph Animation

You can move the selection region within the dataset using the arrow keys on the
board. Line graphs continuously update and replot the data values along the lef
top) edge of the selection region. Therefore, every time you press an arrow key
plot changes one step. Repeated key presses create an animation effect of a m
line traveling through the array.

Figure 15-4: Row and Column Line Graphs
Transform Part 3: Reference Manual Select Tool
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Resize Tool

Line graphs can be easily sized with the Resize tool. Simply grab one of the corn
depress the left mouse button, and drag the image. In the toolbar, you can resiz
line graph by typing new values in the Image Size text fields. Because the vertic
scale is associated with the data range, unlike any of the other plot types, draggin
image may be more useful than theImage Size.../Rectangle Size... command, which
relates the size of the image to the scales in the dataset.
Resize Tool Transform Part 3: Reference Manual
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Many kinds of data are best displayed with a contour plot. The most familiar kin
contour plot is a topographical, such as those sold by the U.S. Geological Survey
rate of change of elevation is represented by the spacing between contour lines
closer together the lines are, the more elevation is changing.

Transform draws a contour line marking the path you would travel through the
dataset if you wanted to stay at the same data value. A set of these contour line
makes up a contour plot. This section explains how to control which data values
contoured, how to smooth the lines, and how to use color, dashed lines, and lab
define the information.

The dataset can be considered a grid of data points connected by grid lines. Tra
form uses an interpolation algorithm to determine the points where the contour 
passes between the data values and, hence, where it crosses the grid line. Con
lines will always complete a closed curve, unless the curve runs off the edge of 
data grid. Although they can bump into each other, they cannot cross.
Transform Part 3: Reference Manual 199
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Create a Contour Plot

To create a contour plot from the current dataset, selectContour Plot... from the
Image menu. In Windows, the contour plot will be generated in an image window
shown below. In Power Macintosh, the Contours dialog will first appear (describ
later in this chapter).

MinMax Tool

The value range displayed by the MinMax tool controls which contour lines are
drawn in the final plot. All contour lines that are specified in the dialog are follow
without regard to the MinMax settings, but only those within the range are drawn.
update the plot, change the values in the image Min and Max boxes in the toolbar
press Enter orReplot.

Figure 16-1: Contour Plot
Create a Contour Plot Transform Part 3: Reference Manual
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Resize Tool

The size of the contour plot can be changed without requiring the lines to be follow
again. Change the size of the plot with the mouse or with Image Size.... Each time
the lines are redrawn, they are drawn in the highest resolution at the full size of 
plot.

Label Tool

Labels are interactively added to the contour lines by activating the Label tool th
clicking the mouse on any contour you want labeled.

As shown in Figure 16-3, a text label appears at the nearest point on the contou
remove a label, simply click on it again. Each contour label shows the data valu
associated with a particular contour line. To select a different number display fo
for the labels, select a new format label from the Format pop-up menu. Once cho
press Enter.

You can also change the font, style, and size of labels by clicking theFont but-
ton/pop-up menu to open the Font dialog.

Figure 16-2: Contour Label Options (Windows and Macintosh)
Transform Part 3: Reference Manual Create a Contour Plot
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Contour Tool (Windows)

For contour plots only, the tool palette includes the Contour tool, which provides
most of the control over how contours are displayed. With the Contour tool, you
add contour levels interactively and directly on the contour window. Move the ar
cursor to point to the position where you wish to draw a contour. Now click the
mouse button. As soon as the new contour has been followed through the datase
drawn according to the active drawing options. Although contours can be added
interactively, they can only be deleted in the Contour Levels dialog. Figure 16-4
shows the Windows toolbar when the Contour tool is active.

Dashed Lines

When you turn on theDashed Linesbutton, contour lines for data values greater tha
or equal to the split value are solid, and lines for values less than the split value
drawn as dashed lines. The default for the split value is 0, but you can change it in
edit box provided.

Figure 16-3: Contour Plot with Labels

Figure 16-4: Contour Tool Toolbar
Create a Contour Plot Transform Part 3: Reference Manual



Chapter 16: Contour Plots 203

h
-5
ers.

or
ach
alue

are
sim-
ross

the
Smoothed Lines

Turning on theSmoothed Linesbutton enables a Bezier smoothing algorithm whic
adds more line segments that smooth out the sharp angles in the plot. Figure 16
shows how smoothed lines add more points to the line drawing to eliminate corn

Color Lines

TheColor Lines button allows you to choose whether the lines are drawn in black
according to the currently selected color table. If you select color, the colors for e
line are chosen in the same way as for raster images. A contour line drawn at a v
of 25 is the same color as a data value of 25.

Contour Levels

Click the last button in the Windows toolbar to invoke the Contour Levels dialog.

The main text box lists a contour specification like -20:10@10, which means lines
drawn from -20 to 10 in increments of 10. To change or add to the specifications,
ply click in the text box and type other values or ranges separated by commas. Ac
the bottom of the dialog is a line display of the specifications. Along the right of 
dialog box are four buttons:OK, Cancel, Automatic..., andUpdate.

Figure 16-5: Lines Without Smoothing and With Smoothing

Figure 16-6: Contour Dialog
Transform Part 3: Reference Manual Create a Contour Plot
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TheAutomatic... button invokes a dialog where you can set the number of conto
levels you want displayed. Changing the automatic number of contour levels de
all the current contour levels specified in the dialog and finds evenly spaced con
levels according to the number of levels entered.

Clicking theUpdate button tells Transform to read all of the levels specified in the
text box and display them on the line display below.

When you are finished with the dialog, clickOK  to use the new list; clickCancel to
leave the levels where they were when you started. If you picked new levels, Tra
form proceeds to find all the levels in the text list and to follow the contour levels
the dataset. After the lines are found, they are drawn in the contour window.

Contour Tool (Power Macintosh)

With the Contour tool, you can add contour levels interactively and directly on th
contour window. Move the arrow cursor to point to the position where you wish t
draw a contour. Now click the mouse button. As soon as the new contour has b
followed through the dataset, it is drawn according to the active drawing options
Although contours can be added interactively, they can only be deleted in the Con
Levels dialog. Figure 16-8 shows the bottom margin of the image window when
Contour tool is active.

The Contour tool on Power Macintosh provides access to the Contours dialog w
provides the same options described above for the Windows Contour tool.

Figure 16-7: Automatic Levels Dialog

Figure 16-8: Contour Tool Options (Macintosh)
Create a Contour Plot Transform Part 3: Reference Manual
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Click theContours... button in the bottom margin of the image window (or select
Contours... from the Image menu) to open the Contours dialog shown below.

Note
Adding more than 25 contour lines interactively will cause Transform to quit. Y
may add as many lines as you wish using the Contour Levels dialog.

Line Display

The line display rectangle contains vertical lines representing the currently chos
contour levels. To add a level with the mouse, click in the line display at the poin
where you wish to add the contour. If you hold the mouse down, you can drag the
until it reaches the desired location. As you drag the line, the level that you are 
rently pointing to will appear under the line display.

When you release the mouse button, the line becomes fixed and the contour lev
added to the list in the main text box. The data value is rounded according to the
format in the data window. For instance, if the main display format is F6.2 and y
click on data value 39.4325, then the value is truncated to 39.43; this value is use
specify the contour.

Figure 16-9: Contours Dialog
Transform Part 3: Reference Manual Create a Contour Plot
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Min and Max for Contours

The Min and Max boxes contain the minimum and maximum data values in the
active range of the dataset. These are the same numbers found in the MinMax 
and the Color Bar window. If a contour level is outside this range but still specified
the contour list, it will be followed but not drawn when the lines are drawn on the
plot.

Show Lines

To see where the currently specified contour levels are, selectShow Lines to update
the line display rectangle. A vertical line appears in the line display rectangle for
every contour line specified in the main text box. The left side of the line display r
angle represents the minimum active data value, the right side represents the m
mum active data value, and the lines are drawn on a linear scale in between. If 
contour line falls outside of this range, it is not displayed.

Main Text Box

The main text box contains the full specification of which contour levels are to b
drawn. Each level is listed by its data value. You can also specify ranges, with li
drawn at specified intervals. For example, an entry of -20:10@10 means lines a
drawn from -20 to 10 in increments of 10. To add or delete contours, edit the tex
this text box.

Add single contours by adding that level to the list. Specify as many decimal digit
you need (about 8 digits of accuracy). Each level must be separated by a comma
space. Ranges of lines that are evenly spaced can be entered in the format A: B @ C
where A is the beginning of the range, B is the end of the range, and C is the spa
To see the new lines in the line display, click on theShow Lines button. There is a
256 character limit on the length of the string in the text rectangle.

Set Auto Levels

TheSet Auto Levels button removes all the current contour levels and finds even
spaced contour levels according to the number entered in the Number of Autom
Levels box. Enter a new value of automatically spaced levels in the box and click
Auto Levels. The new levels are added to the main text box and also drawn in the
display rectangle as if Show Lines were clicked. All former lines and text are dele
Create a Contour Plot Transform Part 3: Reference Manual
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High Resolution

High Resolutionmeans that the contouring of the data grid is made more precise
interpolating a new point in the middle of each cell in the grid before the contour
followed through the new, finer grid. Turn this checkbox on to effectively double 
data resolution. Contours are recalculated to make the high resolution take effe

Smoothed Lines

Turning on theSmoothed Lines checkbox enables a Bezier smoothing algorithm
which adds more line segments that smooth out the sharp angles in the plot. Fig
16-10 shows how smoothed lines add more points to the line to eliminate corne

Dashed Lines

When you turn on theDashed Linescheckbox, some of the contour lines are draw
as solid lines and some are drawn as dashed lines. Lines for data values greate
or equal to the split value are solid, and lines for values less than the split value
drawn as dashed lines. The default for the split value is zero, but you can change
the edit box provided.

Color Lines

TheColor Lines checkbox allows you to choose whether the lines are drawn in bla
or according to the currently selected color table. If you select color, the colors f
each line are chosen in the same way as for raster images. A contour line draw
value of 25 is the same color as a data value of 25.

OK

When clicked, Transform finds all the levels in the text list and follows the conto
levels in the dataset. After the lines are found, they are drawn in the contour wind
If you wish to stop the process, press command-period.

Figure 16-10: Lines Without Smoothing and With Smoothing
Transform Part 3: Reference Manual Create a Contour Plot
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Copying Contour Plots

ChooseCopy from the Edit menu to copy the contour plot andPaste/Paste Overlay
to overlay it onto another image. In Power Macintosh, if you copy a contour plot w
the Option key selected, your overlay will have white lines instead of black. It is 
ommended that you turn off axes before you copy a contour window.

Note
Each data value in a raster image generates a rectangle of color centered on th
value; therefore, a raster image extends slightly above, below, to the left and to
right of the location of the bordering data values. Contours, in contrast, are dra
only to the data values, not beyond them. Therefore, when overlaying a contou
top of a raster, there may be a small gap between the edges of the contours a
border of the raster image.
Copying Contour Plots Transform Part 3: Reference Manual
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Vector plots are often used for flow diagrams, to show the speed and direction o
flow. A wind speed diagram, for example, can show the relative strength of the w
and which direction it points.

The arrow at the bottom of the vector image is a scale arrow that is equal to the ve
maximum. You cannot change it or remove it from the vector plot.

Two arrays of data are required to create a vector plot because the relationship
between two orthogonal data arrays is used to determine which direction each a
points. This chapter provides details on how Transform creates and uses vector
Transform Part 3: Reference Manual 209



210 Chapter 17: Vector Plots

eates
tated
g the
nting
rrow

ull
ach
are.

used

cale
lt ori-

ual
Drawing Vector Plots

A vector plot takes two conforming arrays of data (same size and shape) and cr
an image filled with rows of arrows, evenly spaced. The arrows are sized and ro
according to the data values. One value is taken from the first array representin
horizontal component, and another value is taken from the second array represe
the vertical component. From these components, the size and direction of the a
are determined and the arrow is drawn.

Figure 17-1 shows how an arrow’s size is determined before being drawn. The f
area of the image is divided into equal-sized squares and an arrow is drawn in e
square as shown. The center of the arrow always matches the center of the squ
The length of the arrow is scaled proportionally to the magnitude of the vector
formed from the horizontal and vertical components. The components also are 
to form the tangent of the rotation angle for the arrow.

Determine Origin

Transform assigns the positive direction for the arrows according to whether the s
labels ascend in value or descend in value. Figure 17-2, Part A shows the defau
entation of the axes and the positive direction for the components of the vector
arrows. The arrow shown has positive horizontal and vertical components of eq

Figure 17-1: Arrow Components
Drawing Vector Plots Transform Part 3: Reference Manual
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magnitude. Part B shows that if the row scales are descending values, a positive a
points up instead of down. Part C shows the arrow pointing up and to the left wh
both scales have descending values.

Create a Vector Plot

Creating a vector plot starts with theVector Plot command from the Image menu. A
standard image window appears with a vector plot created from the current datas
this plot, all the arrows point at the same 45-degree angle because when vector
are created, the same dataset is used for both the horizontal and vertical compo
of the arrows; therefore the tangent is always 45 degrees.

Choosing Components

When creating a vector plot, at least two datasets with the same dimensions mu
open. One dataset is used for the Horizontal component (marked ‘H’ in Power M
intosh) and the other is used for the Vertical (‘V’).

The Windows toolbar and Macintosh image window have two primary compone
buttons/checkbox, one for horizontal and one for vertical. They set the compone
direction for the active dataset. The other component should be chosen from on
the pull-down menus. To choose a dataset, select the new component from the a

Figure 17-2: Arrow Direction Depends on Axes

Figure 17-3: Vector Select Toolbar
Transform Part 3: Reference Manual Drawing Vector Plots
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priate menu. The menu list only shows the names of open datasets with dimens
identical to the current dataset. As soon as you choose the new component, Tra
form redraws the vector plot with the new data.

MinMax Tool

When you are working with vectors, the MinMax tool applies to the vector magn
tude, not the value of one of the vector components. For each new vector plot o
change of component datasets, the minimum and maximum values are calculat
surveying the magnitudes of the vectors. To eliminate vectors that are too big or
small, change the maximum or the minimum value. Any vectors with a magnitud
outside the min/max range will not be drawn.

TheResetbutton in the MinMax tool surveys the chosen components, calculating
smallest and largest magnitudes. These results are placed into the minimum and
imum boxes and are used to redraw the plot.

Figure 17-4: Vector Plot

Figure 17-5: Vector MinMax toolbar
Drawing Vector Plots Transform Part 3: Reference Manual
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Resize Tool

The number of arrows stays constant as the image size changes, so the size of
arrows stays proportional to the size of the image.

Vector Tool

Choose the Vector tool from the tool palette to bring up the vector-specific control
the toolbar. Shown in Figure 17-6, the Vector toolbar contains text boxes for chang
the number of arrows to plot in the image, a scaling factor for the arrows, and but
(Windows) to select from six arrow types. Power Macintosh also contains aReplot
button to make those values take effect, and theArrow Type... button to open the
Arrow Type dialog (described below).

# Across

To change the density of arrows plotted (more or fewer), enter a new value for t
number of arrows to space evenly across the plot and hit Enter. Each arrow field
square, so the number of arrows from top to bottom is determined from the asp
ratio of the image. In Power Macintosh, click theReplot button to draw the new
graph.

The arrow density need not match the data resolution exactly. The arrows are d
according to the closest data point to the center of the arrow. If there are fewer ar
than data points, some data points are skipped; if there are more arrows than d
points the data points are used more than once. The row and column scales are
mapped to the image in the same manner as for raster images.

Scale

Enter a new scale factor to change the multiplier for the size of the arrow, where 1
a full-size arrow of full magnitude. Values greater than 1.0 can create overlappin
arrows; values under 1.0 produce arrows that can never overlap or touch each o
Enter a smaller number to reduce the size of the arrows, or a larger number to m

Figure 17-6: Vector Toolbar
Transform Part 3: Reference Manual Drawing Vector Plots
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the arrows larger, even making them overlap. In Windows hit Enter to redraw the
arrows or in Power Macintosh, click theReplot button to make the new value take
effect.

Arrow Type

The appearance of each arrow is controllable with the arrow type buttons in the
dows tool bar or via the Power Macintosh Arrow Type dialog (available by clickin
theArrow Type... button. Each button represents a different kind of arrow display
Two sizes, a large arrow and a small arrow, are shown to indicate how the partic
arrow is scaled according to magnitude. Some have the same size arrowhead ind
dent of the scaled length of the arrow, while others have a scaled arrowhead tha
shrinks as the length of the arrow gets smaller. One type is only an arrow tail wi
dot instead of an arrowhead. Pick any of the six arrow types by clicking the butt
which displays that arrow. In Power Macintosh, click theOK  button to replot the
image with the new arrows.

Figure 17-7: Arrow Types (Windows and Power Macintosh)
Drawing Vector Plots Transform Part 3: Reference Manual
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Surface plots, sometimes referred to as three-dimensional plots because of the
three-dimensional perspective appearance, are available in Transform as anothe
to view two-dimensional arrays of numbers. Two-dimensional data is represente
a three-dimensional flexible surface. The height of each point on the surface is 
mined from the data values in the array. Arbitrary orientation and size are suppo
The surface can be filled with color or drawn as a wireframe, with or without hid
lines removed.
Transform Part 3: Reference Manual 215
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Create a Surface Plot

To create a surface plot, selectSurface Plot from the Image menu. Initially, Trans-
form draws a surface as a wireframe plot of approximately 10 lines per axis. The t
‘wireframe’ here means that all lines are visible, including ones that would be hid
by other parts of the surface if the surface were opaque.

Select Tool

When a surface plot is active, the Select tool lets you change the surface plot or
tion, choose from six types of surfaces, and specify plot parameters.

Surface Plot Orientation

Using the mouse, you can interactively change the orientation of the surface plo
ative to you. When you depress the mouse button, the surface plot image is tem
rarily replaced by a wireframe box of equal size. To produce a new orientation, 
the mouse across the screen with the mouse button depressed. As you move th
mouse, the wireframe box moves and the axes angles are displayed in the toolb
After you release the mouse button, the new surface plot is drawn in the same or
tion as the wireframe box.

In Power Macintosh, when orienting a surface plot, you can move the surface p
within the image area. To do this, hold down the Command key and click and dr
the mouse to leave the plot in the new position.

Virtual Trackball

To get an idea of how the plot is rotated, imagine the three-dimensional surface
encased in a large sphere, just large enough to hold the whole wireframe box. Y
click the mouse pointer on this sphere as you would touch a trackball and drag 
point to a new rotation. This method of mouse-based rotation is known as a ‘virt

Figure 18-1: Toolbar for Select Tool
Create a Surface Plot Transform Part 3: Reference Manual
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trackball’. If you drag from the bottom to the top, the plot rotates away from you
you drag from left to right, the plot rotates counterclockwise in a horizontal plane.
spin the plot around an axes pointing out of the screen, drag the mouse around
perimeter of the virtual trackball.

Move Anchor

Sometimes you run out of room to complete a rotation with one mouse moveme
Press and hold the Shift (Option on Macintosh) key to move the mouse pointer 
new anchor point. Release the Shift/Option key and continue rotating the plot.

Exact Values for Rotation Angles

You may also type exact values for the X, Y, and Z axes angles in the three text fi
on the Windows toolbar or in the Power Macintosh Surface Plot Angles dialog (av
able by clicking theSurface... button in selection mode, then clicking theEdit
Angles button).

The numbers shown in the text fields are the same as the angles of rotation for 
surface plot coordinate system. To replot the image and return to the image win
type in your desired angles for the new orientation and press Enter on your keyb
(Windows) orOK  in the Surface Plot Angles dialog (Power Macintosh).

Location of the Origin

The location of the origin depends on whether these values are positive or nega
When both independent axis scales are ascending, a right-handed dataset coor
system is drawn, with the origin placed at the top left corner of the matrix. When b
axis scales are descending, the origin is drawn at the bottom right corner, result
again in a right-handed system.

If one or both of the scale values are descending, the origin of the coordinate sy
is drawn at a different corner. In the case of descending row axis values but ascen
column axis values, the origin is drawn at the bottom left corner. This results in a
handed system. If the column axis scale values are descending but row axis sca
ues are ascending, the origin is drawn at the top right corner, also resulting in a
handed system.
Transform Part 3: Reference Manual Create a Surface Plot
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Surface Parameters

As well as letting you change the surface plot orientation and choose from a var
of surfaces, the Select tool allows you to specify plot parameters. Clicking theSur-
face... button invokes the Surface Parameters dialog, where you specify grid, pa
lax, and color variables.

Data Size (Power Macintosh)

To change the plot axis lengths, either select the up or down arrows or enter valu
the text edit boxes. These values are specified in pixels, but the process of 3D t
formation usually makes the axis lengths in the resulting 2D image come out sm
than the given size. The number of rows and columns in the source dataset are
under the header 'Data Size'. For the plot size, the number next to 'Height' is the

Figure 18-2: Surface Parameters Dialog (Windows and Power Macintosh)
Create a Surface Plot Transform Part 3: Reference Manual
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axis, the scaled height of the surface (in pixels) from its lowest point to its highe
point. The 'Zoom' factors represent the ratios of the plot axis sizes to the dataset
ber of rows, number of columns, and default height, respectively.

Grid Lines

You can draw both row and column grid lines, or you can deselect one or the ot
(but not both) to draw lines in only one direction on the surface.

Note
The density of a surface plot is controlled by the number of lines chosen for BO
rows and columns, even if you have chosen to display only row or column line

The values for Spacing and Count (Windows) or Lines Every and # Of (Power M
intosh) are relative to Size, by default. For example, if Size is 60 and Spacing/Li
Every is 4, Count/# Of will be 15. This defines the total number of lines to be draw
You can specify how many lines to skip by changing the ratio between Spacing/L
Every and Count/# Of. The number of lines to be drawn can never be greater tha
total number of rows or columns in the dataset.

Parallax

The parallax factor lets you control the virtual distance from your eye to the data
face. The default value is 5.0, which represents a large distance away from the 
face. The smaller the number, the closer you are, and the more distorted your vie
the surface.

Average Colors

When you check the Average Colors box, each color-filled polygon is defined by
average of the surrounding four data points. When it is not checked, the color fo
each is set from one corner of the polygon.

Color Variable

When your request a color surface, you can use the data values of an alternate d
to supply the color information. Choose another dataset from the Color Variable
Only eligible (equal-size) datasets are selectable from this menu. This feature p
vides a means to correlate data values from two different datasets into one graph
dataset provides the shape of the surface; the other is a color image which is, in
effect, draped over the surface.
Transform Part 3: Reference Manual Create a Surface Plot
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Surface Types

With the Select tool active, Transform allows you to create six different surface p
types by clicking on the buttons in the toolbar. The types of plots that you can cr
are, from left to right, Wireframe, Black & White, Hi-res Black & White, Color Su
face, Framed Color Surface, and Hi-res Color Surface. When you choose a type
surface is redrawn in the new type without changing any other display paramete
Some types (e.g., the Hi-res Color Surface plot) take much longer to draw than o
types.

All plot types, except Color Surface plot, contain black lines along the rows and
umns. In the Surface Parameters dialog (discussed below), you can specify wh
you want row lines, column lines, or both.

Wireframe

A wireframe surface drawn in perspective with black lines and no removal of hidd
lines (Figure 18-3) is what you see when you initially generate a surface plot. Th
the default type for all new surfaces because it is the fastest to draw. Data value
skipped if you draw fewer lines than there are data points.

Figure 18-3: Wireframe Surface Plot
Create a Surface Plot Transform Part 3: Reference Manual
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Black & White Surface Plot

Figure 18-4 shows a black and white surface plot (B&W Surface) similar to the w
frame plot but filled in with white, resulting in the removal of hidden lines. Skippe
data values between the lines are ignored.

Hi-res Black & White Surface Plot

Figure 18-5 shows a high-resolution, black and white surface plot (Hi-Res B&W S
face). The same number of black lines are drawn as in the black and white surfa
plot. Between the lines, however, every data point is positioned and drawn as a w
rectangle.

Figure 18-4: Black & White Surface Plot

Figure 18-5: Hi-res Black & White Surface Plot
Transform Part 3: Reference Manual Create a Surface Plot
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The lines appear to curve because they are drawn in several segments at a fine
lution. For some plots, the data between the lines may obscure portions of those
Using the Color Surface Plot or increasing the number of lines can help reduce 
confusion this may cause.

When lines are requested along every row and column, no skipped data points 
between the black lines. In such a case, the Hi-res Black & White and Black & Wh
Surface plots are identical.

Color Surface Plot

Figure 18-6 shows a color surface plot. Each rectangle patch has a color calcul
from the average of the four corner values of the patch. When the image is drawn
appropriate color from the current color table is used to fill each patch. Additiona
the color of each patch is taken from the same dataset that determines the shape
surface. These defaults can be overridden with a different parameter setting. Co
information can be taken from an alternate dataset.

Figure 18-6: Color Surface Plot
Create a Surface Plot Transform Part 3: Reference Manual
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Framed Color Surface Plot

Figure 18-7 shows a framed color surface plot. This is similar to the color surfac
plot, but each rectangle of the surface is framed with lines. The lines help define
shape of the surface, while the color can be used to display data values from a 
ent dataset or used to reinforce the surface shape.

Hi-res (Framed) Color Surface Plot

Figure 18-8 shows a high-resolution, framed, color surface plot, which takes a r
tively long time to render. Like the high-resolution black and white surface plot, t
plot has black lines. Black lines are drawn along only the lines requested, and th
appear curved because they are drawn using every data point along the line. W
lines are requested along every row and column, no skipped data points fall bet
the black lines. In such a case, the Hi-res Color Plot is identical to the Framed C
Surface Plot.

Figure 18-7: Framed Color Surface Plot
Transform Part 3: Reference Manual Create a Surface Plot
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The rows and columns of data that do not fall on the black lines are represented
color. Inside each black frame, Transform draws a high-resolution color map of 
els with every data value represented. Each patch of color represents the avera
the four adjacent data values (by default). Sometimes a central patch of color m
obscure a segment from the framing lines.

MinMax Tool

In surface plots, the minimum and maximum data values are mapped to the low
and highest points on the surface. Limiting the range of values is a common too
analysis of surface plots. The effect is to ‘chop off’ the mountains and valleys so
detail in the middle range can be displayed.

Resize Tool

The Windows surface Resize tool allows you to translate (or move) the image wi
the plot window and to size images. To translate the image, simply click on theMove
Surfaceradio button in the toolbar, then with the cursor back over the surface pl
depress the left mouse button, and move the image.

Figure 18-8: Hi-res Color Surface Plot

Figure 18-9: Surface Resize Toolbar
Create a Surface Plot Transform Part 3: Reference Manual



Chapter 18: Surface Plots 225

 X,
g dia-

con-

 val-

tune

hin
ing
ca-

ith
rges
larges
In Windows, you can also resize your active plot directly by typing values for the
Y, and Z coordinates into the rectangles in the toolbar or use the Surface Scalin
log described below.

In Power Macintosh, the initial plot rectangle is the same as for the other plots, 
trolled by theRectangle Size... command, but to make it fit within the window, the
size of the surface starts out smaller than the window.

Surface Scaling (Windows only)

Another option for sizing a surface plot is to click on theSurface Scaling button to
bring up the Surface Scaling dialog. You can enter either zoom values or actual
ues (in pixels) for Rows, Columns, and Heights in this dialog.

Fit to Window (Windows only)

Fit to Window  makes Transform size the surface plot to fit reasonably within the
image window. Transform calculates an average fit, so you may still need to fine
the size afterward.

Move Surface (Windows only)

TheMove Surfacebutton lets you move the surface plot around on the canvas wit
the image window. When Move Surface is active, you can move the plot by click
on the it, holding the mouse button down, and dragging the plot to the desired lo
tion.

Interactive Sizing (Windows only)

To interactively scale the plot in all three coordinates, click on theResize Surface
button in the toolbar and click on the plot. When you click, the plot is replaced w
the outline box until you release the mouse. Moving the mouse up and down enla
and reduces the Z (data) axes. Moving the mouse right and left reduces and en

Figure 18-10: Surface Scaling Dialog
Transform Part 3: Reference Manual Create a Surface Plot
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the plot along the X and Y axes, respectively. As you resize the image, the curre
plot size is continuously updated in the toolbar. To scale the plot in only the X an
axes, depress the Control (CTRL) key and maneuver the mouse as before.

Axis Tool

Clicking on the Axis button in Windows brings up the array of toolbar buttons tha
you’ve seen with other images. From left to right, the buttons activate the axes la
dialog for rows, columns, and data; the color bar; the color bar axes label dialog
image title dialog; and the surface decorations dialog. The last five radio buttons
specify the plot’s axes origin. In Power Macintosh, the Axis tool provides interact
sizing and access to labeling. In the bottom margin of the image window, the left s
of the margin displays the current plot size in pixel unit. These are the same axis
values found in the Surface Plot Parameters dialog, but the Surface Size tools a
you to interactively resize with the mouse.

Row, Column, Data Axes, and Color bar Labels

In Windows, these four buttons invoke an Axes label dialog, in which you specif
axes name, plot range, axes labels range, increments and intervals, tick mark se
auto range calculation, and label format.

Figure 18-11: Surface Axes Toolbar
Create a Surface Plot Transform Part 3: Reference Manual
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In Power Macintosh, clicking theLabels... button opens the Surface Labels dialog,
which lets you control axis drawing, labels, backstops, skirts and tickmarks.

Enable Color Bar

In Windows, click this button to turn the color bar display on and off for a surface
plot.

In Power Macintosh, this same option is available by selecting or deselecting th
Color Bar checkbox in the Surface Plot Labels dialog.

Surface Skirt, Backstop and Grid Lines

In Windows, clicking theSurface Decorations button invokes a dialog with three
checkboxes: skirt, backstop, and gridlines. If the box that corresponds with these
tures is checked, the feature is enabled. Click in the box to change the current se
You can also type a color index for skirt and backstop.

Figure 18-12: Surface Plot Labels

Figure 18-13: Surface Decorations Dialog
Transform Part 3: Reference Manual Create a Surface Plot
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In Power Macintosh, these same features are available in the Surface Plot Labe
log.

Skirt —The skirt is the base of the flexible surface; drawing one will obscure any
view you may have had of the bottom of the surface. Skirts can be drawn in colo
The color index box is active only when the skirt is enabled, allowing you to type i
color number to be used. This color number is on the same scale as the one prod
by the color scaling equation used for raster images. Enter a number from 1 - 25
a color, 0 for white, 255 for black, or 256 for gray.

Backstop—The backstop is made up of the two rear walls of the imaginary cube
enclosing the surface plot. The backstop enhances the three-dimensional effect
plot. Backstops can be drawn in color. The color index box is active only when t
backstop is enabled, allowing you to type in a color number to be used for draw
This color number is on the same scale as the one produced by the color scaling
tion used for raster images. Enter a number from 1 - 254 for a color, 0 for white, 2
for black, or 256 for gray.

Gridlines—The backstop can also include horizontal gridlines at the major tick in
vals. To turn on gridlines, click in its checkbox. You may have to enable Backsto
first.

Figure 18-14: Finished Surface Plot with Skirt and Gridlines
Create a Surface Plot Transform Part 3: Reference Manual
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Axes Types

The axes type controls the general appearance of the surface plot’s axes. In Wind
the last five buttons let you specify from what perspective you wish to view the p
In Power Macintosh, these same options are available from the Axis Type pop-u
menu in the Surface Plot Labels dialog.

The available types are surface only (no axes), axes in origin (axes drawn to the
gin point), left data axes (data axes drawn to the left of the plot), right data axes (
axes drawn to the right of the plot), and double axes (a combination of left and rig

Interactive Sizing (Power Macintosh Only)

Click the mouse anywhere within the window and drag to resize the plot. When 
click, the plot is replaced with the outline box until you release the mouse. Movi
the mouse up and down enlarges and reduces the Z (data) axis. Moving the mo
right and left reduces and enlarges, respectively, the plot along the X and Y axe
simultaneously. The current plot size is continuously updated at the bottom of th
window as you resize the plot.

Note
Interactively increasing the surface plot using the Axes tool does not automatic
increase the image area. You may also need to increase the size of the image
using the Resize tool.

Figure 18-15: Axes Type Buttons (Windows Toolbar) and
Macintosh Axis Type Pop-up Menu in the Surface Plot Labels Dialog
Transform Part 3: Reference Manual Create a Surface Plot
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Adjust the X and Y Axes Independently (Power Macintosh Only)

Normally, the X and Y axes are kept at the same aspect ratio. To adjust the X a
axes independently, hold the option key down. In this mode, the Z axis size is fr
and the mouse movement controls the X and Y axis sizes separately. Up-and-d
movements of the mouse control the Y axis; left-to-right control movements con
the X axis.

Font and Size Pop-up Menus (Power Macintosh Only)

Two pop-up menus at the right side of the window’s bottom margin control the fo
and size of the labels and numbers to be printed in the window. To change the p
annotations, select a new font from the font menu or a new size from the size m

Fit to Window Button (Power Macintosh Only)

Fit To Window makes Transform pick a reasonable size for the surface plot so it
within that window. Transform calculates an average fit which does not always ma
the current plot, so you may want to fine-tune the size after usingFit To Window.
Create a Surface Plot Transform Part 3: Reference Manual
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Histogram plots in Transform for Windows provide a graphical view of the distrib
tion of the values in a dataset. The values are presented in the form of a vertica
graph with one bar for each entry in the color table. The plot is drawn by calcula
how many data values are mapped into each color table entry and setting the heig
the vertical bars accordingly. In this chapter you will see how to use histogram p
both as an informative analysis plot and to facilitate control over the color scaling
a dataset.
Transform Part 3: Reference Manual 231
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Create a Histogram

With the dataset window active, select theHistogram command from the Image
menu.

The vertical axis of a histogram plot shows the count of how many data points a
present in the dataset which map to each color. The horizontal axis covers the d
range from the minimum data value to the maximum data value. Any points whi
fall outside of the current data range, called outliers, are omitted from the plot.

A histogram displays the same information you see in a color raster image of th
same data, arranged differently. The same number of data points appear in the 
colors in both types of plots. The raster image shows the data arranged in its orig
two-dimensional form while the histogram displays the points sorted in order by d
value.

The histogram may be drawn in color, with each vertical bar drawn in the corresp
ing color from the current color table. Without color, each bar is drawn in black.

Figure 19-1: Histogram plot
Create a Histogram Transform Part 3: Reference Manual
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Select Tool

The Select tool allows you to interactively explore the histogram information. Cli
on one of the vertical bars and observe the numbers at the left side of the toolbar
Value box shows an approximate data value (position on the horizontal axis) for
bar. The count box presents the number of data values which were mapped into
color cell (vertical axis).

Draw Color Histogram

TheDraw Color Histogram button on the Select toolbar controls the coloring of th
vertical bars. If this setting is on, bars are drawn in color. If it is off, the bars are 
black.

MinMax Tool

A histogram plot may be used to display and modify the data range, using the M
Max tool. When a suitable range is found, it can be propagated to all of the othe
image windows.

As with the MinMax tool for any other plot, you may directly edit the data range m
imum and maximum using the text fields in the toolbar. You may also change the
range by clicking and dragging the black triangles at the bottom of the plot. As y
drag the triangle, the data range values in the toolbar are updated. When you re
the mouse, the data range is changed and the histogram is replotted.

To help you analyze the current data range, the number of low and high outliers in
dataset are shown in the toolbar.

Figure 19-2: Histogram Select Toolbar

Figure 19-3: Histogram MinMax Toolbar
Transform Part 3: Reference Manual Create a Histogram
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Reset Data MinMax

This button resets the data range for the histogram window to the absolute mini
and maximum of all data values in the array. After clicking this button, there will 
no outliers.

Edit Outlier Colors

Outliers "fall off the edges" of a histogram plot. Using the Outlier Colors dialog do
not change the appearance of the histogram. Since the histogram window is co
monly used to set the data range for other image windows, you may still find this
ture useful. After setting the data range and the outlier colors you may propagat
these settings to the rest of the dataset's windows, as described below.

Update All Windows

This button propagates the current data range and color scaling settings to the 
the dataset. All existing plot and image windows are automatically redrawn. The
tings become the primary settings for the dataset so that any new windows crea
inherit the new values.

Resize Tool

Histograms may be interactively sized with the Resize tool. Because the scales
histogram plots are not associated with the dataset row and column scales, this
be more useful than theImage Size...command.

Axis Tool

As explained above, the horizontal axis for histograms is associated with the da
range. This means that the plot bounds for the horizontal axis is actually the data
imum and maximum. If you modify the plot bounds in the axis dialog for this axi
those changes modify the data range.
Create a Histogram Transform Part 3: Reference Manual
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g
Here we discuss selecting data regions in windows, synchronizing windows, tilin
windows, hiding windows and preferences.
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The Selection Region

A fundamental concept in Transform is the selection region. Transform allows yo
mark, or select, a region of data cells in a dataset window or on an image plot a
have that region be marked in all windows associated with the dataset. With this
ture you can point to an area of particular interest in one window, such as a rast
image or contour plot, and automatically have the data values for that area visible
selected in the dataset window. If you also have a line plot open, it will display a h
izontal or vertical profile of the dataset at that point. An example of this coordinat
is shown below.

The Selection Region and Window Types

The selection region can be found on dataset windows, raster images, interpola
images, polar plots (Macintosh only), line plots, contour plots, and vector plots; 
selection region is not available for surface plots or histograms (Windows only).

Figure 20-1: Multiple Image Windows Showing Same Selection Region
The Selection Region Transform Part 3: Reference Manual
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On dataset windows, the selection region is shown in inverted text. On the other
dow types the selection region is shown as a rectangle surrounding the pixels tha
respond to the selected values. Note that if your row or column numerical scale
not uniformly spaced, the size of the selection region for the same number of da
points may vary across the image (as it should).

On line plots, Transform not only draws a rectangle around the selection region
also redraws the entire graph using the row (or column) of data from the top (lef
edge of the selection. The top and bottom edges of the rectangle match the ran
data values within the selection; the left and right edges match the columns (row
the selection region.

In Macintosh polar plots, Transform treats the selection region as a set of radius
angle measurements. An annular sector is drawn in the window, enclosing the c
sponding selection region.

The Selection Region and the Tool Bar (Windows only)

The selection region is shown when either the Select tool or the MinMax tool is
active. When the Select tool is active, Transform shows the coordinates of the s
tion region in the tool bar. This is done using the dataset’s numerical scales. Whe
MinMax tool is active, Transform maintains the minimum and maximum of the
selection region in the tool bar.

The Selection Region and the Mouse

The mouse may be used to change the selection region when either the Select t
the MinMax tool is active.

• Click and drag the mouse across the window to start a new selection region

• Click the mouse while the shift key is depressed to extend or modify the cur
selection region.

• On dataset windows, you may also click and drag across a series of column s
labels to select an entire column or series of columns and likewise for entire
rows. If you click on the area left of and above the scale labels, Transform will
the selection region to the entire dataset.
Transform Part 3: Reference Manual The Selection Region
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The Selection Region and the Keyboard

Cursor motion keys may also be used to change the selection region when the 
tool is active and, with the exception of dataset windows, when the MinMax tool
active. The table below provides a list of keyboard functions available with Windo

For each of the above key combinations, the SHIFT key may be used to extend
current selection region to the appropriate destination rather than move it.

Transform for Power Macintosh gives lets you use the Up-, Down-, Left- and Rig
Arrow keys as described in the table above, plus the ability to extend a selection u
the SHIFT key.

Synchronizing Selections Across Windows

When you change the selection region, Transform updates all windows for that 
ticular dataset automatically. Sometimes, you may want Transform to also updat
selection region for other datasets. For example, when you have temperature a
humidity measurements for the same area and you want to compare them at co
sponding locations.

To synchronize the selection region for multiple datasets, selectSynchronize from
the Edit menu. If it is active, there will be a checkmark next to it. Select it again 
turn synchronization off.

Key Action Action with CONTROL Key

Up-Arrow
Down-
Arrow
Left-Arrow
Right Arrow

Moves one cell in the
indicated direction

Moves one screen-worth in the
indicated direction

Page Up
Page Down

Moves one screen-worth in
the indicated direction

Moves to the top or bottom of
the dataset

Home
End

Moves to the left or right
edge of the dataset

Moves to the top-left or bot-
tom-right corner of the dataset

Table 20-1: Keyboard Functions (Windows only)
The Selection Region Transform Part 3: Reference Manual
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With Synchronize on, an update to a selection region affects all datasets with th
same number of rows and columns; datasets of a different size are unaffected. 
want to synchronize datasets with different sizes, first useResample Data...from the
Numbers menu to resample one dataset to the same size as the other.
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The Windows Menu

The Windows menu helps you hide (Power Macintosh only) windows you do no
want to see and find the windows you want to see. It can also rearrange the win
you have on the screen.

Window Names in the Windows Menu

The Windows menu represents a complete list of the windows that are available
the Windows menu, a checkmark marks the current window—the frontmost wind
on the screen. The dataset associated with that window is the current dataset. A
image generated from the Image menu is always of the current dataset.

Window Naming

Window names are formed from the dataset name and a suffix depending on th
dow type. The suffix also contains a number to distinguish multiple windows of t
same type.

Selecting Windows from the Menu

In addition to clicking in a window to select it, you can also select a window from t
Windows menu, which brings the window to the front. This is useful for windows
that are hidden or obscured.

Hide Window Command (Power Macintosh only)

TheHide Window command from the Windows menu makes the current window
invisible: its entry in the Windows menu is italicized to indicate that the window ca
not be seen. The only way to make the window visible again is to select the nam
from the Windows menu.

Tile Windows Command

Transform can arrange windows on the screen so that as many windows as pos
may be seen at the same time. Transform will shrink or expand the open window
make them fit on the screen.

You may want to 'hide' some of your windows before you select theTile Windows
command, so they do not clutter up your screen. You can always 'unhide' the hi
windows later.
The Windows Menu Transform Part 3: Reference Manual
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If you have a lot of windows, Transform may be forced to layer the tiled windows
(e.g., a screen of 640 x 480 pixels can hold eight windows). The first eight wind
will be tiled normally, then the next eight will be tiled on top of the first eight in a se
ond layer. This will continue with more layers if necessary. You can access the fi
layer by using the Windows menu or moving the second-layer windows.

Note
Transform does not tile color bar windows and hidden windows.
Transform Part 3: Reference Manual The Windows Menu
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Preferences

Preferences are a collection of settings that specify the default behavior of Transf
When Transform first starts up, all of the preferences are set to the last settings s
As you work with the program, Transform uses the preference settings to remem
almost everything you enter in dialogs or set up when creating images.

Preference settings are associated with the reserved macro variables described
Chapter 23. For example, the default behavior of Transform is to create contour p
without color. This is because the default setting for thecontour_color reserved vari-
able is false. If you change the Preferences setting tocontour_color=true, new con-
tour plots will be created in color.

Preferences for Windows

This section describes how to set preferences in Transform for Windows.

Font Preferences

To set the default font for Transform, select the Preferences submenu under the
menu, and choose theFont... command. This opens a standard font browser displa
ing the current default font. Select a new default font and size and clickOK . The
default font is used for all new data and notebook windows. To make this setting
manent, save your preferences with the Preferences Settings dialog, described

Display Preferences Dialog

To modify your display preferences, select the Preferences submenu under the
menu, and choose theDisplay... command.

Figure 20-2: Display Preferences Dialog
Preferences Transform Part 3: Reference Manual
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New Windows: Width and Height

These values determine the size of all newly created windows. You may want a
these to suit your particular display configuration.

Data Format and Scale Format

Newly created datasets will use these display formats for data and scales. Howev
some cases, these defaults may be overridden. For example, in file import, disp
formats saved with the dataset override the data and scale format defaults.

Preferences Settings Dialog

To view and modify the complete list of preference settings, select the Preferen
submenu under the Edit menu, and choose theSettings... command. The dialog
shown in Figure 20-3 appears.

This dialog consists of a text editing area which lists all the preference settings. W
the dialog first appears, the values shown reflect the current state of the prefere
settings in Transform. Note that these settings may change during your use of the
gram.

Using the text editing area and the various options in this dialog, you may modify
current settings and, optionally, save those settings. The options in this dialog ar
cussed below.

Figure 20-3: Preferences Settings Dialog (Windows)
Transform Part 3: Reference Manual Preferences
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Factory Defaults

Click this button to restore your Preferences settings to the default state they ha
when Transform first installed from the CD. All settings and reserved variables a
reset to their initial values.

Last Saved

Click this button to reset all the current settings to the last settings you saved.

Import

Click this button to import the preferences settings and custom macros from prev
versions of Transform. Used when upgrading Transform.

Save Settings

If this box is checked at the time you clickOK , the settings shown in the dialog will
be saved on disk, and will be active the next time you use Transform as well.

Preferences for Power Macintosh

To set Transform preferences, selectPreferences...from the Edit menu. The dialog is
shown in Figure 20-4. The options in this dialog are discussed below. Parameters
you save in this dialog remain in effect from session to session.

Figure 20-4: Preferences Dialog (Power Macintosh)
Preferences Transform Part 3: Reference Manual
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New Image Width, New Image Height

Enter the width and height in pixels of new images. Images you generate in this
sion will be of this size. Changing this does not affect images currently open.

Use Data Aspect Ratio

When checked, the image sizes are changed so that the aspect ratio is maintaine
example, if the current image size is 200 x 200 pixels, an image generated from
x 100 array will be 140 x 200 pixels in size. Note that in this option, the aspect rati
defined as the ratio of the column size to row size,not the column range to the row
range.

Data Format, Row/Column Format

Enter display formats for the data values and column/row labels in the data wind
The format specifications are detailed in Chapter 10.

These defaults are used when you create a new dataset, import a non-HDF data
paste data from the clipboard. In other cases, Transform uses the formats stored
the data. For example, if you use theExtract Selection andCalculate From Notes
commands, Transform copies the formats from the datasets used in the calcula

Lowest Number, Highest Number

All data values outside this low/high range are excluded when Transform does a
calculations. This feature affects the color bar window, imported data, and noteb
derived datasets. To reset the largest possible range, set these fields to -INF an

This feature is most useful when working with missing data. For example, if you
missing data value is -9999 but your true data goes from around 0 to around 300
can calculate the true min/max of the data by setting the Lowest Number to -9000
then opening the Color Bar.

Canvas Width, Canvas Height

Use to set the default background for image windows. The canvas corresponds t
paper your image is printed on; the scroll bars control your view of that canvas. O
controls allow you to resize and move the image anywhere on the canvas.

The canvas always starts out at least the size of your screen and is enlarged whe
create any image larger than your screen. When the image prints, the upper lef
ner of the canvas is mapped to the upper left corner of the paper. If you want m
room to scroll or more room to print, increase the size of the canvas.
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When Importing..., Transpose, Flip Horizontal, Flip Vertical

When importing non-HDF datasets, you can have Transform automatically trans
your date (swap rows for columns), flip the columns horizontally left for right, or fl
the rows vertically top for bottom. Transform does not apply these operations to
own datasets.

Display Font, Display Size

Choose your desired Font and Size selections from the pop-up menus in the dia
The choices you make affect all data and notebook windows. For most windows,
will see the change as soon as you clickOK  or Save. These settings can be overrid-
den for axis labels and for labels in contour plots.

Current Settings

To save your current settings from session to session, clickCurrent Settings and
thenSave. Transform remembers almost everything you enter in dialogs or set u
when creating images.

Factory Defaults

Click this button to restore your Preferences settings to the default state they ha
when Transform was installed from the CD. All settings and reserved variables 
reset to their initial values.

Edit Preferences...

Click this button to edit the complete list of saved Preferences variables, saved 
Transform Macro. When you are done editing, click onOK  to return to the Prefer-
ences dialog.

Note that the Preferences macro is different from a normal Transform macro in 
the list of variables and commands is fixed: you cannot add or delete macro com
mands or variables, you can only change the values assigned to the variables. Re
Chapters 22 and 23 for more information on macros and reserved variables.

Cancel

SelectCancel to return to Transform without making any Preferences changes.

OK

Click onOK to store your Preferences changes. Your changes will only be active
the current session.
Preferences Transform Part 3: Reference Manual
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Save

Click onSaveto store your Preferences changes. All changes except for New Im
Width and New Image Height will be stored on disk in the Transform application
and will be active in this and all future sessions.
Transform Part 3: Reference Manual Preferences
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Transform provides several commands under the Edit menu that allow you to
exchange data using the clipboard. In addition, you can export datasets and ima
using theSave As command from the File menu.
Transform Part 3: Reference Manual 249
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Data Exchange Commands

This section describes the variety of copy and paste commands available to bot
Windows and Power Macintosh versions of Transform.

Copy Command

TheCopy command makes choices about what to copy, and about copy format,
according to the context in which it is selected.

Using Copy in Dataset and Notebook Windows

When selected from a dataset window, theCopy command places whatever is cur-
rently selected on the clipboard as text. Data in the selection region is copied as
of numbers separated by tabs. In Windows, the scales are not included. In Pow
Macintosh, you may copy an entire row and column with its scales by clicking th
individual row or column header, then press and hold the Shift key while clicking
lower triangle above the column of labels. To copy the entire table with scales, c
the region of the two triangles at the upper left corner of the data window, then h
the Shift key and click again in the triangle region. This is suitable for pasting in
spreadsheet programs. In addition, text on the clipboard in this format may be pa
into another Transform dataset window.

When selected from a notebook window, theCopy command places the currently
selected text on the clipboard. The text can be pasted into other applications, or
other Transform notebook windows.

Using Copy in Image and Plot Windows

When selected from any plot or image window, theCopy command places the plot or
image on the Clipboard as a Picture (a Windows Metafile) or as a bitmap (Powe
Macintosh). This is suitable for pasting into presentation graphics programs. In 
tion, graphic objects on the clipboard in this format may be pasted onto any Tra
form plot or image as an overlay.

In Power Macintosh, if an overlay is present and the Select tool active, it is copi
along with the image. In this case, the drawing in the Clipboard consists of the b
image plus the overlay drawing.

Note
Power Macintosh: if you copy a contour plot with the Option key selected, you
overlay will have white lines instead of black.
Data Exchange Commands Transform Part 3: Reference Manual
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Copy As... Command (Windows Only)

Copy As... allows more flexibility by bringing up a dialog with options. When
selected from a dataset window, theCopy As...command produces the dialog shown
in Figure 21-1.

This dialog always consists of two lists. The left list displays the choice of objec
that may be copied. The right list contains the choices of what formats to use w
storing the information on the clipboard.

The contents of the lists vary depending on what type of window is active, and t
contents of that window.

Using Copy As... from Dataset Windows

From a dataset window, the selection region is copied as text, just as it would be u
theCopy command.Copy As... provides the option of copying with or without
scales, as shown in Figure 21-1.

Note
From a notebook window,Copy As... works identically toCopy; the selection
region is simply copied as text.

Using Copy As... from Image and Plot Windows

Figure 21-2 shows the Copy As dialog when invoked from an image window tha
contains a raster image and an overlay.

Figure 21-1: Using Copy As... from a Dataset Window
Transform Part 3: Reference Manual Data Exchange Commands
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From a plot or image window, Transform allows you to copy either the color tabl
the image or plot, the image with an overlay, or just the overlay. Format options lis
on the right depend on the component selected on the left:

• A color table may only be copied as a Palette object.

• The plot itself may be copied as either a Picture (Windows Metafile) or a bitm

• The plot may be copied with its overlay(s) as a Bitmap.

• The top overlay may be copied as a Picture.

Copy Color Tables (Power Macintosh Only)

Color tables, technically 'clut' resources, can be copied and pasted between win
in Transform and the View Utility. Only the Color Bar window in Transform can b
used to copy a color table. ChooseColor Bar from the Image menu and then pick
Copy Colors from the Edit menu. Whatever colors are being used in the color ba
window are stored in the Clipboard.

Copy 2x, Copy 4x (Power Macintosh Only)

These copy commands from the Edit menu multiply the size of the copied image
is drawn for the Clipboard. The reason for this operation is to increase the fine d
in the plots by using more dots. PICT drawings in the Clipboard are always assu
to be based on 72 dots per inch (dpi) of resolution, limiting the amount of detail
which can be shown. Copying a plot at actual size is always limited to 72 dpi res
tion. We get around this limitation by copying an image at a much larger size tha
intended and shrinking the plot to its intended size later.

Figure 21-2: Copy As Dialog
Data Exchange Commands Transform Part 3: Reference Manual
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For example, copy a contour plot with theCopy 2x command and then paste the
result into another application such as MacDraw. In MacDraw, print the image a
reduced size, by using thePage Setup... command to set the percent reduction to
50%. Now do the same procedure with no percent reduction and the regularCopy
command. Compare the results. Figure 21-3 shows a similar set of results obtain
resizing the plot in our documentation formatting process. The plot on the left ca
from Copy, the one on the right was produced withCopy 4x, then resized to match.

With Copy 2x, twice as many dots of resolution are used for the line calculations
Copy 4x uses four times the resolution.

Copy Bitmap (Power Macintosh Only)

Each time a line graph, contour, surface, or vector plot is drawn to the screen, T
form creates a bitmap representation of the lines that make up the plot. In this p
cess, the lines are drawn as dots and polygons are filled with dots of color again
white background. When the drawing is done, the final image is a rectangle of pix
each set to the appropriate color.Copy Bitmap puts the bitmap version of the plot in
the Clipboard. All information of lines, polygons, and text labels are forgotten an
only the complete image remains.

Raster images are always bitmap representations, soCopy should be used;Copy Bit-
map is disabled.

Figure 21-3: High Resolution Copy Results
Transform Part 3: Reference Manual Data Exchange Commands
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Paste Command

ThePaste command, like theCopy command, is simple and allows no options. In
fact, if the clipboard does not contain a format which is valid for the active windo
thePaste command may be grayed.

Using Paste in Dataset and Notebook Windows

For dataset windows, thePastecommand requires a text object on the clipboard. Th
text must be text numbers, separated by tabs or spaces. Each row must be sep
by a carriage return and linefeed.

The numbers on the clipboard are pasted into the dataset starting at the upper le
ner of the selection region. There must be sufficient space to the right and down
the selection point to accommodate the size of the data array on the clipboard. If t
is sufficient space and the text on the clipboard is in the correct format, the num
in the dataset are replaced by the numbers on the clipboard.

One convenient use forPaste is to copy portions of one array to another. If you hav
two arrays that represent similar or overlapping data but you need to compare or
bine the two, using Copy and Paste may be the easiest way to accomplish the m

Using the Notebook window with the clipboard can provide data entry capabilities
you need to enter a series of numbers into a dataset, enter them into the notebo
window first, separated by tabs with carriage returns at the end of each row. Cop
text numbers to the Clipboard, select a data window and use Paste to enter the
bers into the dataset (or in Power Macintosh, usePaste New to create a new dataset)

Using Paste in Image and Plot Windows

For plot or image windows, thePastecommand requires a graphic that can be past
as an overlay. The preferred format is a Picture (Windows Metafile) or PICT (Po
Macintosh) but a bitmap may be used.
Data Exchange Commands Transform Part 3: Reference Manual
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Paste As... Command (Windows Only)

ThePaste As... command allows more flexibility in pasting objects from the Clip-
board. The Windows Clipboard is capable of containing more than one kind of ob
at a time. Using thePaste As...command, it is possible to choose which item to pas
and how to paste it. Shown below is the Paste As dialog. This dialog always disp
two lists, described below.

Paste:

This list shows the objects, by format, which are available on the Clipboard for p
ing. In the example above, an object has been copied to the clipboard in two form
Bitmap and Palette.

As:

This list shows the available ways in which the object might be pasted into Tran
form, depending on which item is highlighted under Paste:, as well as on the typ
the active window. Only formats appropriate for the active window are shown.

For example, a Bitmap object listed under Paste: can be pasted into an image win
as on overly, or pasted into a data window as a new dataset (Transform convert
pixel values to data values).

A Palette object can only be pasted into an image window as a new color table.

Paste Overlay and Paste New for Images (Macintosh Only)

Two forms of pasting images are supported, creating a PICT overlay and creatin
new dataset. Use thePaste Overlay command from the Edit menu to paste the con
tents of the Clipboard as an overlay. The current window must be an image win
The overlay is drawn into the window, aligned with the image which is already

Figure 21-4: Paste As dialog
Transform Part 3: Reference Manual Data Exchange Commands
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present (note that the drawing in the Clipboard needs to be transparent so that 
image beneath it is still visible). If this PICT is not the desired overlay, delete it w
theClear Overlay command (make sure the Overlay tool is selected to do this).

SelectPaste New to create a new dataset and a new image window based on the
rent Clipboard. The Clipboard PICT is drawn as a Transform image and converte
pixel values in the range 0 to 255. The data window that appears shows the dat
ues derived from this image, one data value for every pixel in the PICT image.

Paste Color Tables (Power Macintosh only)

Any color table, technically a 'clut' resource, in the Clipboard can be pasted into
Transform's image windows. This resource contains a full set of 256 color entries
like the color tables in the Color Tables menu.

After usingCopy Colors to place a color table into the Clipboard, use thePaste Col-
ors command from the Edit menu to apply that color table to the current image. O
images and plots that use color can be affected by this process, limiting its use to
ter images, color contour lines, and color surface plots.
Data Exchange Commands Transform Part 3: Reference Manual
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File Export

Transform lets you to save your data and/or images in one of several formats. Y
may also export through the Clipboard as discussed in the previous chapter.

Using Save As... to Export Data

Under the File menu, theSave As... command brings up the dialog shown below
when chosen with a dataset window active. The drop-down menu/radio buttons in
bottom of the dialog allows you to choose the file format to be used. The format
available depend on the active window type.

Transform HDF/Data, Images, Notebook to HDF

By default, Transform saves a dataset to an HDF file with an identifier that marks
file as having been created in Transform.

The Notebook contents are saved as an annotation record. All plot or image wind
are saved as 8-bit raster images. All custom color tables are saved as 8-bit colo
ettes. All overlays are stored as Windows Metafile/PICT records.

In addition, Transform saves extra information to allow all windows to be recon-
structed as they were when they were saved. Transform files may be used by a
other program which supports the HDF format.

Figure 21-5: Save As Dialog (Windows and Macintosh)
Transform Part 3: Reference Manual File Export
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HDF Data/Data Only to HDF

With this option, Transform writes the dataset and the Notebook contents (Wind
only) into an HDF file, but does not save anything else. Transform will import the
data in this file, but it will not recognize the file as a Transform HDF file.

Append to HDF Data File (Windows only)

This is equivalent to the HDF Data File described above, except that the datase
appended to the existing HDF file.

If you have a Transform HDF File and you append datasets to it using "Append
HDF Data File", when you reopen the file in Transform it will only open the data
that was originally saved using the Transform HDF option. If you want the Multip
Records dialog to appear (allowing you to open all of the datasets in a file), you m
first save the file using HDF Data File, and then append the datasets to that file

Note
Power Macintosh: you can append datasets and images with the macro langu
usingsaveas() .

ASCII Matrix/Data in Text Format

With this option, Transform writes the data and scales to an ASCII text file as a sc
matrix. Each row is output on one line with each number separated by tabs. The
bers are formatted exactly as they are in the data window. The first line contains
column headers, and each line starts with the row header for that row. Useful fo
exporting the data to spreadsheets or word processors. Transform can import th
format as an ASCII matrix file, with the Table Format option selected.

Raw Binary Float File (Windows only)

With this option, Transform writes the data only to a raw binary file. The numbers
saved in IEEE floating point format, 4 bytes per data value. No header informatio
retained, so a dataset saved in this format with X columns and Y rows will be exa
(X * Y * 4) bytes long.

Transform can import this file as a binary matrix file, but you will have to specify t
number of rows and columns and number type at import time, as that informatio
not stored in the file.
File Export Transform Part 3: Reference Manual
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Save As... from Image Windows

The following options are available in the Save As dialog when the command is
sen from a plot or image window:

Transform HDF/Data, Images, Notebook to HDF

Same as described above for dataset windows.

HDF Image/Image to HDF

In Windows, this option in Transform creates an 8-bit raster image which contains
contents of the current window and saves it into an HDF file.

In Power Macintosh, the image record is a compressed 8-bit image with a color
lookup table. Useful for exporting to programs that display HDF images. Transfo
can import this file type, but it converts the 8-bit image into data values in the ra
0-255. Note that saving an image to HDF Image saves the overlay but not the a

Append to HDF Image

In Windows, this is the same as the HDF Image File described above, except tha
image is appended to the existing HDF file.

If you have a Transform HDF File and you append images to it using "Append t
HDF Image", when you reopen the file in Transform it will only open the dataset
notebook and image that were originally saved using the Transform HDF option
you want the Multiple Records dialog to appear allowing you to open all of the
images in a file, you must first save the file using "HDF Image File", and then app
the images to that file.

Note
Power Macintosh: you can append datasets and images with the macro langu
usingsaveas() .

Image to PICT (Macintosh only)

Saves the image and any overlay in a PICT file as one combined drawing. Macin
publishing, drawing, and word processing programs often can import PICT files
directly.

Transform can import this file type, but first converts the drawing into an 8-bit re
sentation with data values in the range 0-255. Note that saving an image to PIC
saves both the overlay and the axes.
Transform Part 3: Reference Manual File Export
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TIFF File/Image to TIFF

With this option, Transform creates an 8-bit raster image which contains the cont
of the current window and saves it into a TIFF (Tagged Image File Format) file, 
of the most commonly used standard formats for image data. Note that in Powe
Macintosh, saving an image to TIFF does not save overlays or axes.

Note
In full Transform HDF save files, the dataset is stored as an HDF Scientific Data
(SDS) record with 32-bit floating point values. The scales and printing formats
stored with the data in the SDS record.

Images, including the raster plots, contour plots, surface plots, vector plots, and
graphs are stored as compressed raster images in their own Raster Image Gr
(RIG) records, one per image window. The notebook is an annotation record for
dataset. Overlays in Power Macintosh are PICT records which are restored wh
reading the file.

Finally, the master index is stored in a custom ASCII description record unique
Transform. This master record is not published, but the individual image and d
records match the HDF specification exactly and are available for extraction w
programs that use the HDF libraries.

Windows Metafile (Windows only)

With this option, Transform saves the plot or image (but not the overlays) into a W
dows Metafile, which can be imported into page layout or presentation applicati

Save Command

Save only works for complete files which were saved previously with the 'Transfo
HDF/Data, Images and Notebook to HDF' option of theSave As... command. The
Save command rewrites the file with the data, notebook, and all image windows.
ally Transform saves a single dataset per file. However, when you save a file co
ing vector plots or surface plots with a second color variable, both datasets use
create those image plots are written to the file. When you open the file again, bo
datasets will appear. Note that if a surface plot and a vector plot both use the sa
second variable, two copies of the second variable are saved.
File Export Transform Part 3: Reference Manual
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Close Commands

To close an image or dataset and free its memory, click on the close box or sele
Close on the File menu.

SelectingClose All from the File menu closes all the windows and datasets curren
open, hidden or not. It is the same as using theClose command for every open win-
dow.

When you close a data window you will see the warning dialog if you have made
changes to images, data, or the notebook associated with that data window. ClickYes
in the dialog to save the changes or to save a new data file and close the windo
Click No to ignore any changes and close the window. TheCancelbutton cancels the
Close command.

A file can only have one dataset window and one Notebook window, but may ha
multiple image windows. When a dataset is removed from memory, all image w
dows that are dependent on that dataset are also closed. However, image wind
may be closed without affecting their associated datasets.

Note that unlike image windows, you may close the Notebook window at any tim
without losing its contents. The contents are saved with the dataset at all times.
ChoosingSee Notebook from the Numbers menu restores an old notebook windo
to the screen with all of its previous contents.

Note
Vector plots (and some surface plots) are made from two datasets. If any of th
supporting datasets are removed from memory, then these image windows are
removed.
Transform Part 3: Reference Manual File Export
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Transform has a built-in macro language that is very similar to Fortran. The mac
language is procedural and consists of three basic elements: functions (i.e., y=3
subroutine calls (i.e., call open(“filename”)) and reserved variables (i.e.,
axis_auto=true). In Transform, the function and subroutine elements are primar
used to perform calculations, manipulate data, and generate images. The reser
variables give the capability of setting the preferences used by the subroutine e
ments.

Most of the following example macros are included in the 'Transform/Macros' fold
You can avoid typing in these macros in two ways.

1. Copy the text into an empty Notebook window, highlight the text and choose
Calculate from Notes from the Numbers menu.

2. From the Macros menu, selectEdit Macros and thenImport... from the dialog
to add the macro to the Macros menu. Then execute the macro by selecting
from the Macros menu.
Transform Part 3: Reference Manual 263
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The Notebook Window

All of the three basic elements mentioned above contain a variety of macros wh
can be accessed through the Notebook window. To open the Notebook window s
See Notebook under the Numbers menu. With the Notebook window active in Wi
dows, the toolbar consists of two popup menus; Datasets and Scalars; in Powe
intosh, the Notebook window contains four pop-up menus: Math Fns, Functions
Datasets and Externals. These menus are designed to expedite entries into the
book. Select an item from the pop-up menu (in Windows you have to also press
Enter key) to place it into the Notebook at the location of the cursor. We recomm
that you use the pop-up menus as much as possible to avoid typos and syntax 

Datasets Menu

The Datasets menu contains a listing of all available dataset arrays currently in 
ory. For example, the following datasets were imported into Transform and are c
rently available.

Figure 22-1: The Notebook Window
The Notebook Window Transform Part 3: Reference Manual
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Selecting a name and then pressing Enter will paste it into the Notebook at the 
rent cursor location. Transform automatically converts any illegal characters into
proper macro syntax (i.e., My File is converted to My_File).

Scalars Menu (Windows only)

The Scalars Functions menu lists all of the reserved variables that are used by 
form. Selecting a name and then pressing the Enter key will paste it into the No
book at the current cursor location.

Figure 22-2: The Datasets Menu

Figure 22-3: The Scalars Menu
Transform Part 3: Reference Manual The Notebook Window



266 Chapter 22: Using Macros

elp

into
ol-
dy for
lly

3.

uilt
k,
ready
ni-

3.

ded
rsor
nc-
In addition to the chapters in this manual, you can consult Transform's on-line h
by selectingMacro Language Reference...command from the Help menu.

Math FNS Menu (Macintosh only)

The Math Fns menu contains a listing of the mathematical macro functions built
Transform. When you select a function, the name is pasted into the Notebook, f
lowed by a set of parentheses (). The cursor is placed inside the parentheses, rea
you to type the parameter for the function to call. The function name that is initia
highlighted is always the last function selected from the menu.

Note
Each individual mathematical macro is described in greater detail in Chapter 2

Functions Menu (Macintosh only)

The Functions menu contains a listing of the data manipulation macro functions b
into Transform.When you select a function, the name is pasted into the Noteboo
followed by a set of parentheses (). The cursor is placed inside the parentheses,
for you to type the parameter for the function to call. The function name that is i
tially highlighted is always the last function selected from the menu.

Note
Each individual mathematical macro is described in greater detail in Chapter 2

Externals Menu (Macintosh only)

The External Functions menu lists all of the external functions that have been loa
into Transform. Selecting a name will paste it into the Notebook at the current cu
location. See Appendix F for information about how to create you own external fu
tions.
The Notebook Window Transform Part 3: Reference Manual
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Executing Macro Commands in the Notebook

Once the Notebook window is open, it takes three steps to execute a macro comm
The steps are:

1. Type in a macro command or a series of macro commands.

2. Highlight either a single macro command or series of macro commands.

3. SelectCalculate from Notes from the Numbers menu.

Note
Each macro command must occupy one and only one line. However, if your m
wraps to the next line and you did not use a carriage return, Transform will exec
the macro as if it occupied only one line.

Tip
If you only want to execute one macro command you do not have to highlight 
You can simply put the cursor at the end of the macro you want to execute and
selectCalculate from Notes from the Numbers menu anywhere in the line.

Figure 22-4: Commands Executed in the Notebook (Fig22_04.txt)
Transform Part 3: Reference Manual Executing Macro Commands in the Notebook
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By selectingCalculate from Notes, Transform will execute every highlighted macro
command in the Notebook window starting from the top and ending at the botto
This is very convenient for entering a series of commands and executing them i
specific sequence. For example you may want to open a file, perform some dat
manipulation, and then save the file. To illustrate this example, we will use the fi
Yvel.hdf which is included with a typical installation of Transform.

In this example, the directory "Saved" was created before the macro was execu

Note
Power Macintosh: the name of the hard drive in these macro examples will no
always be the same as your system. Be sure and substitute the name of your 
drive whenever you have to give path information.

In addition, in the example above, instead of ‘call setdirectory’ and ‘call setsav
rectory’ you would use the line ‘call setfolder’ and ‘call setsavefolder’. See the
example in the ‘Macros’ directory for more information.

Besides entering macro commands in the Notebook window, it is also possible 
enter comments. Comments will enable you to document your work so that it is 
ily understood at a later date. To enter a comment that starts at the beginning o

Figure 22-5: Sample Macro Run in the Notebook (Fig22_05.txt)
Executing Macro Commands in the Notebook Transform Part 3: Reference Manual
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line, place an asterisk (*) symbol before your text. If you are entering a comment
follows a macro command that you want to execute, place an exclamation (!) sym
before your text. Any characters entered after an asterisk or exclamation symbol
be ignored by Transform whenCalculate from Notesis selected.

There is one last command that can be executed in the notebook window, and it i
Print  command. ThePrint  command will display either scalar variables or the
results of scalar calculations in the Notebook window. It is important to point out t
values displayed from thePrint  command start with an asterisk and are treated as
comments.

ThePrint  command will only work for scalar variables and scalar calculations. A
attempt to use thePrint command for an array will cause an error dialog to appear.
this instance, the error dialog is, “Warning, Incorrect or misplaced parameters in
macro function”. This error message makes sense because an array is an incor
parameter for thePrint  command.

Figure 22-6: Comments in the Notebook (Fig22_06.txt)
Transform Part 3: Reference Manual Executing Macro Commands in the Notebook
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Error Messages

Transform displays an error dialog box any time an illegal operation is attempted
illegal operation can be caused by typing in the macro wrong or attempting to p
form a procedure that is not possible. The dialog box displays the macro in que
and gives general information about the problem. Below is a list of some commo
error messages you may encounter. Keep in mind that this list is not all inclusive

Windows Errors

• Warning, Function not found

• Warning, Syntax error in line: "___" _ characters from beginning of line

• Warning, Identifier not found. Undefined symbol or array

• Warning, Incorrect or misplaced parameters in macro function

• Warning, This expression requires an array

Macintosh Errors

• Error, incorrect or misplaced parameters in the macro function

• Error, Window not found

• Error, Identifier not found. Undefined symbol or array

• Syntax Error, ## characters from the beginning of the line

• Error, Function not found

Tips for Avoiding Errors

Some tips for avoiding error messages are to ensure:

• Macros are typed correctly.

• CAPITAL letters are used when they refer to a name with capital letters.

• Double quotes (“”) are used around names when using subroutine macros.

• The wordcall is placed in front of subroutine macros.

• You usevar(string) when you want a string name to point to the dataset itsel
(i.e., b = "Filename", m = cols(var(b)) returns the number of columns in the
dataset called “Filename”).
Error Messages Transform Part 3: Reference Manual
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Components of Macro Commands

Before discussing how to use the macro commands, it is important to identify th
components of a command. A macro command consists of Mathematical Opera
Constants, Scalar Variables, Dataset Arrays, and Transform’s internal macros. A
macro command can consist of any number of operators, constants, scalar vari
arrays, and internal macros. Each component is defined below.

Mathematical Operators

Mathematical operators are listed below in order of precedence:

To override the precedence, use parentheses ().

- negation (unary minus)

** exponentiation

* and / multiplication and division

+ addition

- subtraction

// concatenation (of strings)

Table 22-1: Mathematical Operators

Figure 22-7: Mathematical Precedence in the Notebook (Fig22_07.txt)
Transform Part 3: Reference Manual Components of Macro Commands
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Constants

Numerical constants are entered with periods (.) for decimal points, and with e re
senting exponentiation. Integers are converted to floating point values before be
used in calculations. Examples of numerical constants are:

3.14159
1.0669e+23

String constants are always delimited with double quotes ("). Some examples a

"xvel.hdf"
"3.14159"

Scalar Variables

Scalar variables are created from assignment statements. For example,

pi = 3.14159

creates the scalar variable pi which has the value "3.14159". All variables are gl
and may be referred to any time after they are created.

The values of all variables are stored as ASCII strings, so they may represent n
as well as numbers. The maximum length of a variable value is 255 characters.
examples below are all legal expressions:

pi = "3.14159"
myfile = "xvel.hdf"
print 1 + "3.14159"
* Result: 4.14159

In particular, thepi  assignment statement given above and the one given previo
are exactly equivalent.

The legal characters for a variable name include all of the alphanumerics and th
underscore (_). Names cannot start with a number. Periods, slashes, asterisks,
plus or minus signs (. / * + –) are not allowed in variable names. For example, p
sure/dens, ke.hdf, and v*u are invalid variable names; but xv102 and K_Energy
valid.

Whenever a variable is used in an expression which requires a number, it is conv
to a number before being used. A value of zero is returned if the field does not s
with a number.
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Dataset Arrays

Any open dataset array may be used in a calculation as you would a scalar vari
For example, if A is an array, then executing the Macro command:

B=log(A)

will generate a new array called B, where each element is equal to the log of the
responding element in A.

The following expressions are also legal:

B=log(A)+1
C=A*A+2

Figure 22-8: The Use of Constants and Strings in the Notebook (Fig22_08.txt)
Transform Part 3: Reference Manual Components of Macro Commands
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In the first example above, each element in B is set to the log of the correspond
element of A, plus 1. Note that arrays and scalar variables can be combined in 
same expression: the scalar variables are treated as if they were arrays with eve
ment set to the scalar value.

In the second example, each element in C is set to the square of the correspon
element in A, plus 2. Note that here, this is not a cross product. If you use more
one array in an expression, they must all have the same row and column dimens

The newly created array will have the dimensions, the numerical column and ro
labels, and the attributes of the first array in the expression. In addition, the minim
and maximum values for the dataset are automatically calculated. A data windo
created and appears on the screen with the name from the formula.

Legal characters for dataset names used in expressions are the same as those
lar variables.
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Function Macro Commands

Function commands are used to calculate mathematical expressions and assig
results to either scalar variables or dataset arrays. If the function returns a scalar
or a scalar string, it is defined as a scalar variable. The best way to display the v
of a scalar variable is to use thePrint  command. In most calculations, all of the
arrays must have the same dimensions. Note that a mathematical expression c
tain any number of these functions.

If the function returns an array, then a new dataset is created with the variable n
In the examples above, you can see that since “x” is a scalar variable then “y” is
a scalar variable. Since “Xvel” is an array, then a new array called “Xvel_sine” is c
ated.

Figure 22-9: Functions in the Notebook that Return Scalars or Arrays
(Fig22_09.txt)
Transform Part 3: Reference Manual Function Macro Commands



276 Chapter 22: Using Macros

 in
 ele-

’

of
unded
Function Macro Examples

Mathematical Trigonometric Functions That Create Arrays Or
Return Scalars

TheGTmask function creates a new array from an existing array. In the function
the above figure, every element in the new array is set to 1 if the corresponding
ment in “Xvel” is greater than 10, and set to 0 if it is less than or equal to 10.

The dataset “Xvel” is the file “Xvel.hdf” which can be found in the ‘Samples\Tstorm
directory.

In the following figure, the random 10 x 10 dataset "q" was created in the first line
the macro. The x dataset was created with truncated decimals, the y dataset ro
down, and the z dataset rounded up.

Figure 22-10: Mathematical Trigonometric Functions that Return Scalars or
Arrays (Fig22_10.txt)
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Mathematical Functions that Require an Array and Return a
Scalar Value

In the example below, we find the mean, standard deviation, minimum, maximu
and sum values for the dataset "Xvel". ThePrint  command is used to display the
results.

Figure 22-11: Mathematical Functions that Create Arrays or Return Scalars
(Fig22_11.txt)
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’
The dataset “Xvel” is the file “Xvel.hdf” which can be found in the ‘Samples\Tstorm
directory.

Figure 22-12: Mathematical Functions that Require an Array and Return a
Scalar Value (Fig22_12.txt)
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Data Manipulation Functions

Thetransfer(q,p) function copies the array “q” into a new array “trans1”, then co
ies array “p” into “trans1” for every cell that they have in common. This is one of t
few functions where the arguments p and q can be different sizes.

Figure 22-13: Data Manipulation Functions in the Notebook (Fig22_13.txt)
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x “q”.
Data Manipulation Functions that Require an Array and Return a
Scalar Value

This example proves that the matrix “trans1” has the same dimensions as matri

Figure 22-14: Data Manipulation Functions in the Notebook (Fig22_14.txt)
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Data Manipulation Functions that Generate Arrays Based on
Analytic Expressions

This example creates a 10x10 matrix where every data location has the value o

Figure 22-15: Data Manipulation Functions that Generate Arrays Based on
Analytic Expressions (Fig22_15.txt)
Transform Part 3: Reference Manual Function Macro Commands



282 Chapter 22: Using Macros

he

the
Advanced Functions

As you can see, Transform inserts the frequency of the matrix data values into t
appropriate data location.

Fourier Transform

You can use Transform to take 2D FFTs of images. Using the 'Xvel.hdf' dataset in
‘Samples\Tstorm’ directory, we generated the image below.

Figure 22-16: Advanced Functions in the Notebook(Fig22_16.txt)
Function Macro Commands Transform Part 3: Reference Manual
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Figure 22-17: 2D Fast Fourier Transform in the Notebook (Fig22_17.txt)

Figure 22-18: Image Created from the Log of the Amplitude
Transform Part 3: Reference Manual Function Macro Commands
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Theresamplerows() andresamplecols() functions resample arrays to the specified
size. They are needed here because Transform's FFT routine only works on co
arrays with row and column sizes that are a power of 2 (64,128,256,512...); they n
not be the same power of 2. Thecomplex() function takes a real array and an imag
nary array (here just zeros), and creates a complex array, with each set of two c
umns representing the real and imaginary parts.

The fft() function does the 2D FFT in the forward (+1) direction. Theampl() func-
tion calculates the real amplitude of a complex array, here the complex frequen
array. We took the log of the amplitude so we could make a better image.
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Subroutine Macro Commands

Transform’s macro language includes subroutines for performing various tasks,
as creating images, processing data, and running custom macros. In order to use
subroutines, the macro command requires the word “call” to be placed in front of
macro. However, some of the subroutines have the form of functions. These sub
tines DO NOT require the word “call” to be placed in front of the macro.

The dataset 'Xvel' is the file 'Xvel.hdf' located in the ‘Samples\Tstorm’ directory.
the example, the directory 'Saved' was created before the macro was executed.

Tip
You can run custom macros saved on the Macros menu from the Notebook win
by using the “call” statement (e.g., call ImageMacro).

Figure 22-19: Subroutine Macros in the Notebook (Fig22_19.txt)
Transform Part 3: Reference Manual Subroutine Macro Commands
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Note
Power Macintosh: Be sure and substitute the name of your hard drive whenever
have to give path information.

In addition, in the example above, instead of ‘call setdirectory’ and ‘call setsav
rectory’ you would use the line ‘call setfolder’ and ‘call setsavefolder’. See the
example in the ‘Macros’ directory for more information.

It is also important to note that most subroutines require either the datasetname
downame, or filename to be entered after the macro. Transform uses the follow
definitions:

datasetname

Name of the dataset window currently active in Transform.

windowname

Name of an image window currently active in Transform.

filename

Name of a file as it is saved on disk.

macroname

Name of macro listed in the Macros menu.

Each of these four names must be enclosed in quotation marks when used in ma
Instead of implicitly stating the dataset (e.g., Xvel), you can also use the reserve
variablecurrentdataset  which is defined by Transform to be the most recent
opened or created dataset.

Tip
In Transform, you will notice that your datasetname does not necessarily corre
spond to your filename. If you want them to correspond, simply selectAttributes...
under the Numbers menu. There you can change the name of your dataset to
spond to the filename.
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Note
In Transform, images that are created from your datasets have the datasetnam
the image type and number added to it. The number specifies the order in which
image is created. This is helpful if you create several images from one dataset

Subroutine Macro Example

The subroutinevar() will return the actual dataset (the numbers) from a string rep
senting the datasetname. The subroutinevar() is most commonly used withcurrent-
dataset. Usingvar() allows you to use currentdataset within a function that expect
numerical argument. Without the use ofvar(), the function will return an answer of
zero, because the value of the string represented by currentdataset is zero, or an
error saying this function requires an array.

Figure 22-20: Subroutine Macro using var( ) in the Notebook (Fig22_20.txt)
Transform Part 3: Reference Manual Subroutine Macro Commands
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Reserved Variable Macro Commands

In Transform, the reserved variable macros are primarily used to set the prefere
of the subroutines. In other words, reserved variables provide the details necess
for a subroutine to carry out it’s function. For example, if you attempt to create a
image using the subroutine:

w=image(datasetname)

all of the details about how to build that image are controlled by the reserved varia
macros. The reserved variable macros define everything from image size to add
axes. The reserved variable macros can be used from the Notebook window, bu
primarily used when editing custom macros.

In this example, the reserved variables defined the surface plot's orientation angl
surface type. Type six is a high resolution, framed color surface plot.

Figure 22-21: Reserved Variable Macros in the Notebook (Fig22_21.txt)
Reserved Variable Macro Commands Transform Part 3: Reference Manual
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Custom Macros And External Macros

In addition to executing macros from the Notebook, they can also be stored as cu
macros on the Macros menu or they can be executed remotely from Mathemati

Transform may be connected to Mathematica from Wolfram Research via MathL
You can also exchange data with Transform over MathLink. See Appendix B for
details and examples.

Custom macros can be created in one of three ways, depending on whether a n
book window, a dataset array window, or an image window is currently active.

Transform also accepts macro commands from other applications via AppleEve
under System 7 (Power Macintosh only). One convenient scripting environment
AppleScript from Apple computer. See Appendix C for details and examples.

Custom Macros: The Notebook Window

To save macro commands that you have entered in the notebook as a custom m
make the notebook window the active window on your screen and select Create
Macro from the Macros menu. Enter a name for the macro, then clickOK . The cus-
tom macro will be added and stored in the Macros menu for future use. If you cho
the same name as an existing macro, the new macro will replace it. To use the cu
macro at a later date, you can either select it from the Macros menu, typecall in front
of it in the Notebook window, or you can call it from another custom macro usingcall
and the macro name.

Figure 22-22: Running a Macro from the Macros Menu
Transform Part 3: Reference Manual Custom Macros And External Macros



290 Chapter 22: Using Macros

l, so
 the

ery
m-

n
ok
ing

plit
akes
, add-
r

Note
Custom macros never accept parameters. All variables in Transform are globa
any information needed by a macro should be stored in variables accessed by
macro before calling the custom macro.

The saved custom macro will work exactly as it did in the Notebook. Note that ev
line of the Notebook is brought into the custom macro, so make sure that any co
ments either begin with an asterisk (*) or an exclamation (!).

Tip
If you are executing a custom macro, or several custom macros, and you get a
error message, you may want to copy and paste the macro(s) into the Notebo
window and run the macros line by line to determine exactly which line is caus
the error.

Tip
When creating macros that perform many different functions, it is advisable to s
them up into several smaller macros and call them from a main macro. This m
it cleaner to read your macro, and easier to find errors during execution.  Also
ing many comment lines will help you remember later on how you created you
macros and for what purpose.

Figure 22-23: Running a Macro from the Notebook (Fig22_23.txt)
Custom Macros And External Macros Transform Part 3: Reference Manual
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Creating A Startup Macro

It is also possible to run a custom macro each time Transform starts. If you save
macro to the Macros menu with the name 'Startup_Macro', it will be executed e
time the program launches. To avoid running the macro at startup, either renam
delete the Startup_Macro.

1. Plot Size

This Startup_Macro sets the initial plot size at 400 x 400 points. Save these lines
macro called Startup_Macro. Exit Transform and then restart the program. Ope
file and create an image. The image will be 400 x 400 pixels.

image_h = 400
image_v = 400

2. Setting Dataset Window Attributes

This Startup_Macro sets the initial characteristics for data windows. It sets type
to 12 points, font to Times, and column width to six characters.

pref_textsize = 12
pref_textfont = "Times"
pref_columnwidth = 6

3. Setting Default Print Options (Windows only)

This example sets initial printer and print options. It sets the page margins.

print_margintop = .5
print_marginbottom = .5
print_marginleft = .5
print_marginright = .5

4. Setting Default Directories (Windows only)

This macro sets initial directories for opening and saving files. The saved directo
was created before starting Transform.

call setdirectory("C:\Fortner\Trnsfrm3\Samples") !where to open files
call setsavedirectory("C:\Saved")  !where to save files

It is recommended that you use thesetsavedirectory()subroutine directly in front of
anysaveas() commands.
Transform Part 3: Reference Manual Custom Macros And External Macros
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5. Setting Default Folders (Macintosh only)

This Startup_Macro sets the initial folders for opening and saving files

call setfolder ("drive:Transform") ! where to open files
call setsavefolder ("drive:Saved") ! where to save files

Note, it is recommended that you use thesetsavefolder()subroutine directly in front
of any saveas() commands.

Custom Macros: Dataset Import Macro

Custom import macros can also be saved for any non-HDF files that you open. 
save an import macro, simply open a file and select Create Macro from the Macros
menu. Enter a name for the macro, then clickOK . Creating an import macro is a
good way to automate the loading of files that have exactly the same format.

Note
The dataset window must be the active window before selectingCreate Macro
from the Macros menu.

In this example, the imported file is “Sprngfld.txt”. It can be found in the ‘Sam-
ples\Monthly’ directory.

Figure 22-24: Creating a custom import macro
Custom Macros And External Macros Transform Part 3: Reference Manual
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Note
If your dataset window was either an imported HDF file or created inside Trans
form, then theCreate Macro... option in the Macros menu will be grayed out.

Custom Macros: Image Window

Custom image macros can also be saved for any images that you create. To sa
image macro, simply create an image and selectCreate Macro from the Macros
menu. Enter a name for the macro, then clickOK .

Note
The image window must be active before selectingCreate Macro... from the Mac-
ros menu.

In this example, the imported file is 'Xvel.hdf' which can be found in the ‘Sam-
ples\Tstorm’ directory.

Figure 22-25: Creating a Custom Macro to Generate Surface Plots
Transform Part 3: Reference Manual Custom Macros And External Macros
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Editing Custom Macros

SelectingEdit Macro... from the Macros menu brings up a dialog that lists all exis
ing macros. The Edit Macros dialog lets you select a macro from a scrolling list 
edit, rename, delete, or export it. You can also import macros from text files or cre
a new macro. Each of these options is described below. When you are finished 
Done to return.

Tip
It is always a good idea to make a back-up of all your custom macros, using th
Export... button.

New Macro

Click New... to script a new macro from scratch. When you clickNew..., you will be
prompted for a name. Enter a name for the new macro and clickOK . The Macro Edi-
tor dialog, described next, will appear, blank, allowing you to enter a new macro

Edit Macro

To edit an existing macro, select its name from the list in the Edit Macros dialog, t
click Edit... to display the Macro Editor dialog (you also can double click on the
macro name.)

Figure 22-26: Edit Macros Dialog
Custom Macros And External Macros Transform Part 3: Reference Manual
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The selected macro will appear, line by line, in the Macro Editor dialog. This dia
lets you enter new text, or edit existing text. The Edit menu is disabled while the
Macro Editor window is active; you can use Control-X, Control-C, Control-V (in
Power Macintosh use the Command key instead of the Control key) to cut, copy
paste text in the window. You may find it easier to copy the entire macro into the
Notebook window to edit it, and then copy it back into the Macro Editor dialog.
When finished, clickOK  to save your changes, orCancel to leave your macro
unchanged.

Rename Macro

Click Rename... to rename the selected macro. Enter the new name and clickOK ;
otherwise clickCancel.

Delete Macro

Click Delete to remove the selected macro. As soon as you confirm the deletion
macro is removed from the list permanently.

Import Macro

Click Import ... to invoke a file browser, which allows you to select a text file and
save it in Transform as a custom macro. Imported macros will appear on the Ma
menu and in the dialog list.

Figure 22-27: Macro Editor Dialog
Transform Part 3: Reference Manual Custom Macros And External Macros
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Note
If you import a file as a macro, or create a new macro from the Edit dialog or t
Notebook, any macro on your menu with the same name is overwritten autom
cally.

Export Macro

Click Export ... to save the selected macro as a text file. You can edit this file with a
text editor or word processor. UseImport ... to read the file back in.

Custom Macro Examples

The following provides examples of how to use custom macros.

Contour Overlay

You can use Transform to automate your visualization tasks. The following exam
opens a data file and creates a contour plot, opens another data file and creates a
image, then pastes the contour overlay on the raster image.

To execute this macro, highlight every line and selectCalculate from Notesfrom the
Numbers menu.

Figure 22-28: Contour Overlay Macro in the Notebook (Fig22_28.txt)
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The first line sets the directory to the location of the data files. Note you may hav
change the path to the location of the Transform directory or folder.

The variablecurrentdataset is set by Transform and is always the active dataset. T
variablecurrentplot  is a reserved variable used to store the name of the current
image window.

We also set the reserved variableimage_axesto false so no labels appear on the co
tour image, and we setcontour_list="auto" so that Transform will pick contour lev-
els.

Calculate Area of a Surface Plot

This next macro calculates and displays the surface area of a surface plot. It ca
lates a numerical approximation of the following integral for a function f(x,y).

Figure 22-29: Contour Overlay Pasted onto the Raster Image
Transform Part 3: Reference Manual Custom Macros And External Macros
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The first line calls the open file subroutine; since no path or file name is listed, the
browser will appear on screen, prompting you to select a data file. Open 'Xvel.h

Note that line 4 creates an array named "q" identical tocurrentdataset; var() is used
becausecurrentdataset contains a string, while mathematical functions require
either an array or scalar as their arguments.

Creating a new array or calling a macro from a dataset will modify currentdatase
line 3 we stored the name of the array 'Xvel' to use later in other macro comman

Surface Plot Animation (Windows)

In this example, we create a rotating surface plot animation that can be played b
with the Windows Media Player. For more information on the Media Player and 
capabilities, see the Microsoft Windows User’s Guide.

First, you need to create a surface plot for the first frame of the animation. Use 
sample dataset. Set up the surface plot the way you want it to appear, but for th
example, we recommend a framed color surface plot with the following settings
Under the Axes tool, set the Axis Type toLeft Data Axis, and turn off the Color Bar.
Under the Select tool, set the orientation to X=-50, Y=0, and Z=0.

Figure 22-30: Calculate Surface Area Macro in the Notebook (Fig22_30.txt)
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From your new surface plot window, chooseCreate Macro... and use the name
“surface_anim” for the macro. Now selectEdit Macros... from the Macros menu,
edit the macro named “surface_anim” and make the changes described below.

Scroll through the macro to find the line forsurface_anglez and change it to follow
the loop_index. Loop_index is a special reserved variable set up by the loop com
mand which we will be using next.

surface_anglez = loop_index

Now scroll to the end of the macro and add the following linesbefore the
user_interactive = true line. Every time this macro is run, this line appends the
resulting image to an HDF file.

call setsavedirectory("c:\saved")
call saveas(currentplot, “anim.hdf”, 13)
call close(currentplot)

Those are the only two changes to the “surface_anim” macro. This macro is now
capable of creating one frame of our animation. We now need to call it multiple
times, once for each frame of the animation. You must create the directory 'c:\sa
before you can run this macro.

The loop command allows us do just that. It calls any custom macro multiple tim
Enter the following command in the Notebook window for the dataset you want 
animate. In this example, it counts 0 to 180 by 20, which are the steps we want to
for surface_anglez.

call loop(0, 180, 20, “surface_anim”)

Now the basic animation is complete. In order to play these frames back with th
Microsoft Windows Media Player, one more format conversion is needed.

To convert from an HDF image sequence to an AVI file, use the following comman

call makeavi(“anim.hdf”, “anim.avi”)

After the macro command., we change the current directory to make sure we can
the file which was just created.

call setdirectory("c:\saved")

Your animation file is now ready to be played. Launch the Media Player applicat
and open the file “anim.avi” to play it back.
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Surface Plot Animation (Macintosh)

In this example, we create a rotating surface plot animation that can be played b
with the View Utility or saved as a PICS file to use with Macintosh's QuickTime
MoviePlayer.

First, you need to create a surface plot for the first frame of the animation; use a
sample dataset. Set up the surface plot the way you want it to appear; for this e
ple, we recommend a framed color surface plot with the following settings: under
Axes tool chooseSurface..., set the Axis Type toLeft Data Axis, and turn off the
Color Bar. Under the Select tool, chooseSurface...andEdit Angles...and set the ori-
entation to X=-50, Y=0, and Z=0.

From your new surface plot window, chooseCreate Macro... and use the name
"Surface_anim" for the macro. Now go toEdit Macro  from the Macro menu, and
edit the macro named "Surface_anim" and make the changes described below.

Scroll through the macro to find the line "surface_anglez = 0" and make it equal
"loop_index". Loop_index is a special reserved variable set up by theloop() com-
mand which we will be using to run the animation.

surface_anglez = loop_index

Now scroll to the end of the macro and add the following linesbefore the
"user_interactive = true" line. Note in thecall setsavefolder() line you need to
change “Harddrive” to the name of your hard drive. Before you can run this mac
you must create a folder on your hard drive called “Saved”. This is where the HD
files will be saved by the macro.

out = "anim"//loop//".hdf"
call setsavefolder("Harddrive:Saved")
call saveas(currentplot, out, 4)
loop = loop + 1
call close(currentplot)

Every time this macro is run, these lines save each surface plot as an image in 
HDF file.

This macro is capable of creating one frame of our animation. We now need to ca
multiple times, once for each frame of the animation. The loop command allows
do just that. It calls any custom macro multiple times. Open the Notebook windo
and make sure it is empty. Enter the following two commands in the Notebook a
chooseCreate Macro from the Macro menu. Call this “RunLoop”.

loop = 0
call loop(0, 180, 20, "Surface_anim")
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In this example, it counts 0 to 180 in increments of 20, which are the steps we wa
use for surface_anglez. Because the loop_index will be 0, 20, 40, ...180 and we
to save the files out as surface0.hdf, surface1.hdf, surface2.hdf... we use anothe
able “loop” that we increment by one, not twenty, to create the file names. The R
Loop macro initializes this variable and executes the loop commands. To execut
macro, chooseRunLoop off the Macros menu.

Now the animation is complete and you have 10 HDF files in the “Saved” folder
your hard drive. In order to play these frames back launch the View Utility, found
the “Transform:Extras” folder, and chooseAnimate From Disk off the File menu.
Browse to the “Saved” folder and chooseCurrent Folder. The View Utility will
open the first file and have the animation buttons at the bottom of the window.

If you want to save the animation to a file format that can be viewed by QuickTim
MoviePlayer, chooseSave Animation As... from the File Menu and enter a file
name. Your animation has now been saved as a PICS file. This PICS file can be
opened in MoviePlayer and converted to a standard movie file.

Advanced Macros

The following provides a summary of the macros located in the ‘Macros\ Advanc
directory. Note that there are lines of code in each of these macros specific to b
Macintosh and Windows platforms. Remove the lines that do not pertain to your
form.

In addition, each macro requires the user to perform several steps to run the ma
It is recommended that you open these text files in a word processor program a
read all of the file before you use them in Transform.

FileLoop.txt

This macro is designed to loop through one directory, and open all of the files tha
in the directory. Then we perform a function on each file, in this case it's a conto
plot, then save each file into a specified directory.

DirLoop.txt

This macro is designed to loop through a series of directories, and open all of the
that are in each directory. After each file is opened, we perform a function on ea
file, in this case it's a contour plot, then save each file into a specified directory.

Tiff to HDF.txt

This macro is designed to loop through one folder and open all of the TIFF files in
The image from the TIFF data is then saved into an HDF file in the specified fol
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OpenSaveLoop.txt

This macro is designed to open all of the files in a directory. Then save each file in
specified directory. This macro is useful for converting non-HDF files to HDF.

ImportMacro.txt

Import macros are useful for importing a series of files that are not automatically
imported into Transform. You may want to create an import macro to use manuall
to incorporate in a loop. All files to be imported must be of the exact same dimens
and type. For example, if you have 30 text column files with the same number o
rows, columns, header lines, etc... you can automate their import into Transform

Matrix-Column.txt

This macro will convert your 2D matrix data into column data. Save your new data
usingSave As... from the File menu and choose "Data in Text Format". This save
your new data file as a scaled matrix. You must then open it in another program (
Excel), and remove the scales. What is left is text column data. If your data has
scales, you would need to add lines of code for the scale values to be used. Th
what it does:

Figure A:

           1 2     3

       1  10   20   30              This is your matrix in Transform

       2  40   50   60

       3  70   80   90

Figure B:

1   2    3                  These correspond to x y and z columns

       1   1   1   10

       2   1   2   40                With the macro language you could create this matrix

       3   1   3   70

       ......................

       8   3   2   60

       9   3   3   90
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In Noesys, save your new Figure B dataset as an HDF dataset. Open that file in
sys. You can now highlight your dataset in Noesys and chooseExport Object... from
the File menu. This exports only the data and not the scales and you would not 
to bring your exported text into another program to remove the scales.

OrderedPairs.txt

These macros allow you to create ordered pairs from two matrices, a and b. The
matrices a and b must be the same size.

matrix a            matrix b

        1  2  3             1  2  3

        4  5  6             4  5  6

        7  8  9             7  8  9

ordered pairs,  matrix c

                  1, 1

                  2, 2

                  3, 3

                  4, 4

                  5, 5  etc....

WinAnimation.txt (Windows only)

This macro is designed to loop through one directory, and open all of the files in
directory. Then we perform a function on each file; in this case it's create an ima
from the data. Then each file is saved as an HDF file into a specified directory. T
HDF file is then converted to an AVI file that can be used with Microsoft Media
Player.

PICSAnimation.txt (Macintosh only)

This macro creates a series of HDF image files that can then be animated using
View Utility, found in the 'Transform:Extras' folder on the Noesys CD. The docu-
mentation for the View Utility is also available on the CD in the ‘Manuals’ folder 
PDF format. These files can be read with Adobe Acrobat Reader, available in th
'Extras:Adobe' folder on the CD or from Adobe Systems Incorporated at
www.adobe.com
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In the View Utility, useAnimate From Disk from the File menu to animate a series
of HDF files and then chooseSave Animation As... to save the animation as a PICS
file. The PICS file can then be read into Apple's QuickTime MoviePlayer as a m
file.

Anim3DData.txt (Macintosh only)

This macro creates a series of PICT image files from a 3D dataset. The files can
be animated using the View Utility, found in the 'Transform:Extras' folder on the
Noesys CD. In View, useAnimate From Disk... from the File menu to animate a
series of PICT files and then chooseSave Animation As...to save the animation as a
PICS file. The PICS file can then be read into Apple's QuickTime MoviePlayer a
movie file.

Printing.txt

These macros can be used to print an image to be 4"x2" and centered on an 11"
page. TypePrintPortrait  andPrintLandscape into a Transform Notebook window
and save them as macros. Depending on whether you would like to print portrai
landscape, simply execute the appropriate macro before creating your image.

Note
If you create your image using an image macro, it is possible that some of the im
macro settings may override the PrintLandscape or PrintPortrait macro settings
avoid this, make sure that the image macro does not use the “image_h”, “image
“image_marginleft”, and “image_margintop” reserved variables. If it does you c
comment them out by adding an asterisk (*) at the beginning of the relevant lin

AutoTran.txt

In Windows, this macro describes how to drive Transform from outside the prog
using standard Visual Basic calls. This example launches Transform, and opens
files and makes a vector plot from those two files.

In Power Macintosh, this file describes how to send commands to Transform us
AppleEvents. See Appendix C for more information.
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This chapter lists and describes the functions, subroutines, and variables that c
used to construct macros.
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Macro Functions Reference

Transform has mathematical and data manipulation functions which return data
arrays and/or scalar values. If the mathematical expression contains an array, th
result will be an array of the same size. If there are no arrays in the mathematic
expression, the result will be a scalar value. In most calculations, all of the array
must have the same dimensions. Note that an expression can contain any num
these functions.

For all functions, the proper syntax to use in the macro language is:

newdataset = function() for functions that create a new dataset.

newvariable = function() for functions that return a scalar variable.

If a function returns an error stating the function requires an array, you may nee
use the subroutinevar().

The subroutinevar() returns the actual dataset (the numbers) from a string repres
ing the datasetname. The subroutinevar() is most commonly used with current-
dataset. Usingvar() allows you to usecurrentdatasetwithin a function that expects
a numerical argument. Without the use ofvar(), the function will return an answer of
zero, because the value of the string represented bycurrentdataset is zero, or an
error stating this function requires an array.

Mathematical Operators

The mathematical operators, in order of precedence, are:

To override the precedence, use parentheses ().

- negation (unary minus)

** exponentiation

* and / multiplication and division

+ addition

- subtraction

// concatenation (of strings)
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Variables Set By Transform

These variables are set by Transform. They are very useful in macros, but shoul
be changed by your macros.

Literals

loop_index Current loop counter. See theloop() function call for
details.

currentplot Name of the most recently created plot. In macros
saved with Create Macro..., this variable is used to
store the name of the new plot.

currentdataset Name of the most recently created dataset. Macros
often use this to refer to the file which was just
opened.

currentfile Name of the file being opened. Used internally for
opening files. It contains the filename during the open
process.

true and
false

These values are used to set other keywords to true or
false.

INF The value for infinity, the largest number which can be
represented in Transform.
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Mathematical Functions

This section provides a list of mathematical functions available in Transform.

Mathematical Trigonometric Functions that Create Arrays or
Return Scalars

The following trigonometric functions are available. They will either create a new
data array or return a scalar value, depending on the argument in the mathema
expression.

sin(q) Sine of the argument (q) in radians.

cos(q) Cosine of the argument (q) in radians.

tan(q) Tangent of the argument (q) in radians.

asin(q) Arcsine of the argument (q), returns radians.

acos(q) Arccosine of the argument (q), returns radians.

atan(q) Arctangent of the argument (q), returns radians between - /2 and
/2.

atan2(q,p) Arctangent of the argument (q/p), returns radians between -  and
.

sinh(q) Hyperbolic sine of the argument (q), in radians.

cosh(q) Hyperbolic cosine of the argument (q), in radians.

tanh(q) Hyperbolic tangent of the argument (q), in radians.

dtor(q) Degrees to radians of the argument (q).

rtod(q) Radians to degrees of the argument (q).
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Mathematical Functions that Create Arrays or Return Scalars

These functions will either create a new data array or return a scalar value, depen
on the argument in the mathematical expression.

Mathematical Functions that Require an Array and Return
Scalars

The following mathematical functions require a single data array as an argument
always return a scalar value.

mod(q,p) Integer remainder of the argument (q/p).

log(q) Natural logarithm of the argument (q).

exp(q) Exponential function of the argument (q).

log10(q) Base 10 logarithm of the argument (q).

pow(q,p) Take the argument (q) to the power (p).

sqrt(q) Square root of the argument (q).

abs(q) Absolute value of the argument (q).

int(q) Integer truncation of the argument (q).

floor(q) Round the argument (q) down to next integer.

ceiling(q) Round the argument (q) up to next integer.

mean(q) Arithmetic mean of the argument (q).

sdev(q) Standard deviation of the argument (q).

min(q) Minimum data value of the argument (q).

max(q) Maximum data value of the argument (q).

sum(q) Sum of all data values of the argument (q).
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Data Manipulation Functions

These functions require at least one data array as an argument, and create a ne
array. In most cases, the resultant array always has the same dimensions as th
array used in the argument.

transpose(q) Transposes (flips diagonally) the data array (q) and
exchanges the row and column numerical scales.

rowflip(q) Exchanges the rows (flips top for bottom), and the corre-
sponding row labels, of the data array (q).

colflip(q) Exchanges the columns (flips left for right), and the corre-
sponding column labels, of the data array (q).

rowdup(q,row#) Creates a new data array where every row is equal to the
value in row number row# of the array (q), where row num-
bers begin with 0. The row and column labels in the new
array will be identical to those in array (q).

coldup(q,col#) Creates a new data array where every column is equal to th
value in column number col# of the array (q), where col-
umn numbers begin with 0. The row and column labels in
the new array will be identical to those in array (q).

shl(q) Creates a new array where the data in array (q) has been
shifted to the left one column. The rightmost column will
be set equal to the previous rightmost column.

shr(q) Creates a new array where the data in array (q) has been
shifted to the right one column. The leftmost column will
be set equal to the previous leftmost column.

shu(q) Creates a new array where the data in array (q) has been
shifted up one row. The bottom row will be set equal to the
previous bottom row.

shd(q) Creates a new array where the data in array (q) has been
shifted down one row. The top row will be set equal to the
previous top row.

rotrows(q,#rows) Rotates the rows in array (q) from top to bottom by #rows.
Copy the bottom rows to the top as they fall off. Negative
numbers move the data up, positive numbers move the dat
down.
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rotcols(q,#cols) Rotates the columns in array (q) from left to right by #cols.
Copy the right side rows to the left side as they fall off.
Negative numbers move the data left, positive numbers
move the data right.

transfer(q,p) Copies array (p) into a copy of array (q) for every cell that
they have in common. The resulting array is the same size
as array (q). This is one of the few functions where the
arguments can be arrays of different size.

colsum(q) Sums each column in array (q) and replaces every elemen
of the column with that sum. Can be used to approximate
an integral in the vertical direction (dy).

colavg(q) Same as colsum, except that the column sums are divided
by the number of elements summed.

rowsum(q) Sums each row in array (q) and replaces every element of
the row with that sum. Can be used to approximate an inte
gral in the horizontal direction (dx).

rowavg(q) Same as rowsum, except that the column sums are divide
by the number of elements summed.

recode(q,n) Replaces all zero values in array (q) with floating point
value n.

zapnan(q,n) Replaces all NAN (Not-A-Number) values in array (q) with
floating point value n.

LEmask(q,#) Returns an array where every element is set to 1 if the cor
responding element in array (q) is less than or equal to #,
and set to 0 if it is greater than #.

LTmask(q,#) Same asLEmask(), but with less than.

GEmask(q,#) Same as LEmask(), but with greater than or equal.

GTmask(q,#) Same asLEmask(), but with greater than.

EQmask(q,#) Same asLEmask(), but with equal to.

NEmask(q,#) Same asLEmask(), but with not equal to.
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Data Manipulation Functions that Require an Array and
Return a Scalar

These functions require an array as an argument, and always return a scalar va

Data Manipulation Functions that Generate Arrays Based on
Analytic Expressions

These functions are useful for generating new arrays based on analytic express

pts(q) Number of points in array (q).

cols(q) Number of columns in array (q).

rows(q) Number of rows in array (q).

colrange(q) Range of column scale values in array (q).

rowrange(q) Range of row scale values in array (q).

colmean(q) Mean of distance between columns in array (q).

rowmean(q) Mean of distance between rows in array (q).

colsdev(q) Standard deviation of distance between columns in array (q).

rowsdev(q) Standard deviation of distance between rows in array (q).

c(q) Returns an array where every number in a column is equal to the
numerical label from array (q) for that column.

r(q) Returns an array where every number in a row is equal to the
numerical label from array (q) for that row.

x(q) Synonym for the function c(q).

y(q) Synonym for the function r(q).

zeros(a,b) Creates an array of (a) columns and (b) rows, where every elemen
in the array is equal to 0.

rand(a,b) Creates an array of (a) columns and (b) rows, where every elemen
is a random number between 0 and 1.

ones(a,b) Creates an array of (a) columns and (b) rows, where every elemen
in the array is equal to 1.
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Advanced Functions

Transform allows you to use these more complex data manipulation features in 
ros, most of which are available on menus.

colscales(q,startval,endval) Returns a dataset of the same size as array (q),
with the same data, except that column scales
are changed to go from startval to endval. The
new scale values are evenly spaced. This macro
is the same as theGenerate Scales command
from the Numbers menu.

fillmissing(q) Does a Fill Missing Data operation on array (q).
Make sure all of the fill_ reserved variables are
set appropriately before calling this function.
Same as theFill Missing Data... command
from the Numbers menu.

frequency(q,n) Creates a histogram of array (q). The function
first divides the number range into n equally
spaced bins, and then counts the number of data
points in the array (q) which fall in each bin.
Returns an array with a single row and n col-
umns containing the counts.

resamplecols(q,n) Resamples array (q) in the horizontal direction,
stretching the array to n columns. To control
resampling options, it uses the current value of
keyword variables resample_type and
resample_scalecol. Same as theResample
Data... command from the Numbers menu.

resamplerows(q,n) Resamples array (q) in the vertical direction,
stretching the array to n rows. To control resam-
pling options,  it uses the current value of
reserved variables resample_type and
resample_scalerow. Same as theResample
Data... command from the Numbers menu.
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rowscales(q,startval,endval) Returns a dataset of the same size as array (q),
with the same data, except that the row scales
are changed to go from startval to endval. The
new scale values are evenly spaced. This macro
will operate the same as theGenerate Scales
command from the Numbers menu.

smooth(q,n) Smooths array (q) using n passes. Same as the
Smooth Data... command from the Numbers
menu.

streamfunction(h,v) Calculates the non-divergent stream function
for velocity components h (horizontal) and v
(vertical). A contour plot of the result gives you
streamlines for the velocity field. This function
works only for 2D, irrotational (no source or
sine), incompressible flows.
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Fast Fourier Transforms

Transform provides a set of functions for dealing with complex variables and Fa
Fourier Transforms.

Complex Numbers

You can create complex arrays using thecomplex(r,i) function. Herer  is an array
containing real values, and i is an array containing imaginary values. The resulting
complex array has twice as many columns as either the real or imaginary arrays
(which must be the same size). The columns alternate real and imaginary numb
For instance, the real array:

and the imaginary array

becomes the combined complex array:

In the list below,c refers to complex arrays (that is, double width arrays that altern
real and imaginary components).

r1 r2 r3

r4 r5 r6

i1 i2 i3

i4 i5 i6

r1 i1 r2 i2 rr3 i3

r4 i4 r5 i5 r6 i6

complex(r,i) Combines the real array (r) and the imaginary array (i),
both of the same dimensions, into a complex array.

real(c) Extracts the real part of complex array (c) and makes a new
array with only the real values.

imag(c) Extracts the imaginary part of complex array (c) and makes
a new array of only the imaginary values.
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If your array does not have dimensions which are a power of 2, you will need to
theResample Data... command to create a new array of the proper size from you
current data.

complexap(a,p) Forms a complex array, given two arrays representing the
amplitude and phase of those complex numbers. The phase
is assumed to be in radians.

ampl(c) Calculates the amplitude of each complex number in the
complex array (c), and returns a real array with just the
amplitude values.

phase(c) Calculates the phase of each complex number in the com-
plex array (c), and returns a real array with just the phase
values, in radians.

fft(c,n) Performs a 2D Fast Fourier Transform on the complex
array (c). The parameter n=1 for a forward transform and
=-1 for an inverse transform. Datasets must be square and
the number of rows must be a power of 2. A square com-
plex dataset has twice the number of columns as it does
rows because every two columns represents one complex
number.

fftrows(c,n) Performs a 1D Fast Fourier Transform on every row of
complex array (c). The parameter n=1 for a forward trans-
form and =-1 for an inverse transform. The number of col-
umns must be a power of 2.

fftcols(c,n) Performs a 1D Fast Fourier Transform on every column of
complex array (c). The parameter n=1 for a forward trans-
form and =-1 for an inverse transform. The number of rows
must be a power of 2. Every pair of columns is processed as
one column of complex numbers.
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Kernel Functions

The following built-in functions approximate the various derivatives. The x derivat
is the slope from left to right, the y derivative is the slope from top to bottom. Fo
details on their exact operation, see Appendix E.

Generic Kernel Functions

Generic kernel operations are implemented with the kernel function:

ddx(q) dq/dx of array (q) - difference from left to right

ddy(q) dq/dy of array (q) - difference from top to bottom

d2dx(q) d2q/dx2 of array (q) - second derivative from left to right

d2dy(q) d2q/dy2 of array (q) - second derivative from top to bottom

lap(q) 5 point laplacian of array (q)

lap5(q) same as lap(q)

lap9(q) 9 point laplacian of array (q)

kernel(q,k) Performs a generic 3x3 kernel convolution on array (q). Array (k)
is the convolution kernel and it must be 3x3.
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Listing Of Macro Subroutines

In the listing of macro subroutines, the following conventions are used; each of th
four namesmust be enclosed in quotation marks when used in macros:

Most subroutines require the use of the word "call" in front of the subroutine. Tho
that do not are presented here with syntax variable =subroutine() where the subrou-
tine returns information into the variable. For all the other subroutines the proper
tax iscall subroutine(). This is also the proper syntax for calling custom macros th
are saved on the Macros menu.

w=image( datasetname )
w=interpolated( datasetname )
w=line( datasetname )
w=contour( datasetname )
w=surface( datasetname )
w=vector( datasetname, datasetname, 0 ) (Power Macintosh only)
w=vector( datasetname, datasetname, Flag ) (Windows only)

if Flag = 0

        1st parameter is horizontal axis

        2nd parameter is vertical axis

     if Flag = 1

        1st parameter is vertical axis

        2nd parameter is horizontal axis

Creates an image window from the datasetdatasetname, using the current
reserved variable values and returns the name of the new window. Executing
these calls is exactly the same as selecting the command from the Image m

datasetname Name of a dataset currently open in Transform (for exam-
ple, "Xvel").

windowname Name of a currently open window (for example,
"Xvel.contour1").

filename Name of a disk file (for example, "XVEL.HDF").

macroname Name of macro listed under the Macros menu.
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w=histogram( datasetname ) (Windows only)

Creates an image window from the datasetdatasetname, using the current
reserved variable values and returns the name of the new window. Executing
of these calls is exactly the same as selecting the command from the Image m

call addaxis( windowname, whichaxis )

Adds axis type whichaxis to windowwindowname. The parameter whichaxis=1
for the X axis, =2 for the Y axis, =3 for the Z (data) axis, and =4 for the Colo
Bar.

call addlabel( windowname, x, y ) (Power Macintosh only)

Adds a contour label at x pixels in and y pixels over from the lower left corner
the image, to windowwindowname (which must be a contour window). Used
internally for saving contour plot labels.

call addscalelabel( windowname, x, y ) (Windows only)

Adds a contour label to the contour level closest to the coordinate (x,y) on th
contour plotwindowname. The x and the y locations for the label are given in
scale coordinates rather than pixels.

call beep

Beeps the speaker once.

call close( windowname )

Closes windowwindowname. If you close the dataset window, all windows
associated with that dataset are closed. An error will occur if you try to close
dataset from the Notebook window associated with that dataset.

call closeall (Windows only)

Same asClose All from the File menu. Can only be executed if saved as a cust
macro and run from the Macros menu. If user_interactive=false, every windo
will be closed without being saved.

call copy( windowname or datasetname )

Copies the data or image in windowwindowname or the selected data in the
datasetdatasetname to the Clipboard. Same asCopy from the Edit menu. Use
with Paste to paste data or create an overlay.

call createcolortable( datasetname, tablename ) (Windows only)
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Converts the datasetdatasetnameto a color table and adds it to the list of custom
color tables with the nametablename. The dataset must have 256 rows and 3
columns. Columns 1, 2 and 3 contain the red, green, and blue components o
color table respectively, with values between 0 and 256.

call deletemacro( macroname )

Deletes the macro macroname from the Macros menu. Does nothing if the na
macro is not found.

call exechdfmacro( filename, macroname )

Executes the macro macroname from the HDF file filename.

call execmacrofile( filename )

Executes a macro from the text filefilename. The entire contents of the text file
are executed as a single macro. Use withsetdirectory() (Windows) orsetfolder()
(Power Macintosh) to specify where the file is located.

call extractselection( datasetname )

The currently selected region of the dataset is extracted to create a new dat
The new datasetname has the same base name with the suffix "_x". Works 
same as theExtract Selection command from the Numbers menu. Use
setselection() to specify which region of data to extract.

s = getdatasetname( windowname )

Returns the dataset name for the dataset window.

n = getfilecount()

Counts the number of files in the current folder. Used for processing sequenc
files with the loop command, or in scripts. This subroutine should be directly p
ceded by thecall setdirectory() (Windows) orcallsetfolder() (Macintosh) sub-
routine. It takes no argument in the ()'s and returns the number of files in the
variable "n" which can then be used in a macro. Syntax example:

call setdirectory("d:\myfolder")  !Windows syntax  or
call setfolder("HardDrive:Folder")  !Macintosh syntax
n = getfilecount()
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f = getnthfilename( filenumber )

Returns the filename for file number filenumber in the current directory/folde
The parameterfilenumber is the number of the file, starting with 1, when they
are arranged in the folder in alphabetical order. Useful for importing a seque
of files from a folder.

s = getvalidname( datasetname ) (Windows only)

Returns a unique name for the given datasetname. Useful in macros to avoid
flicting with existing dataset names.

call loadhdfdataset( filename, reference# )

Loads the dataset record with reference number reference# from the HDF fi
filename. Used internally for opening HDF files.

call loadhdfnotes( filename, dataset#, reference# ) (Windows only)

Given filename, a dataset number, and an HDF reference number, reads an
tation record as Notebook contents to the given dataset. Used internally for o
ing Notebook records.

call loadhdfoverlay( windowname, filename, reference# )

Loads the overlay record with reference numberreference# from the HDF file
filename and places it on top of the image in windowwindowname. Used inter-
nally for opening saved overlays.

call loadpictoverlay( windowname, filename) (Power Macintosh only)

Loads an overlay from the PICT filefilenameand places it on top of the image in
windowwindowname.

call loop( start, stop, increment, macroname )

Executes the macromacronameas the variableloop_indexgoes from the value
start to the valuestop in increments ofincrement. The macro macroname is
executed (stop-start)/increment+1 times. Themacroname must be in double
quotes. The variableloop_index can be used to reference files to be opened o
saved.

call makeavi( filename, aviname ) (Windows only)

Given the name of an HDF file and a name for a new AVI file, read every 8-b
image from the HDF file and create an AVI file with those images. AVI files c
tain animations that may be played back with the Windows Media Player. To
these files with Windows Media Player, the files must end in “.avi”.
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call open( filename )

Opens the disk filefilename, bringing up any datasets and windows which wer
stored in the file. Used both for Transform-saved files and for imported files.
Looks for the file in the current directory/folder. If no file name is given, a dialo
prompts you for the required information.

call paste( windowname or datasetname )

Pastes contents from the clipboard onto the image in the windowwindowname
or the data from the clipboard into the selected region of the data window
datasetname. Same asPaste from the Edit menu.

call pastenew( windowname or datasetname ) (Power Macintosh only)

Pastes an image from the clipboard to create a new dataset called “Untitled
a new image from that untitled dataset. For a dataset, pastes data from the 
board into a new dataset called “Untitled”. Same asPaste New.

s = prompt( promptstring, defaultstring )

Prompts you with the text stringpromptstring  and waits for text input. Returns
the string typed in into the variables. If no changes made, it returns the string
defaultstring. Unless they are variables,promptstring  anddefaultstring need
to be in double quotes.

call saveas( windowname, filename, save_type )

Saves the window windowname to the disk file filename in the current save d
tory/folder. If user_interactive=false, it will overwrite any file of the same nam
without prompting. For types 4, 5, 6, 8, (and additionally 13, 14, and 15 in W
dows), thewindownamemust be the name of the image window (or you can u
currentplot) and not the dataset window. The parametersave_type is:

=0 Prompts the user

=1 Saves data, images, and notebook to HDF file

=2 Saves data only to HDF file

=3 Saves data to text file

=4 Saves image to HDF file

=5 (Power Macintosh only) Saves image to PICT file

=6 Saves image to TIFF file

=7 Appends data, notebook to HDF file
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If you have a Transform HDF File (equivalent to usingsaveasoption 1, or "Data,
Images, Notebook to HDF" from the File menu's Save As dialog) and you app
datasets or images to it usingsaveas option 7, 8, or 13 (Windows), when you
reopen the file in Transform it will only open the dataset, notebook and imag
that were originally saved using the Transform HDF option. If you want the M
tiple Records dialog to appear (allowing you to open all of the datasets or ima
in a file), you must first save the file using HDF Data File (saveasoption 2 or 4),
and then append the datasets or images to that file.

call savecolortable( datasetname, tablename ) (Power Macintosh only)

Converts the datasetdatasetnameto a color table and adds it to the Color Table
menu with the nametablename. The dataset must have 256 rows and 3 column
Columns 1, 2 and 3 contain the red, green, and blue components of the color
respectively (1-255).tablename must be in double quotes.

call savemacro( windowname, macroname )

Creates macromacronamefrom the image windowwindownameand adds it to
the Macros menu. Same asCreate Macro... on the Macros menu.

call setdirectory( directoryname ) (Windows only)

Specifies the directory name and path indirectoryname for opening files. You
can use a full or partial path name with backslash separators.

call setfolder( foldername ) (Power Macintosh only)

Specifies the folder name and path in foldername for opening files.You can u
full or partial path name with colon separators, e.g. “HD80:myfiles:myfolder”.
no folder name is given, a dialog prompts you for the required information.

call setformats( datasetname, string, string ) (Windows only)

Given a dataset name and two Fortran-style format strings, set the data form
the first and the scale format to the second.

=8 Appends image to HDF file

=13 (Windows only) Appends image to HDF file, same size as
image(s) already in file—useful for animations.

=14 (Windows only) Saves image to Windows bitmap

=15 (Windows only) Saves image to Windows metafile

=16 (Windows only) Saves data to raw binary IEEE float file
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call setoverlayrect( windowname, left, top, right, bottom )

Modifies the location of the overlay in the image windowwindowname. The
parameters left, top, right, and bottom refer to the pixel locations of the over
rectangle relative to the upper left corner of the canvas. Normally this call is 
needed, as executing apaste call will automatically set the overlayrect to match
the image. Used internally.

call setnames( datasetname, newdataname, newxname, newyname )

Changes the name of datasetdatasetnameto newdataname, and changes the X
axis and Y axis scale names tonewxname andnewyname respectively. If an
empty string ("") is passed a parameter, that name is not changed.

call setsavedirectory( directoryname ) (Windows only)

Specifies the directory name and path indirectoryname for files saved with
saveas. You can use a full or partial path name with backslash separators.

call setsavefolder( foldername ) (Power Macintosh only)

Specifies the folder name and path in foldername for files saved with saveas
You can use a full or partial path name with colon separators. For example,
"HD80:myfiles:myfolder". If no folder name is given, a dialog prompts you fo
the required information.

call setselection( datasetname, left, top, right, bottom )

Sets the selection region for dataset datasetname. The parameters left, top,
and bottom refer to the row and column index numbers of the dataset, starti
with 0,0 for the upper left corner. All windows for this dataset are updated, an
Synchronize is turned on, all matching datasets also update.

d = var( windowname )

Returns the dataset from a string representing thedatasetname or awin-
downame. The subroutinevar( ) is most commonly used withcurrentdataset.
Consider the following example:

sinx = sin(var(currentdataset))

Since the function sin expects a numerical argument,var ( ) is used to convert the
string in currentdataset to the actual data. A new dataset named 'sinx' is cre
such that each element in 'sinx' is the sine of the corresponding element incur-
rentdataset. Without the use ofvar ( ), thesin function would return an answer
of zero, since the value of the string represented by currentdataset is zero.
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Macro Variables Reference

Listed here are the reserved variable names for use in Transform macros. Thes
reserved variables are used by the macro subroutine calls, listed earlier in this c
ter.

Values for all variables are stored as ASCII strings which may be up to 255 charac
in length. When a numeric value is required by Transform, the string is converted
a number. A value of 0 is returned if the field does not start with a number. Many v
ables need to be set to the string "true" or the string "false". You can instead use
reserved variablestrue andfalse.

Transform Reserved Variables

axis_auto=true

When =true, Transform automatically calculates the axis labels, format, and
spacing, and overridesaxis_labelspacing, axis_min, axis_max, axis_labelmin,
axis_labelmax and text_format. When =false, those same parameters are us
to calculate the axis labels.

axis_autospacing=true

When =true, Transform automatically calculates the label spacing (incremen
and overrides axis_labelspacing. When =false,axis_labelspacing is used to cal-
culate the label spacing.

axis_autotextformat=true

When =true, Transform automatically calculates the printing format for axis
labels, and overridestext_format. When =false,text_format is used to set the
printing format.

axis_colorbarh=254 (Windows only)

Specifies the width, in pixels, of the color bar on color images and plots.

axis_colorbarv=24 (Windows only)

Specifies the height, in pixels, of the color bar on color images and plots.

axis_gridlines=true

When =true, Transform draws gridlines on the plot. Gridlines are drawn from
each major tick to the opposite side of the plot. When =false, no gridlines ar
drawn.
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axis_labelinterval=5

Number of intervals between labels on the axis. Labels are spaced to form
axis_labelinterval intervals betweenaxis_labelmin andaxis_labelmax.

axis_labelmax=3.14

End of label range, in data or scale units. Labels are drawn starting at
axis_labelmin and ending ataxis_labelmax. They may be clipped byaxis_min
andaxis_max. If axis_labelmax is less thanaxis_labelmin the labels decrease
in value along the axis.

axis_labelmin=0.0

Start of label range, in data or scale units. Labels are drawn starting at
axis_labelmin and ending ataxis_labelmax. They may be clipped byaxis_min
andaxis_max. If axis_labelmax is less thanaxis_labelmin the labels decrease
in value along the axis.

axis_labelspacing=0.5

Distance between axis labels, in data units.

axis_majorlength=8

Length of a major tickmark, in pixels.

axis_majorticks=2

Number of major tickmarks per label interval. Ifaxis_majorticks=1, then a
major tick is placed at every axis label.

axis_majorwidth=1

Width of a major tickmark, in pixels.

axis_max=3.14

End of the axis in scale units. No tickmarks and labels appear beyond this v

axis_min=0.0

Start of the axis in scale units. No tickmarks and labels appear before this v

axis_minorlength=8

Length of a minor tickmark, in pixels.
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axis_minorticks=2

Number of minor tickmark intervals per major interval. Ifaxis_minorticks=5,
then four minor ticks are visible between each two major tickmarks. If
axis_minorticks=1, then the minor ticks are each obscured by a major tickma

axis_minorwidth=1

Width of a minor tickmark, in pixels.

axis_mirror=true

When =true, two sets of axes are drawn. The axes are drawn on both sides o
image when vertical axes are being drawn, or above and below the image w
horizontal axes are being drawn.

axis_tickinout=2

Direction to draw both major and minor tickmarks:

axis_title="X axis"

Title to display on the axis.

color_lowoutlier=1 (Windows only)
color_highoutlier=254 (Windows only)

These variables specify the color index number (0-255) used for outliers. Us
for black; 255 for white.

color_max=254
color_min=1

Lowest and highest color index number (0-255). When you are creating colo
images, data is scaled to the colors between the color indicescolor_min to
color_max. Usually,color_min=1 andcolor_max=254; 0 and 255 are normally
reserved for black and white, respectively.

=1 Inward ticks

=2 Outward ticks

=3 Both inward and outward ticks
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color_scalemax=3.14 (Power Macintosh only)
color_scalemin=0.0 (Power Macintosh only)

The highest and lowest data values; used for converting data values to colo
Usually overridden bydata_min anddata_max, except in special plots (surface
plots with a separate color variable).

color_scaling=0 (Windows only)

Specifies method of scaling values to colors:

color_table="Rainbow"

Name of the color table to use from the ColorTables menu.

color_variable="Density"

Name of the dataset to base colors on. When you are using a primary dataset
surface plot (e.g., surface height) and a secondary dataset (e.g., surface co
indicates the name of the secondary dataset.

contour_autolevels=7

Number of automatic, equally spaced contour levels. Used when
contour_list="auto"  and in the Contours dialog.

contour_color=true

When =true, Transform draws contour lines in a color that depends on the d
value for each line. When =false, all lines draw in black. Same as the color l
setting in the Contour Levels dialog.

contour_dashlines=true

When =true, Transform draws some contours as dashed lines. Lines represe
data values less thancontour_dashsplit are dashed, others are solid. When
=false, all lines are solid. Same as the dashed lines setting in the Contour L
dialog.

=0 Automatic selection

=1 Linear (appropriate for scientific data)

=2 No scaling (appropriate for image data)
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contour_dashsplit=0.0

If contour_dashlines=true, then contour lines below the value
contour_dashsplit are drawn as dashed lines. Same as the dashed line valu
Contours.

contour_highres=true

When =true, Transform draws contours in higher resolution. Same as the hi
resolution setting in the Contours dialog.

contour_list="0:100@10"

Explicit list of contours to draw. The list may contain a comma-separated list
numbers or contour ranges. Whencontour_list="auto", then Transform picks the
contours, usingcontour_autolevels to set the number of contours. See the con
tour chapter for details on the format. Same as the contour list in the Contou
Levels dialog.

contour_smoothline=true

When =true, Transform draws contours with Bezier-smoothed curves. Same
the smooth lines for Contours.

contour_textfont="Courier" (Power Macintosh only)

Font for contour labels.

contour_textformat="F8.2"

Printing format for contour labels.

contour_textsize=10 (Power Macintosh only)

Text size for contour labels, in points.

contour_textw32font="Courier New,NoBold,10" (Windows only)

Font for contour labels.

data_autominmax=true

When =true, Transform calculates the data minimum and maximum automa
cally, and overrides thedata_min anddata_max settings.

data_max=3.14
data_min=0.0

The highest and lowest data values; used for converting data values to colo
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data_xname="x axis" (Windows only)
data_yname="y axis" (Windows only)

Names of X and Y axes; identical to the rows and cols fields in the Attributes
log.

file_directory (Windows only)

Name of the current directory for opening files. See thesetdirectory subroutine
for details.

file_savedirectory (Windows only)

Name of the current directory for saving files. See thesetsavedirectory subrou-
tine for details.

file_folder (Power Macintosh only)

Name of the current folder for opening files. See thesetfolder subroutine for
details.

file_savefolder (Power Macintosh only)

Name of the current folder for saving files. See thesetsavefolder subroutine for
details.

fill_equal=1

Parameter used for defining missing data values and also for defining a bac
ground fill value when converting column files to matrix files:

fill_function=2

Parameter designating data value range of influence. Used by the Kriging a
weighted fill interpolation methods:

=1 if missing data values are equal to fill_value

=2 if missing data values are greater than fill_value

=3 if missing data values are less than fill_value

=1 for linear (1/r) distribution function

=2 for spherical (1/r^2) distribution function

=3 for exponential distribution function

=4 for Gaussian distribution function
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fill_krignugget=0.0

The Kriging Nugget value. See the Kriging section for more information.

fill_krigcolrange=1

The Kriging column range of influence, in data units. See the Kriging section
more information. This reserved variable cannot be set to zero. If so, it will b
changed to 1 before being executed.

fill_krigrowrange=1

The Kriging row range of influence, in data units. See the Kriging section for
more information. This reserved variable cannot be set to zero. If so, it will b
changed to 1 before being executed.

fill_krigsamples=50

Maximum number of samples per Kriging operation.

fill_krigsill=1.0

Kriging sill factor.

fill_krigvarmatrix=true

When =true, Transform produces a variance matrix in addition to the filled ma
after Kriging.

fill_linear=1

Parameter for linear interpolation. Same as the linear interpolation option in
Fill Missing Data dialog.

=1 for interpolate along rows and columns

=2 for interpolate along rows only

=3 for interpolate along columns only
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fill_method=1

Parameter for selecting fill missing data method. Matches the selections from
Fill Missing Data dialog. Used for thefillmissing() notebook function.

fill_preserve=false

When =true, Transform preserves valid data values while filling missing data.
get smoother output, setfill_preserve=false. Only used with weighted fills.

fill_range=4

Size of the region of influence for filling missing data, in row and column units.
fill_range=0, a default value is calculated and used. When using the Kriging
method, the variablesfill_krigcolrange  andfill_krigrowrange  are used instead.

fill_value=-99

Missing data value. Along withfill_equal, specifies the range of missing data
values (and therefore the range of valid data values).

histogram_color=true (Windows only)

When =true, a histogram appears in color; when =false histogram appears i
black-and-white.

image_axes=true

When =true, Transform adds axes to a plot or image; when =false axes are 
included.

image_canvash=640
image_canvasv=480

Size of the window's background canvas in pixels. The default value is the siz
the main display. Also found in the Preferences dialog.

=0 Do not interpolate missing data

=1 for interpolation using nearest neighbor

=2 for interpolation using Kernel smoothing

=3 for interpolation using linear interpolation

=4 for interpolation using weighted fill

=5 for interpolation using Kriging
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image_frame=true

When =true, Transform draws a frame around the plot.

image_v=300
image_h=400

The image size, in pixels. Same as the Image Size dialog.

image_marginleft=0
image_margintop=0

The position of the upper left corner of the image, relative to the upper left cor
of the canvas, in pixels.

image_title="Plot title"

Title for the plot. This title appears centered, above the plot.

import_3d=true

When =true, the file being imported is flagged as a 3D file. When =false, the
is flagged as a 2D file.

import_3daxis=1

Parameter used when importing 3D files to specify axis direction. Ignored un
import_3d=true.

import_3dslices="20,22,23"

List of 2D slices to import from a 3D file. Ignored unlessimport_3d=true. See
the section on the Select Slices dialog for information on the format.

import_byteswap=true

When =true, Transform swaps bytes when reading data. See the data impo
tion for more information.

=1 for importing slice in XY plane

=2 for slice in XZ plane

=3 for slice in YZ plane
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import_colautoscale=true

When =true, Transform calculates the column minimum and maximum value
automatically, overriding the parametersimport_colxmin, import_colxmax,
import_colymin, import_colymax, data_min and data_min. When =false,
those same parameters are used to calculate the column x, y, and data minim
and maximums.

import_coldatacols="3,4,5"

Indicates which columns to import as data columns. See the Data Import se
for more information.

import_coldelim=false

When =true, Transform treats every delimiter as a new column. Same as ch
ing Strict Delimiters during import. When =false, you can have multiple delim
ers (spaces, commas, tabs) between columns.

import_colfixedchar="1:4,5:10,11:15"

Specifies the character positions of the columns when import_delimiter=7 (fi
character positions). Each column is specified by a starting character and e
character position, separated by a colon. Same as choosing Fixed Fields du
import.

import_colplacement=3

If two import data values will be placed in the same location in the target matr
this parameter specifies how to handle the situation:

import_coltargetx=61
import_coltargety=41

Size of the target matrix when converting column data to matrix data. The par
eterimport_coltargetx is the number of columns in the target matrix,
import_coltargety is the number of rows.

import_coltitles=true

When =true, the last line of the header contains the column names (for text 
umn import only).

=1 for replacement of the previous value at the matrix location

=2 for summing all values at the same matrix location

=3 for averaging all values at the same matrix location
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import_colx=1

Specifies the column number that contains the X locations.

import_colxmin=0.0
import_colxmax=3.14

Specifies minimum and maximum values in the column used for the X locatio
Data values with X locations outside this range are ignored. Points inside th
range are positioned in the target matrix betweenimport_colxmin on the left and
import_colxmax on the right. Ifimport_colautoscale=true, these parameters
are ignored.

import_coly=1

Specifies the column number that contains the Y locations.

import_colymin=0.0
import_colymax=3.14

Specifies minimum and maximum values in the column used for the Y locatio
Data values with Y locations outside this range are ignored. Points inside th
range are positioned in the target matrix betweenimport_colymin on the top and
import_colymax on the bottom. Ifimport_colautoscale=true, these parameters
are ignored.

import_delimiter=3

Specifies how text columns are delimited:

=0 for columns separated by tabs only

=1 for columns separated by spaces only

=2 for columns separated by commas only

=3 for columns separated by tabs or spaces

=4 for columns separated by tabs or commas

=5 for columns separated by spaces or commas

=6 for columns separated by tabs, spaces, or commas

=7 for columns in fixed locations specified by import_colfixedchar
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import_dimcolumns=100
import_dimrows=80
import_dimlayers=70

Specifies the size of the import 2D or 3D matrix or column file. The paramet
import_dimlayers is ignored unlessimport_3d=true .

import_filetype=1

This macro is only necessary foruser_interactive = false. Parameter specifying
the type of import file:

=0 for file type not specified (the default case)

=1 for HDF files

=2 for HDF files saved with Transform

=3 for HDF VSET files

=4 (Power Macintosh) for PICT files

=5 (Power Macintosh)for PICS files

=6  for TIFF files

=7 for FITS files

=8 for binary matrix files

=9 for binary column files

=10 for binary PBM files

=12 for MATLAB files

=13 (Power Macintosh) for XWD files

=14 for GIF files

=15 for ASCII Text matrix files

=16 for ASCII Special files

=17 for ASCII Text matrix files with scale information

=18 for ASCII column files

=19 (Windows) for ASCII PBM files

=20 (Windows) for Bitmap files
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import_flipcols=false

When =true, Transform flips the columns left for right when importing files.
Same as using thecolflip() function on your imported dataset.

import_fliprows=false

When =true, Transform flips the rows up for down when importing files. Same
using therowflip()  function on your imported dataset.

import_transpose=false

When =true, Transform flips the data array diagonally when importing files.
Same as using thetranspose()function on your imported dataset.

import_numtype=1

Parameter specifying the number type in a binary file:

import_record="5,6,7,10"

Specifies which records to read from a multi-record file.

import_skip=0

For text files, specifies the number of lines of text to skip before reading data.
binary files, specifies the number of bytes to skip before reading data.

lineplot_lock=false

When =true, Transform will not update the lineplot when the selection region
changes. When =false, the lineplot will be updated when the selection regio
changes.

=1 for signed 8 bit byte

=2  for unsigned 8 bit byte

=3 for signed 16 bit integer

=4 for unsigned 16 bit integer

=5 for signed 32 bit integer

=6  for unsigned 32 bit integer

=7 for IEEE 32 bit floating point

=8 for IEEE 64 bit floating point

=9 for VAX/VMS 32 bit floating point
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lineplot_number=4

Specifies which row or column index number to plot on a lineplot.

lineplot_vertical=false

When =true, the lineplot is drawn from a column of the 2D data array. When
=false, the lineplot is drawn from a row of the 2D data array.

line_dashlength=5

Length of dashes in a dashed line, in pixels. Only used when drawing dashe
lines.

line_width=1

Width of drawn lines, in pixels. Used for line graphs, contours, axes, and the p
frame. Note that you can setline_width to fractional values such as 0.4, to pro-
duce very fine lines when printing to high-resolution output devices.

polar_radius=150  (Power Macintosh only)

Size of polar plot contents, from center to edge, in pixels. The largest radius v
(row scale) is scaled to this size when plotted on the screen. The parameter
image_v andimage_h control the overall size of the plot, but the contents are
drawn to the scale specified inpolar_radius.

polar_view=“200,-200,200,200”  (Power Macintosh only)

Defines the viewing area of a polar plot in pixels, where 0,0 is the center of t
polar coordinates.

polar_zeroangle=0  (Power Macintosh only)

Parameter specifying the coordinate system for polar plots.
=0 for east, =1 for south, =2 for west; =3 for north being the direction of the
angle 0.0.

pref_aspectratio=false

When =true, images are initially generated with the same aspect ratio as the
of the dataset array. When =false, images are initially generated with the siz
image_h by image_v.
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pref_maxnumber=INF
pref_minnumber= -INF

Specifies the largest and smallest legal numbers. All values outside this rang
assumed invalid, so they are left out of max/min calculations, etc. Note:INF rep-
resents infinity.

pref_textformatdata="F8.1"

Specifies the printing format used for the data values in all new data window
Also found in the Preferences dialog.

pref_textformatscales="F5.1"

Specifies the printing format used for the scales in all new data windows. Al
found in the Preferences dialog.

pref_textfont="Courier"  (Power Macintosh only)

Specifies the default font for all new windows; also found in the Preferences
log.

pref_textsize=10  (Power Macintosh only)

Specifies the text size, in points, for all new dataset, image and Notebook w
dows. Also found in the Preferences dialog.

pref_textw32font="Courier New,NoBold,10"  (Windows only)

The preferred default font for all new windows; may also be set using theFont...
command under the Preferences submenu of the Edit menu.

pref_windowh=200

Width of new windows.

pref_windowv=200

Height of new windows.

print_cropmarks=true  (Windows only)

When true, Transform places cropmarks on multi-page printouts for alignme
assistance.
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print_marginleft=1  (Windows only)
print_marginright=1  (Windows only)
print_margintop=1  (Windows only)
print_marginbottom=1  (Windows only)

Specify page margins, in inches, as measured from border of printable area
page.

print_pageheaderleft=" "  (Windows only)
print_pageheaderright="&n"  (Windows only)
print_pagefooterleft="&d"  (Windows only)
print_pagefooterright="Page &p of &P"  (Windows only)

Parameter specifying text page headers and page footers to be printed. The
lowing special symbols will be expanded as each page is printed:

resample_scalecol=0

When =0, columns are resampled to a linear scale. When =1, columns are re
pled on a logarithmic scale.

resample_scalerow=0

When =0, rows are resampled to a linear scale. When =1, rows are resample
a logarithmic scale.

&d date MMM DD YYYY

&D date DD MMM YYY

&n or &N dataset name

&p page number

&P total number of pages

&t or &T the total number of pages

&w or &W name of the window

&& &
Macro Variables Reference Transform Part 3: Reference Manual
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resample_type=0

Parameter specifying the resampling method when resampling to a larger si
Parameter is ignored when resampling to a smaller size.

surface_anglex=-50.0
surface_angley=0.0
surface_anglez=45.0

Rotation angles, in degrees, specifying the orientation of the surface plot. W
bothsurface_anglex=0 andsurface_angley=0, then the surface plot Z axis (the
axis perpendicular to the plane of the surface plot) points toward you out of 
screen. A positivesurface_anglex tilts the Z axis downward, a positive
surface_angleytilts the Z axis to the right. The parametersurface_anglezspeci-
fies the rotation of the surface plot around the Z axis.

surface_averagecolors=true

When =true, Transform averages the four corner data points to calculate the c
used on color surface plots. When =false, the upper left corner data point is
to calculate the color.

surface_axistype=4

Parameter specifying surface plot axis configuration.

=0 for bilinear interpolation

=1 for biquadratic interpolation

=2 for bicubic interpolation

=1 for surface plot only, no axes

=2 for row, column and data axes originate at origin

=3 for row, column axes at front, data axes on left

=4 for row, column axes at front, data axes on right

=5 for row, column axes at front, data axes on left and right
Transform Part 3: Reference Manual Macro Variables Reference
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surface_backstop=255

Parameter specifying the color of the surface backstop:

surface_backstopline=false

When =true, Transform draws lines from each data axis major tick mark alon
surface backstop walls. Ignored ifsurface_backstop=-1.

surface_linemaxcol=25
surface_linemaxrow=25

Parameters specifying the maximum number of lines to draw for the row and
umn axes on the surface plot. The lines are always spaced an integer skip
between data rows and columns, so the actual number of lines drawn is often
than the maximum.

surface_linescol=true
surface_linesrow=true

When =true, Transform draws lines along the columns and/or rows. At least
of the two must be =true. If both are =true, you will see a ‘mesh’ surface plo

surface_offseth=50
surface_offsetv=50

Specifies the horizontal and vertical offset of the center of the surface plot fr
upper left corner of the window, in pixels.

surface_parallax=5.0

Parameter specifying the surface plot parallax.

surface_sizex=110
surface_sizey=110
surface_sizez=85

Specifies the size of the X, Y, and Z axes of a surface plot, in pixel units. Th
actual lengths of the axes are smaller due to the 3D projection.

= -1 for no backstop at all

= 0 for a white backstop

= 255 for a black backstop

= 1 to 254 for the color index from current color table

= 256 for gray
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surface_skirt=0

Parameter specifying the color of the surface skirt:

surface_type=1

Parameter specifying the type of surface plot. Same as the surface option me
the surface plot selection tool.

text_format="F8.1"

Specifies the number printing format. Used for numbers printed as axis labe

text_font="Courier" (Power Macintosh only)

Specifies the font name used for displaying text. Used when producing image
specify the font for labels and titles.

text_size=12 (Power Macintosh only)

Specifies the font size, in points. Used when producing images to specify the text
for labels and titles.

text_w32font="Courier New,NoBold,10" (Windows only)

Default font used for all windows created whenuser_interactive=false, such as
during the execution of a macro.

= -1 for no skirt at all

= 0 for a white skirt

= 255 for a black skirt

= 1 to 254 for the color index from the current color table

= 256 for gray

=1 for a wireframe surface plot (no hidden line removal)

=2 for a black&white surface plot (hidden line removal)

=3 for a high resolution black&white surface plot

=4 for a color surface plot (no grid lines)

=5 for a framed color surface plot (grid lines)

=6 for a high resolution framed color surface plot
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user_interactive=true

When =true, dialogs are allowed. For example, executing acall contour('Xvel')
whenuser_interactive=true will cause the contour dialog to appear. When
=false, no dialogs are displayed, and the keywords defined here are used to c
the plots. The parameteruser_interactive is usually set to false for complex
macros. When using calculate from notes, note thatuser_interactive is set to
true before the macro commands execute. In fact, each time you execute a 
command or use a command key combination, Transform sets
user_interactive=true.

vector_arrowtype=1

Parameter between 1 to 6 specifying the type of arrow for vector plots. The 
lowing represents Windows parameters:

vector_max=3.14
vector_min=0.0

The minimum and maximum vector magnitudes in a vector plot, in data unit
Vectors with a magnitude less than vector_min or greater thanvector_max are
omitted from the vector plot. A vector with a magnitude ofvector_max will be
exactlyimage_h/vector_number pixels long, ifvector_scale=1.0.

vector_number=22

Parameter specifying the number of arrows across for a vector plot. The num
of arrows vertically is calculated automatically so that the horizontal and verti
arrow spacing is identical.

vector_scale=1.0

Parameter specifying the maximum length of vectors. The maximum vector
length isvector_scale*(image_h/vector_number) pixels long.

=1 for scaled arrow with black head

=2 for scaled arrow with white head

=3 for fixed black head with scaled tail

=4 for fixed circle with scaled tail

=5 for scaled wedge

=6 for plain scaled arrow
Macro Variables Reference Transform Part 3: Reference Manual
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Transform provides extensive support for printing dataset windows, Notebook w
dows, and the image and plot graphic windows. Image windows are printed as t
are displayed; the entire contents of a window, from image to annotation to over
plots, are printed just as they are displayed on the screen.
Transform Part 3: Reference Manual 345



346 Chapter 24: Printing

pen
is
ter

ur
e of
Printing in Transform for Windows

Before printing, you must select and configure a printer from the list of printers
installed on your Windows system.

To do so, select thePrinter Setup... command from the File menu. You will see a
dialog similar to the one shown below.

Print Setup Dialog

Printer

The Printer field lists the currently selected printer, its status, type and location. O
the drop-down list to choose from other printers configured on your system. If th
list is empty or does not list a printer you wish to use, install or configure the prin
using the Printers program in the Windows Control Panel; please refer to the yo
Windows documentation for additional information. You may also select the rang
pages you would like to print and the number of copies to be made.

To change printers or paper attributes, press theProperties button. You will see a
Print Properties dialog similar to the one shown below.

Figure 24-1: Print Dialog
Printing in Transform for Windows Transform Part 3: Reference Manual
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This dialog is tailored to the currently selected printer and to your version of Win
dows. Therefore, its content may vary considerably from that shown above.

Paper

Use the settings in this area to select the paper size on which you want to print an
the paper source.

Orientation

Lets you specify whether or not you want the pages to be printed portrait or lands
oriented.

Figure 24-2: Print Properties Dialog
Transform Part 3: Reference Manual Printing in Transform for Windows
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Page Setup

When you print a Transform window, it will be paginated if necessary. The Page
Setup dialog, available from thePage Setup... command on the File menu, lets you
select page margins and optional header and footer text.

Page Margins

The four page-margin fields give you complete control over the size and placeme
text and graphics on the printed page. These values are specified in inches, and
relative to the printable area of the page as reported by the printer driver. Therefo
you have exact page placement requirements, you will need to decrease your ma
to compensate for the unprintable region.

Page Headers and Footers

Transform also allows you to specify header and footer text to appear at the top
bottom of each page of your output. Vertically, headers and footers are placed ju
outside the margin; they are suppressed if the corresponding vertical margin is 
than the height of the selected font. Horizontally, they are placed just inside the 
gin and are justified to the outside.

The header and footer text may be set to any text or phrase of your choosing, o
be empty. Transform allows you to specify the following special tokens that will 
replaced as each page is printed:

Figure 24-3: Page Setup dialog
Printing in Transform for Windows Transform Part 3: Reference Manual
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Use of any other character following an & is reserved for future use.

Print Preview Command

Selecting thePrint Preview command from the File menu shows the data, image
attribute window at a reduced size so you can adjust the layout before you print
Tools on the preview window let you print, view subsequent or previous pages, 
two pages side by side, and zoom in or out of the window.

Token... Replacement ...

&d date MMM DD YYYY

&D date DD MMM YYY

&n or &N dataset name

&p page number

&P total number of pages

&t or &T page number

&w or &W total number of pages

&& the total number of pages
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Print Command

Selecting thePrint  command from the File menu will open the Print dialog shown
below.

Figure 24-4: Print Preview Window

Figure 24-5: Print Dialog
Printing in Transform for Windows Transform Part 3: Reference Manual
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Printer

Same as described for the Print Setup dialog above, with the addition of a Print
File option.

Print Range

The buttons under Print Range let you choose to print all pages, to limit output t
range of pages. Other options in the Print dialog will vary by printer.

The first time that you invoke the Print dialog during a Transform session, the def
settings for the default system printer will appear.

Copies

Allows you to specify the number of multiple copies of the document you would li
to print.

SelectingOK  in the Print dialog prints the contents of the frontmost window. The
details of printing the various window types (data, text window, etc.) are given in
next section. While the window is being printed, the following dialog will be visib
and will show progress on a page-by-page basis.

Interrupting or Aborting a Print

To abort the printing process, press theCancel button on this dialog. It may take a
moment for the abort signal to terminate processing, since it is checked at the b
ning and ending of each page.

(If the output was queued to Windows Print Manager (the default), it may be abo
or cancelled; see the Print Manager documentation that came with your Window
system.)

Figure 24-6: Print Progress Dialog
Transform Part 3: Reference Manual Printing in Transform for Windows
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Printing in Transform for Macintosh

This chapter provides an overview of printing from Transform to LaserWriters an
EPS files. Although printing to non-Laserwriters is usually very similar, you may
need to refer to your printer manual to take full advantage of all of the options a
able. It is best to print color images on a color printer, but black and white printe
such as the Laserwriter can produce reasonable grayscale printouts of your ima

Page Setup

To setup your printer, selectPage Setup... command from the File menu. If you are
using a Laserwriter, you will see the dialog shown in the figure below. If you are
using a Laserwriter, your dialog may be different.

Use this dialog to change the orientation of the paper or set an expansion facto
percent reduction field may be used to reduce (or enlarge) the entire plot by a per
age factor where 100% is the same size plot as you see on your screen.

The Print... Command

SelectingPrint... from the File menu prints the contents of the front-most window
Live images are printed actual size in the same position relative to the paper as
are placed relative to the canvas.

Figure 24-7: Page Setup...Dialog
Printing in Transform for Macintosh Transform Part 3: Reference Manual
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If you are using Apple's Laserwriter drivers, you will see the dialog in the figure
below. The version number printed in the upper right corner of the dialog must be
or greater for grayscale printing. If you are not using a Laserwriter, your dialog m
be different.

To print to an EPS file, selectFile from the Destination pop-up menu. This will open
an additional dialog that lets you specify the format.

Interrupting a Print

Command-period halts the printing process at the end of the page in process. O
page of graphics takes a long time to print, so the interrupt request may not take e
immediately.

Selected Regions

ThePrint... command prints the entire window contents and ignores the selectio
region. To print only the contents of the selection region, first useExtract Selection
from the Numbers menu to create a new data window. Generate a new image win
if necessary, then print from the new window.

Choosing the Printing Font

The font for printing matches the font and size used in the window. For data and n
book windows, the font and size are specified in the Preferences dialog. For con
and axis labels, the font and size are specified from menus in the Labels and Ax
tools.

Figure 24-8: Print Dialog
Transform Part 3: Reference Manual Printing in Transform for Macintosh
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Positioning the Image on the Page

The image canvas corresponds to the paper the image is printed on. New imag
always start out in the upper left corner of the canvas, so on paper they print in 
upper left corner of the page. Use the Size tool and Overlay tool to position the im
and overlay on the canvas, or use the Printing.txt macro from the Advanced Ma
section of Chapter 22.

If your monitor has 72 dots per inch (typical for Macintosh monitors), your printe
image will be exactly the same size as the screen image (unless you have chang
percentage enlargement in the Page Setup dialog). Transform always assumes
every pixel is 1/72 of an inch in size.

Setting Line Width

All Transform plots support the line_width setting to refine line thickness on prin
outs. Before you create your plot, or in the Preferences macro, set the reserved
able line_width to the desired line thickness, in fractions of a point. We have see
good results setting the thickness to 0.4 points.
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Printing Windows

Printing from dataset, image, and notebook windows is described below.

Printing Dataset Windows

The number of rows and columns of text that will fit on a page is determined by 
parameters set using thePrint Setup... command. Transform prints the contents of
the window in spreadsheet-like fashion, left-to-right and top-to-bottom. The scal
values are printed to the left of each row and above each column.

When multiple pages are required in Windows, the scale values are repeated on
page. To aid in viewing, a separator line is drawn between the scale values and
dataset values. Separator lines are also drawn between every five rows and col
If the print range was set to Selection in the Windows Print dialog, Transform wi
only print the rows and columns in the selection region.

In Power Macintosh, pages are printed with the name of the dataset, page num
and a borderline along the top and left of the data array. Independent scale value
printed on each page so that multiple pages may be aligned. In addition, Transf
always prints all the numbers in a data window, not just the visible window or th
selection region. This can easily add up to many pages, so double-check the siz
your dataset before printing.

Note
It is strongly recommended that you select a fixed width font, such as ‘Courier
‘Courier New’, so that decimal points line up properly.

Printing Notebook Windows

The entire contents of the notebook are printed by default. If, however, you enab
Selection under Print Range in the Printer Setup dialog, only the highlighted reg
of the Notebook will be printed.

In Power Macintosh, the Notebook prints with line breaks set up to match the sc
appearance. The contents of the Notebook are paginated and the pages are num
The font and size match the font and size set up for the window on the screen.
Transform Part 3: Reference Manual Printing Windows
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Printing Image Windows

The size and placement of most image window types—raster, interpolated, line,
tour, vector, and histogram—is determined by the image size and margin setting
the Resize tool. For an overlay it is determined by the settings on the Overlay to

On the screen, the size and margin refer to screen pixels. On paper, these are i
preted aspoints (1/72 inch). For example, an image of size 216 x 216 will appear
exactly 3 inches square on paper. The image margins specify an offset from the
margins for the upper-left corner of the image area. The vertical axis and any ot
annotations are drawn in the margin area.

Printing Surface Plot Windows

Surface plots (except for wireframe) are drawn as a map of filled polygons. Draw
always takes place back-to-front so that the hidden lines in the rear are obscured
best results, it is recommended that you select Hi-res Black & White or Hi-res Co
Surface before printing your surface plots.

Surface plots are placed on the page so that the upper-left corner of the window a
with the top-left margin of the page.

In Power Macintosh, in the lower left, the dataset name is printed along with the
names of the independent variables, like the raster plots.

Since polygon filling takes a long time at high resolution, surface plots are usua
easier to manage as bitmap representations rather than as series of overlappin
gons. In the Power Macintosh Print dialog, Transform provides a Print Bitmap ch
box for your selection. Turn the checkbox on or off before clickingOK . Printouts of
the bitmap can be 4 to 10 times faster than the high resolution filled polygons, bu
not as detailed.

Printing Vector Plots

Vectors on a vector plot are drawn as line segments, sometimes using a polygo
filled polygon for the arrow head. Vectors are calculated and drawn at the highe
printer resolution available.

Printing with Overlays

After the base image is printed, any overlay present for that image is printed. Th
overlay is positioned on the page with the same offset and same relative size as
present in the image window.
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Because PICT drawings in Power Macintosh are fixed at 72 DPI (dots per inch)
base resolution for printing overlays is always 72 DPI. However, you can get hig
resolution for your overlay by bringing it in at double size (or more) and then red
ing it in size with the Overlay tool.

Printing Line Graphs

Line graphs are drawn as line segments.
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Print to File

Depending on your available print drivers, you can print data, image and attribu
windows to a printer (*.prn) file by selecting thePrint to File checkbox (Windows)
or to a postscript file with theFile command from the Destination pop-up menu
(Macintosh) in the Print dialog. ClickingOK  with this option selected will open the
Print to File dialog.
Print to File Transform Part 3: Reference Manual
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This appendix reviews each of the menus and commands that appear in Transf
menu bar. The menu bar changes depending upon whether a file is open, and w
window type is active. If the Transform program window is open, but no files are
open, Transform commands appear in four menus: File, Edit, Macros, and Help
When a file is open, the following menus appear: File, Edit, Image, Numbers, M
ros, Color Tables, Tools (Windows only), Windows, and Help.

Note that certain Transform windows have fewer menus. For example, the Colo
Tables menu is absent when a line plot is active.
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File Menu

TheNew...command lets you to create a new array with all of the numbers set to
or 1.0.

TheOpen... command accesses a file from disk. Use it to load datasets which w
previously saved from Transform or to import data from a variety of file formats.

TheSave command saves any updates to an open file.

TheSave As... command saves a copy of the current dataset with the file name o
your choice. Several export types are available.

TheClose command closes the current window and removes it from the screen.
When you close a dataset window, the data is removed from memory, and all de
dent windows are also removed.

TheClose All command removes all windows from the screen.

ThePrint  command prints the current dataset, notebook or image in a manner c
sistent with parameters set using Page Setup... andPrinter Setup....

ThePage Setup... command brings up a dialog that allows you to set page margi
and add header and footer text.

ThePrinter Setup... command (Windows only) brings up a dialog that allows you t
select and configure a printer from the list of printers installed on your Windows
tem.

TheExit/Quit  command closes all of the windows and exits the program.

Figure A-1: File menu
File Menu Transform Part 4: Appendices
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Edit Menu

TheCut command removes the currently selected text (if appropriate) and copie
to the clipboard.

TheCopy command copies a Windows metafile representation of the current plot
copies currently selected data as text, to the clipboard.

ThePastecommand adds the contents of the current clipboard to the current wind
wherever appropriate.

TheClear command removes the currently selected text, image, or overlay from
currently selected window, whichever applies.

TheCopy As... command (Windows only) brings up a dialog that lets you select
which components in a window to copy. When appropriate, this dialog also allow
you to choose what format to copy to.

ThePaste As... command (Windows only) brings up a dialog which lets you choo
what to paste from the clipboard. When appropriate, this dialog also lets you choo
format for the pasted component.

ThePaste Overlay command (Power Macintosh only) adds the contents of the c
rent Clipboard to an image or plot window as an overlay.

TheCopy 2x andCopy 4x commands (Power Macintosh only) enlarge images (a
two to four times their actual size) while copying them to the Clipboard. This featu
is useful for resolution improvement.

Figure A-2: Edit Menu
Transform Part 4: Appendices Edit Menu
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TheCopy Bitmap command (Power Macintosh only) copies a bitmap representat
of the current plot to the Clipboard.

ThePaste New command (Power Macintosh only) use the current contents of the
Clipboard to create a new window (if possible) and a new dataset from the imag
data present.

TheSynchronizecommand links two or more datasets of the same size, so that w
data points are selected in one dataset, the corresponding data points will be se
in the other dataset(s).

TheFont... command brings up the dialog that allows you to select font and size
text in dataset and notebook windows, and for axes labels in image and plot wind

ThePreferencescommand allows you to specify display font, style, and size; spec
new window size, as well as data and scale numerical format; and view all curre
settings, line-by-line in macro form. For more on Preferences, see Chapter 20. Y
can save changes in settings to disk.

TheStatus Barcommand (Windows only) lets you display or hide the status bar.
When enabled, the Status Bar is displayed in the bottom left margin of the wind
and a checkmark appears in the menu next to the command.

TheTool Bar command (Windows only) lets you display or hide the tool bar. Wh
enabled, the tool bar is displayed across the top margin of the Transform window,
a checkmark appears in the menu next to the command.

TheTool Palette command (Windows only) brings up a pull-right that provides
access to four options for the display of the tool palette. SelectingOff  hides the tool
palette. SelectingHorizontal  from the submenu displays the tool palette across th
top of the Transform window. SelectingVertical from the submenu displays the tool
palette along the left margin of the Transform window. SelectingFloating displays
the tool palette in a floating window that you can move within the Transform wind
as desired.
Edit Menu Transform Part 4: Appendices
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Image Menu

The Image menu allows you to generate the different types of Transform images
plots. See Chapters 12-19 for more information about each image and plot type

TheImage Size.../Rectangle Size...command brings up a dialog to control sizing o
images and plots.

TheCircle Size...command (Power Macintosh only) opens a dialog to control sizi
information for any polar images created.

Figure A-3: Image Menu
Transform Part 4: Appendices Image Menu
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Numbers Menu

TheAttributes... command lets you select different characteristics for the curren
dataset, including the dataset name.

TheExtract Selectioncommand creates a new dataset that consists of the data va
in the selection region of the current window.

TheChange Data Entry... command (Power Macintosh only) lets you change the
selected data value in your array.

TheGenerate Scales...command creates a new dataset from the current dataset w
different row and column scales.

TheSee Notebook command opens a notebook window where you may enter no
about the dataset, or enter and execute macro expressions. In Windows, theCalculate
From Notescommand replacesSee Notebookwhen the notebook window is active.

Calculate from Notes evaluates the current line or currently selected macro expr
sion in the notebook.

TheSmooth Data... command creates a new dataset by smoothing the values in
current dataset.

TheResample Data... command creates a new dataset of a different size from th
current dataset by interpolating data values.

TheFill Missing Data... command provides several options for interpolating or
replacing missing data in the current dataset.

TheMathLink...  command allows Transform to connect to Mathematica to acce
commands and exchange data.

Figure A-4: Numbers Menu
Numbers Menu Transform Part 4: Appendices
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Macros Menu

See Chapter 22: Using Macros and Chapter 23: Macro Reference for more info
tion on macro commands.

TheCreate Macro... command prompts for a macro name and saves a macro ba
on the characteristics of the current window.

TheEdit Macros... command presents a list of the currently saved macros and allo
you to edit, rename, delete, import, export and create new macros.

Previously saved macros are listed below the below the horizontal divider line. Lis
macros are executed when selected from the menu.

Figure A-5: Macros menu
Transform Part 4: Appendices Macros Menu
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Color Tables Menu

The Color Tables menu lists color tables that can be applied to images and plots
Chapter 13:Color and Color Tables for more information on color in Transform.

TheCustom Color Tables... command (Windows only) brings up a dialog that lets
you select a color table created outside of Transform, or that was included in a da
you loaded. The name of the most recently-used custom color table appears bet
the dividers immediately below theCustom Color Tables... command.

TheLoad Color Table... command (Power Macintosh only) reads a color table fro
a disk file and applies it to the current image.

Figure A-6: Color Tables Menu
Color Tables Menu Transform Part 4: Appendices
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Tools Menu

The Tools menu provides an alternative to the tool palette and the tool bar. The 
portion of this menu lets you select a tool for the current window, just as you wo
using the tool palette. The portion of this menu below the divider line changes w
the current window type and tool. Selecting commands in this area is equivalen
pressing the corresponding toolbar button. For more about these tools and optio
see Chapter 12.

Figure A-7: Tools Menu
Transform Part 4: Appendices Tools Menu
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Windows Menu

The Windows menu provides a way to manage open windows.

The Show/Hide Window command (Power Macintosh only) lets you hide and red
play windows.

TheTile command arranges all open windows to fill the Transform window.

TheCascadecommand (Windows only) stacks open windows in a staggered fash
Only the top window is fully visible, but the top and left edges of every window is
visible beneath the previous window.

Arrange Icons (Windows only) aligns all iconified windows in a row in the lower
left corner of the Transform window.

Below the divider, this menu also lists all windows that are currently open, includ
those that have been iconified in Windows.

Figure A-8: Windows Menu
Windows Menu Transform Part 4: Appendices
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Help Menu

In Power Macintosh, the Help menu provides access to Balloon Help.

In Windows, the Help menu provides access to Transform's on-line help.

TheMacro Language Reference...starts the on-line reference to the macro lan-
guage.

TheAbout Transform... command gives information on Transform, including the
version number and copyright information. It also provides access to the technic
support dialog.

Figure A-9: Help menu
Transform Part 4: Appendices Help Menu
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MathLink can be used to connect Transform 3.4 and Mathematica 3.0, allowing
Mathematica full scripting control over Transform. With third-party network soft-
ware, you can even use MathLink to connect Transform to another computer th
running Mathematica.
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Set Up A Mathlink Connection in
Transform for Windows

Setting Up in Mathematica

In the 'Mathlink' directory is the file 'trnsfrm3.m'. Use theNeeds or << (Get) com-
mand to load this package:

In[1]:=   <<trnsfrm3.m

Now you have access to the list of Transform-specific MathLink calls. To set up 
connection open a link with the following function:

In[2] := TransformConnect["3000"]

The parameter “3000” is a port name appropriate for your data transport protoco

Note
See Mathematica and MathLink documentation for information on the various d
transport protocols available, and any port-naming restrictions. The Transform
nect[ ] function uses the default MathLink data transport protocol. To force a s
cific, protocol, use the alternative form, for example:
TransformConnect["3000", "TCP"] .

When using the TCP protocol, the parameter is the socket number: a TCP/IP-spe
number from 1024 to 32000. Choose any number you wish, but it must match on
sides of the link. If an error indicates the socket number is already in use, choos
another number. Higher numbers are usually available.

This command does not return with any messages until Transform connects to 
link, or it times out (several minutes). Start Transform and open the link from the
other side (described below). When Transform connects it returns the symbol
$TransformReady, so in Mathematica, you should see the following message al
with a new prompt:

Out[2]= $TransformReady
In[3]:=

Now the link is open and you are ready to use Mathematica commands with Tra
form. Please refer to your MathLink manual to get a better idea of how connecti
are established, and of the connection options available.
Set Up A Mathlink Connection in Transform for Windows Transform Part 4: Appendices
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Setting Up in Transform

To set up MathLink, selectMathLink...  from the Numbers menu to bring up the dia
log shown in Figure B-1.

To connect to a Mathematica application running on your local workstation, enter
port name that you gave to Mathematica in theTransformConnect[ ] command.
This will connect to Mathematica running on your computer system.

Note
To connect using the TCP protocol or to connect to Mathematica running on
another computer system, enter the port name followed by “@hostname”, for ex
ple “3000@sunserver”.

1. After entering your connection information, clickConnect.

If Mathematica is active and waiting, the connection may be immediate. The
tus message changes to indicate that the link is being attempted or that it has
opened. When the link is established, the status line changes to indicate su
If the link times out or fails, the status line provides an error message.

The connection may fail because Mathematica is not ready or cannot be foun
the specified port location. If so, check your connection address and correct
Select an alternate Mathematica link (such as a copy of Mathematica runnin
a different workstation) and go back to Mathematica to check the status of y
TransformConnect[] command.

2. Click Closeto close the MathLink dialog and allow Transform and Mathematic
to work with the open link.

The link remains open until it is closed by a command from Mathematica or
Transform.

Figure B-1: MathLink Dialog
Transform Part 4: Appendices Set Up A Mathlink Connection in Transform for Windows
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Connecting Mathematica 2.2.x to
Transform for Windows

If you are using an older version of Mathematica we recommend that you upgrad
the latest version. You can, however, link older versions of Mathematica to Transf
3.4. You can follow the same setup instructions provided in the previous pages,
you will need to make the following changes:

1. In the Mathematica notebook, use theTransformConnect["3000", "TCP"]
command. Then in Transform, chooseMathLink... from the Numbers menu, and
in the “Link to” dialog type “3000@ip address”. This option requires your Win
dows machine to have an IP address.

2. Make sure that MLINK32.dll is installed in the c:\WNMATH22 directory.

3. Then modify the trnsfrm3.ini file to be:

mthlnk32= c:\WNMATH22\MLINK32.dll

If your Windows machine does not have an IP address then you will have to
upgrade to the latest version of Mathematica before you can use it with Tran
form.
Connecting Mathematica 2.2.x to Transform for Windows Transform Part 4: Appendices
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Using the Mathlink Connection in
Transform for Windows

Below are the Mathematica commands that are used with Transform.

TransformCommand["call contour(currentdataset)"]

TransformCommand passes any string, or list of strings, to Transform for pro
cessing as a macro expression. When successful, Transform returns the sy
$TransformReady to Mathematica. Otherwise the symbol$Failed is returned.
Transform commands commonly use quote marks as part of the command it
To provide a quote mark within a Mathematica expression, use the backslas
before the quote. For example, the following command opens a file by name

In[8]:= TransformCommand["call open(\"myfilename\")"]

See below for an in-depth example using Mathematica to script Transform m
ros.

myMathematicaData = TransformGetArray["mydata"]
TransformPutArray[myMathematicaData, "mydata"]

TransformGetArray[]  andTransformPutArray[]  exchange data with Trans-
form.TransformGetArray[] transfers an array from Transform to Mathematica
TransformPutArray[] does the opposite. When you read a dataset,Trans-
formGetArray[ ] is the name of any Transform dataset window and a 2D Ma
matica Table is returned. When you write a table withTransformPutArray[] ,
the first parameter is the name of the table in Mathematica and the second pa
eter is a string which will be used as the name of the dataset in Transform.

avalue = TransformGetValue["myvariable"]
TransformPutValue["thevalue", "myvariable"]

TransformGetValue[]  andTransformPutValue[]  exchange simple variables
with Transform.TransformGetValue[]  returns the value of the named variable
TransformPutValue[] assigns the named variable the value given. This is ho
you specify Transform keywords, used to set up and create plots. All values
exchanged as strings even if they represent numerical values.

TransformLinkName[]

TransformLinkName[]  returns the Link identifier for the MathLink connection
to Transform. It is useful when you need to use the Mathematica commands
which operate directly on links, such asLinks[]  andLinkError[] .
Transform Part 4: Appendices Using the Mathlink Connection in Transform for Windows
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Recovering From Errors in
Transform for Windows

The Transform MathLink commands all return a value, the symbol$Transform-
Ready, or upon error, the symbol$Failed. When Transform responds with$Failed, it
places a descriptive error message in the macro variablemathlink_lasterror . The
value of this variable may be displayed in a Transform notebook using theprint com-
mand, or it may be fetched by Mathematica using theTransformGetValue[ ] com-
mand. For example:

In[6]:= TransformGetArray["test"]
Out[6]= $Failed
In[7]:= TransformGetValue["mathlink_lasterror"]
Out[7]:= Unknown dataset--'test'
In[8]:=

When you suspect that the link has become inoperable, you should close the co
tion and reconnect between Transform and Mathematica. Close the Transform 
first by bringing up the MathLink dialog and clicking theDisconnectbutton. As soon
as Transform closes the link, Mathematica detects the action and aborts any wa
MathLink command.

Note
If you are using the TCP protocol for MathLink, you may find that the socket n
ber you chose cannot be reused for several minutes after the link is closed. Cho
new socket number until the previous one times out and becomes available ag
Recovering From Errors in Transform for Windows Transform Part 4: Appendices
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Closing the Mathlink Connection in
Transform for Windows

You may close either side of the MathLink connection, the Transform side or the
Mathematica side. You may also Exit from either program to disconnect.

To release the shared system resources being held, you should always close bo
sides of the connection.

Closing in Transform

Open the MathLink dialog again with theMathLink... menu command and click the
Disconnect button.

Closing in Mathematica

Use the TransformDisconnect[] command.

In[12]:= TransformDisconnect[]
Transform Part 4: Appendices Closing the Mathlink Connection in Transform for Windows
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Mathematica Examples in
Transform for Windows

The following Mathematica programming examples can be found in the MathLin
Examples notebook shipped with Transform.

Example Program 1

In this example we evaluate an analytical function for use in Transform. It create
table of numbers and sends them to Transform, then creates an image from the
It assumes the link is already open.

atable = Table[ Sin[x] Cos[y], {x,-3,3,0.4},{y,-3,3,0.4}] ;
TransformPutArray[atable, "sincos"]
TransformCommand["currentplot = image(\"sincos\")"]

Example Program 2

The following example generates a sequence of datasets from an analytical exp
sion in Mathematica and calls Transform to generate the graphic output, one im
for each dataset. The images are saved to an HDF file. The resulting file is then
verted to an AVI animation file, which may be viewed using the Windows Media
Player. It also assumes the link is already open.

[Based on the example from Mathematica - A System for Doing Mathematics by
Computer, Second Edition, page 175.]

Note
The example below uses a surface macro. Therefore, before running this exam
you must create a macro name 'surface_macro', which generates a Hi-Res Co
surface plot. See Chapters 22 and 23 for more on macros.

Do[tables[t]=Table[BesselJ[0,Sqrt[x^2 + y^2] + t],{x,-10,10},
            {y,-10,10}], {t,0,8,1}];
Do[{TransformPutArray[tables[i],"time"<>ToString[i]],
    TransformCommand["currentdataset=\"time"<>ToString[i]<>"\""],
    TransformCommand["call surface_macro"],
    TransformCommand["call saveas(currentplot,\"besslj.hdf\",13)"],
    TransformCommand["user_interactive=false"],
    TransformCommand["call close(\""<>"time"<>ToString[i]<>"\")"]},
   {i,0,8,1}]
TransformCommand["call makeavi(\"besslj.hdf\",\"besslj.avi\")"]
Mathematica Examples in Transform for Windows Transform Part 4: Appendices
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Set Up a MathLink Connection in Transform
for Power Macintosh

This section describes the steps required to establish a MathLink connection bet
Transform and Mathematica.

Setting up in Mathematica

In the 'Mathematica' folder on your Transform program disk is the file 'Transform
Link.m'. Be sure and place a copy of this file in your mathematica folder. In Math
matica use theNeeds or << (Get) command to load this package:

In[1]:=   <<TransformLink.m

Now you have access to the list of Transform-specific MathLink calls. To set up 
connection open a link with theTransformConnect[] function:

In[2]:=  TransformConnect[]

This command does not return with any messages until Transform connects to 
link, or it times out (several minutes), or you cancel the command. Now switch t
Transform and open the link from the other side (described below). When Transf
does connect it returns the symbol $TransformReady, so you should see the follow-
ing message along with a new prompt:

Out[2]= $TransformReady
In[3]:=

Now the link is open and you are ready to use Mathematica commands with Tra
form.

Please refer to your MathLink documentation to get a better idea of how connect
are established, and of the connection options available.

Setting Up in Transform

To set up MathLink, select MathLink...  from the Numbers menu to bring up the
MathLink to Mathematica dialog.

To connect to a Mathematica application running on your Macintosh, use the de
entry, 'TransformLink'. See the TCP/IP section below for information on connect
to Mathematica on another computer.

1. After entering your connection information, clickOpen Link.
Transform Part 4: Appendices Set Up a MathLink Connection in Transform for Power Macintosh



382 Appendix B: MathLink To Mathematica

 sta-
been

ccess.
age.

d. If
 link

to
nd

m.
ia
the

rm.

rm-

000.
ror
um-

th-

m.
If Mathematica is active and waiting, the connection may be immediate. The
tus message changes to indicate that the link is being attempted or that it has
opened. When the link is established, the status line changes to indicate su
If the link times out or fails, the status line changes to provide an error mess

The connection may fail because Mathematica is not ready or cannot be foun
so, the standard program browser appears. Select an alternate Mathematica
(such as a copy of Mathematica running on a different Macintosh) or choose
Cancel and go back to Mathematica to check the status of yourTransformCon-
nect command.

2. ClickOK to close the MathLink dialog and allow Transform and Mathematica
work with the open link. The link remains open until it is closed by a comma
from Mathematica or Transform.

Setting up a TCP/IP MathLink Connection

MathLink supports TCP/IP connections when MacTCP is installed on your syste
First you need to use a communications program to login to another computer v
TCP/IP and run a version of Mathematica on that computer. You also have to run
TransformLink package in Mathematica in order to use a TCP/IP link to Transfo

In your non-Macintosh version of Mathematica, use the TCP/IP form of Transfo
Connect:

In[2] := TransformConnect["3000"]

The parameter is the socket number: a TCP/IP-specific number from 1024 to 32
Make up any number you like, but it must match on both sides of the link. If an er
indicates the socket number is already in use, choose another number. Higher n
bers are usually available.

On the Transform side of the TCP/IP link, enter a TCP/IP connection ID in the Ma
Link dialog. These are of the formnnnn@hostname wherennnn is the socket num-
ber andhostname is the network name of the computer that is running the remote
copy of Mathematica. An example of this form would be:

3000@sunserver

Click Open Link to open the connection.

Using the MathLink Connection

Below we list all of the supported Mathematica commands for use with Transfor

TransformCommand["call contour(currentdataset)"]
Set Up a MathLink Connection in Transform for Power Macintosh Transform Part 4: Appendices
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TransformCommand passes any string, or list of strings, to Transform for proces
ing as a macro expression. When successful, Transform returns the symbol$Trans-
formReady to Mathematica. Otherwise an error message is returned.

Transform commands commonly use quote marks as part of the command itsel
provide a quote mark within a Mathematica expression, use the backslash befo
quote. For example, the following command opens a file by name:

In[8]:= TransformCommand["call open(\"myfilename\")"]

See below for a more in-depth example of using Mathematica to script Transfor
macros.

myMathematicaData = TransformGetArray["mydata"]
TransformPutArray[myMathematicaData, "mydata"]

TransformGetArray  andTransformPutArray  exchange data with Transform.
Get transfers an array from Transform to Mathematica and put does the oppo
When you read a dataset, theTransformGetArray parameter is the name of any
Transform dataset window and a 2D Mathematica Table is returned as the re
When you write a table withTransformPutArray , the first parameter is the
name of the table in Mathematica and the second parameter is a string which
be used as the name of the dataset in Transform.

avalue = TransformGetValue["myvariable"]
TransformPutValue[thevalue, "myvariable"]

TransformGetValue andTransformPutValue exchange simple variables with
Transform.TransformGetValue returns the value of the named variable.Trans-
formPutValue assigns the named variable the value given. This is how you sp
ify Transform keywords, used to set up and create plots. All values are exchan
as strings even if they represent numerical values.

TransformLinkName[]

TransformLinkName returns the Link identifier for the MathLink connection to
Transform. It is useful when you need to use the Mathematica commands w
operate directly on links, such asLinks[]  andLinkError[] .
Transform Part 4: Appendices Set Up a MathLink Connection in Transform for Power Macintosh
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Recovering from Errors in Transform for Power Macintosh

When you suspect that the link has become inoperable, you should close the co
tion and re-connect between Transform and Mathematica. Close the Transform
first by bringing up the MathLink dialog and clicking theClose Link button. As soon
as Transform cuts off the link, Mathematica detects the action and aborts any wa
MathLink command.

If you are using the TCP protocol for MathLink, you may find that the socket numb
you chose cannot be reused for several minutes after the link is closed. Choose a
socket number until the previous one times out and becomes available again.

Closing the MathLink Connection in Transform for Power
Macintosh

You may close either side of the MathLink connection, the Transform side or the
Mathematica side. When you do, the other side detects the change in status an
connects also. You may alsoQuit  from either program to disconnect.

Closing in Mathematica

Use theTransformDisconnect[] command.

In[12]:= TransformDisconnect[]

Closing in Transform

Open the MathLink dialog again with the MathLink menu command and click th
Close Link button.

Mathematical Examples

The following Mathematica programming examples can be found in the 'Transfo
Link Examples' notebook shipped with Transform.

Example Program 1

In this example we evaluate an analytical function for use in Transform. It create
table of numbers and sends them to Transform, then creates an image from the
It assumes the link is already open.

       atable = Table[ Sin[x] Cos[y], {x,-3,3,0.4},{y,-3,3,0.4}] ;
       TransformPutArray[atable, "sincos"]
       TransformCommand["currentplot = image(\"sincos\")"]
Set Up a MathLink Connection in Transform for Power Macintosh Transform Part 4: Appendices
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Example Program 2

The following example creates an output sequence in Transform which may the
played back as an animation. It generates a sequence of datasets from an anal
expression in Mathematica and calls Transform to generate the graphic output, 
image for each dataset.

[Based on the example from Mathematica - A System for Doing Mathematics by
Computer, Second Edition, page 175.]

Do[tables[t]=Table[BesselJ[0,Sqrt[x^2 + y^2] + t],{x,-10,10},
{y,-10,10}], {t,0,8,1}];

Do[{TransformPutArray[tables[i],"time"<>ToString[i]],
TransformCommand["call surface_macro"],
TransformCommand["call saveas(currentplot,\"TransMovie\", 9)"],
TransformCommand["call close(\""<>"time"<>ToString[i]<>"\")"]},

{i,0,8,1}]
Transform Part 4: Appendices Set Up a MathLink Connection in Transform for Power Macintosh
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AppleEvents is a Macintosh System 7 (or greater) feature which allows applicat
to exchange data and commands. To send commands to Transform, you need 
an application capable of sending AppleEvents. This appendix was tested using
intosh OS 8 and Script Editor 1.1.2 which can be found in the 'Apple Extras:App
Script' folder. Other resources for AppleScripting can be found on the Apple web
athttp://www.apple.com or more specifically
http://applescript.apple.com/default.html.
Transform Part 4: Appendices 387



388 Appendix C: AppleEvents for Power Macintosh

rent
form

n is

m.
turn
Using ScriptEditor to Control Transform

To send commands from the ScriptEditor to Transform, you can use several diffe
AppleScript commands. The commands you would use most often to run Trans
are:

tell

specifies which application the commands are being sent to. If the applicatio
not already running, this command prompts you to launch the application.

end tell

ends the communication between the ScriptEditor and Transform.

activate

brings the target application to the front.

Do Script

Sends a macro command to Transform.

set macro to

used with Do Script macro to send a series of macro commands to Transfor
Each macro command should be separated by & return & ¬. To make the Re
symbol, press Option-Return.

set menuID to

same as activating a menu item.

set menuItem to

same as choosing a command from a menu.

set menuCode to menuID * 65536 + menuItem

the formula to calculate the menu code to send to Transform.

Do Menu menuCode

sends the menu code to Transform.

In addition, all text preceded by a -- indicates a comment.
Using ScriptEditor to Control Transform Transform Part 4: Appendices
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Note
Although you can use AppleScript'sDo Menu command to control Transform, you
may find it easier to send macro commands to Transform using theset macro to
command.

ScriptEditor Example

Here we present an example of using the ScriptEditor to send commands to Tra
form. In this example, ScriptEditor opens Transform, makes Transform the activ
application in the Finder, and then sends a series of macro commands to Trans
The commands tell Transform where to look to open a file, then create an image
that file. TheDo Menu command is used to send the active image window to be
printed. An additional series of macros are then used to save then close the file

tell application "Transform PPC" --open communication with the app
activate -- makes the target application active in the finder
Do Script "call beep"
set macro to ¬

"path = 'HardDrive:Transform:Samples:Tstorm'" & return & ¬
"call setfolder(path)" & return & ¬
"call open('Xvel.hdf')" & return & ¬
"user_interactive = true" & return & ¬
"image_axes = true" & return & ¬
"new =  image(currentdataset)" & return

--the macro sets the path, opens a file and makes an image

Do Script macro -- executes the lines in the "set macro to"

set menuID to 129 --"same as choosing File on the menu"
set menuItem to 10 -- "same as choosing Print off the File menu"
set menuCode to menuID * 65536 + menuItem --menuCode formula

Do Script "user_interactive = false" --turn off user prompts
Do Menu menuCode -- Prints the active window in Transform

Do Script "call setsavefolder('HardDrive:Transform:Samples')"
Do Script "call saveas(currentdataset, 'Test.hdf', 1)"
-- saves Xvel.hdf file into new Test.hdf file in Samples folder

quit -- quits Transform

end tell -- ends communication with Transform
Transform Part 4: Appendices Using ScriptEditor to Control Transform
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Click theRun button to execute the script.

Note
You have to change path names to match your system hard drive.

Command Formatting

You can send multi-line scripts to Transform with a singleset macro to command.
However, since only one error code is returned from one command, it may be diffi
to track down errors in multi-line scripts. You can create them by concatenating li
with return characters as in the following example:

set macro to "user_interactive=false" & return & ¬
"currentplot=contour(currentdataset)" & return

Figure C-1: ScriptEditor
Using ScriptEditor to Control Transform Transform Part 4: Appendices
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The ampersand is a concatenation operator and it is not passed to Transform. T
special keyword return creates a return character which is added to the script th
passed to Transform. This return character is crucial because it separates comm

Embedding quotes in commands works the same way. Because the double quo
used as part of the AppleScript language, we use single quotes where you would
mally use double quotes in the Transform macro language. For example, in Tra
form, the filename Xvel.hdf would be in double quotes (e.g. “Xvel.hdf”). In the
ScriptEditor, the proper syntax is as follows:

set macro to "call open('Xvel.hdf')"

Suppressing User Interaction

To suppress user interaction when sending macro commands, set the
user_interactive flag tofalse. To set it from an external script, send the following:

set macro to "user_interactive=false"
Transform Part 4: Appendices Using ScriptEditor to Control Transform
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MenuID Numbering in Transform

The following represents the menuID numbering in Transform.

The menuID is used to calculate the menu code:

set menuCode to menuID * 65536 + menuItem

MenuItem Calculation

A menuItem represents a command on a menu. Each menuItem is determined 
placement on the menu. The first item on the menu is number one; the rest of th
commands are consecutively ordered as they appear in the menu. Any dividing
on a menu are included in the number count. For example, in the Numbers men
Attributes  is menuItem number one, the first divider is menuItem number five,Cal-
culate From Notes is menuItem number seven and MathLink is number thirteen.

Menu Name menuID Number

File 129

Edit 130

Image 131

Numbers 132

Macros 134

Windows 135

Color Tables 136

Figure C-2: Numbers Menu
MenuID Numbering in Transform Transform Part 4: Appendices
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HDF is an extensible, binary, public domain file format specification for storing d
and images. All Fortner Software products use HDF as their primary data storage
mat. HDF files can store floating point data, scaling information, color images, te
and other items. HDF originated at the National Center for Supercomputing App
tions (NCSA) at the University of Illinois at Urbana-Champaign, where it was de
oped as a solution to the problem of sharing data among all of their different
computers.

NCSA maintains and distributes a public domain software library for reading an
writing HDF format files. The library is available on a variety of computers includin
Macintosh, Windows, Sun, VAX, Silicon Graphics, and Cray UNICOS. The softwa
is written in C with both Fortran and C interfaces supported for making calls to t
HDF libraries.
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HDF Source Code, Manuals, and Web Sites

If you require total control of the contents of an HDF file through a C programmi
environment or you are interested in understanding the full details of the HDF form
you may utilize the HDF libraries.

Source code and documentation for the HDF storage routines is available from
NCSA at the University of Illinois and Fortner Software. The libraries can be
obtained from NCSA's HDF home page athttp://hdf.ncsa.uiuc.edu or by anonymou
ftp to ftp.ncsa.uiuc.edu.
HDF Source Code, Manuals, and Web Sites Transform Part 4: Appendices
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HDF-EOS

HDF-EOS is a convention for HDF established by NASA for earth science data.
NASA’s Earth Observing System (EOS) is part of the Earth Science Enterprise
project, an $8 billion, 15-year project to monitor long-term global environmental
change. This project alone will produce terabytes of information per day, resultin
an overwhelming surge of scientific data stored in HDF and HDF-EOS.

NASA will administer the data flow from the satellites to Earth receiving stations
called Distributed Active Archive Centers (DAACs) and make the data available 
the public via the Internet within 24-48 hours. While the data is available to every
outside of NASA, it is of particular interest to the scientists in the Environmental P
tection Agency, National Weather Service, NOAA, Department of Fishing and W
life, Department of Agriculture, etc. Commercial users will include companies in t
oceangraphic, mining, petroleum, agriculture and other industries.

HDF-EOS files are different from standard HDF files because they include three
earth science data objects (point, swath and grid) which are not defined within t
standard HDF library:

• A point object is a data group that contains data with geolocation informatio

• A swath object is a data group that contains time-ordered data (e.g., swaths
scanned by satellites).

• A grid object is a data group that contains projection data stored in a rectan
array.

HDF-EOS Source Code, Manuals, and Web Sites

For more information about HDF-EOS, go to the HDF-EOS Information Resourc
web site located athttp://hdfeos.gsfc.nasa.gov/hdfeos/hdf.html. This site provides
you access to the HDF-EOS documentation and libraries.
Transform Part 4: Appendices HDF-EOS
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HDF and HDF-EOS

Additional information about HDF, HDF-EOS and their application can be found
the World Wide Web at the following web sites:

• HDFinfo.com - a clearinghouse of HDF information: http://www.hdfinfo.com/

• NCSA's web page: http://hdf.ncsa.uiuc.edu

• NASA Goddard Space Flight Center (GSFC) page on HDF:
http://daac.gsfc.nasa.gov/REFERENCE_DOCS/HDF/gdaac_hdf.html

• Earth Science Enterprise web page: http://www.hq.nasa.gov/office/mtpe/

• EOS Data Resources web page - a list of all data centers distributing terabyt
science data in HDF: http://eospso.gsfc.nasa.gov/eos_homepage/

Data Download

The following web sites let you access data to be downloaded.

• TOMS (zipped):
http://daac.gsfc.nasa.gov/CAMPAIGN_DOCS/FTP_SITE/readmes/toms_daily.html

• GOME:
http://daac.gsfc.nasa.gov/CAMPAIGN_DOCS/FTP_SITE/readmes/gome_daily.html

• CZCS:
http://daac.gsfc.nasa.gov/CAMPAIGN_DOCS/OCDST/czcs_readme.html

• SeaWiFS:
http://daac.gsfc.nasa.gov/CAMPAIGN_DOCS/OCDST/OB_main.html

• SSMI:
http://daac.gsfc.nasa.gov/CAMPAIGN_DOCS/hydrology/
readme_html/ssmi_monthly_readme.html

• TRMM: http://lake.nascom.nasa.gov/DATA/TRMM/

• NSCAT: ftp://podaac.jpl.nasa.gov/pub/ocean_wind/nscat/

• DTED:
http://164.214.2.59/geospatial/products/DTED/dted.html
http://164.214.2.54/mel/data.html
Web Sites Transform Part 4: Appendices
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• SDTS: http://edcwww.cr.usgs.gov/doc/edchome/ndcdb/ndcdb.html

Note that the SeaWiFS and TRMM sites require you to order the data for a fee. W
the exception of the DTED and SDTS web sites, all data is stored in HDF. Noes
supports import of DTED and SDTS to HDF as described in the “Importing Files
chapter of theNoesys User’s Guide and Reference Manual.
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Kernel Functions
 or
king
Transform can calculate kernel convolution operations using built-in 3x3 kernels
using kernels you construct yourself. These kernel functions can be useful for ta
derivatives, sharpening edges of the data, smoothing the data, etc.

Here is a listing of the kernel functions.

ddx(q) dq/dx - difference from left to right

ddy(q) dq/dy - difference from top to bottom

d2dx(q) d2q/dx2 - second derivative from left to right

d2dy(q) d2q/dy2 - second derivative from top to bottom

lap(q) 5 point laplacian

lap5(q) same as lap(q)

lap9(q) 9 point laplacian

kernel(q,k) generic kernel
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Kernel Convolutions

A 3x3 computational kernel has the layout shown in Table E-1, where the value to
computed is in the center. The individual elements of the kernel make up coeffici
in the equation used to find a new center value. The coefficients are multiplied w
the data values in the array and added together. This kernel operation is repeated
for each member of the data array.

In Figure E-1, the shaded square marks the current array element to be comput
The surrounding 3x3 grid of nine elements is used to compute the value in the mi
for the result array.

The surrounding 3x3 grid of numbers is used for each point in the resulting arra
along with the 3x3 kernel of coefficients, to compute the results with the followin
formula. If array 'K' contains the nine kernel coefficients, and array 'P' contains t
computational subgrid diagrammed in Figure E-1, the resulting value for the cen
'fi,j ', is given by:

i-1
j-1

i
j-1

i+1
j-1

i-1
l

i
j

i+1
j

i-1
j+1

i
j+1

i+1
j+1

Table E-1: Layout of 3x3 Kernel
Kernel Convolutions Transform Part 4: Appendices
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Calculations are done once for each point within the computed region, shown in
ure E-2. Because the kernel computations require neighbors on each side in all
tions, the computed region extends to one element from the edge. At the end of
kernel operation, the edge values are filled in by copying them from their neares
neighbors.

When using the generic kernel function, you provide the names of two arrays, on
be used for data input, and the other containing the kernel coefficients. The com
tion proceeds across the rows of the dataset and down, evaluating the kernel at
point to produce an answer for the resulting array. The next section describes h
set up the kernel array.

Figure E-2: 3 x 3 Kernel in Array Grid

Figure E-3: Computed Region
Transform Part 4: Appendices Kernel Convolutions
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Generic Kernel Examples

For example, to perform a differencing equation to approximate the 'x' derivative
an array that has equally spaced columns, one unit apart:

1. After opening your source array, select See Notebook from the Numbers me
A notebook window appears.

2. Enter the following array into the Notebook window, with each number separa
by a tab and a hard return at the end of each row.

3. Select the array and chooseCopy from the Edit menu. The array is copied onto
the Clipboard.

4. In Windows, select a non-notebook window and choosePaste As… from the
Edit menu; selectNew Dataset in the Paste As dialog and clickOK . In Power
Macintosh, selectPaste New from the Edit menu. This creates a new data win
dow.

5. Name the window 'd_kernel' using the Attributes dialog from the Numbers me
You now have a usable kernel.

6. Enter and select the following formula in the notebook window.

diffx = kernel(q, d_kernel)/2

where ‘q’ is the name of your source array.

7. ChooseCalculate From Notes from the Numbers menu. The command applie
your 3x3 convolution to the data and produces a new dataset the same size

Look at the image to verify that each data point consists of the value to its right mi
the value to its left divided by 2.

Try using the kernels shown in Tables E-2 through E-4 for experimentation. The
nel shown in Table E-2 smooths the data, averaging the center value with its ne
bors, reducing any spikes and sharp transitions. The left kernel in Table E-3 brin
out horizontal lines in the data; the right kernel brings out vertical lines. Finally, t
kernel in Table E-4 sharpens edges in the data.

0 0 0

-1 0 1

0 0 0
Generic Kernel Examples Transform Part 4: Appendices



Appendix E: Kernel Functions 403
1 0 1

0 1 0

1 0 1

Table E-4: Kernel that Smooths Data

1 1 1 1 0 -1

0 0 0 1 0 -1

-1 -1 -1 1 0 -1

Table E-5: Kernels that Detect Horizontal and Vertical Lines of Data

1 -1 1

-1 1 -1

1 -1 1

Table E-6: Kernel that Sharpens Edges in Data
Transform Part 4: Appendices Generic Kernel Examples
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Kernels For Built-in Functions

This section presents the coefficient matrices for the built-in kernel functions (Tab
E-5 through E-10). Certain constants are used throughout:

• The average width of the rows and columns— x and y:

x = (x max – x min ) / (n cols  – 1)
y = (y max – y min ) / (n rows  – 1)

These constants are valid only when the columns are evenly spaced.

• The row and/or column differences for a point—hi and hj:

hi  = x i+1  – x i
hj  = y j+1  – y j

where 'xi' is the column scale value at column 'i' and 'yj' is the row scale value at
row 'j' value at row 'j'

A = - hi / [ hi-1  ( hi + hi-1 )]
B = – (A + C)
C = hi-1  / [ hi ( hi + hi-1 )]
f i ,j = A*P i-1 , j  + B*P i , j  + C*P i+1,j

A = -h j  / [ h j -1 (h j  + h j -1)]
B = – (A + C)
C = h j -1 / [ h j  (h j  + h j -1)]
f i , j  = A*P i , j-1  + B*P i , j  + C*P i , j+1

A B C

Table E-7: ddx Kernel

A

B

C

Table E-8: ddy Kernel
Kernels For Built-in Functions Transform Part 4: Appendices
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A = 2 / [ hi-1  ( hi + hi-1 )]
B = – (A + C)
C = 2/ [ hi ( hi + hi-1 )]
f i , j  = A*P i-1,j  + B*P i , j  + C*P i+1,j

A = 2 / [ h j-1  (h j  + h j-1 )]
B = – (A + C)
C = 2 / [ h j  (h j  + h j-1 )]
f i , j  = A*P i , j-1  + B*P i , j  + C*P i , j+1

Because of the use of x and y in the Laplacian approximations, they are only
valid for evenly spaced rows and columns.

A = 1/( y) 2

B = 1/( x) 2

C = –2 (A + B)
f i , j  = A*(P i , j-1  + P i , j+1 ) + B*(P i-1,j  + P i+1,j ) + C*P i,j

A B C

Table E-9: d2dx Kernel

A

B

C

Table E-10: d2dy Kernel

A

B C B

A

Table E-11: lap and lap5 Kernel
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h = ( x + y)/2
A = 1/[4 ( h) 2]
B = 2A
C = –12A
f i , j  = A*(P i-1,j-1  + P i-1,j+1  + P i+1,j-1  + P i+1 , j+1 )
+ B*(P i,j-1  + P i,j+1  + P i-1,j + P i+1,j ) + C*P i,j

A B A

B C B

A B A

Table E-12: Lap9 Kernel
Kernels For Built-in Functions Transform Part 4: Appendices
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External Functions
(Macintosh only)
nc-
rks
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If you have access to a C compiler, you can write your own external notebook fu
tions. Transform comes with a sample external function tested with the Metrowe
C compiler (IDE version 2.0). You can use these examples to create your own e
nal functionality.
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Using External Functions

External functions are stored in library files. Anytime Transform cannot find a fu
tion name in its internal list, a dialog box (Figure F-1) appears to help you choose
external library file. If you misspelled the function name, click the Return to Note
book button; otherwise click Select Library File and proceed to select and open 
library from disk. Once you open a library, you can use any of the functions within
all the functions remain available until you exit Transform.

In addition, the popup menu in the Notebook window labeled 'Externals' provide
easy access to all the names of functions that are available from open library fil
You must open the library file as described above first before the names show u
the popup menu. Then you may choose functions from the menu.

Sample Files

rotate.c

Takes the name of one data set and one constant as arguments.  It will cause th
image to be shifted by "constant" number of columns to the right if positive cons
or left if negative.

stdev.c

Computes the mean and standard deviation of a dataset and creates a new dat
comprised of the number of standard deviation each entry in the original datase
away from the mean.

Figure F-1: Choosing an External Function Library
Using External Functions Transform Part 4: Appendices
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Metrowerks project files that can be used to build and modify External functions

rotate and stdev

Prebuilt versions of External functions that can be called from Transform.

Compiler Settings for Creating Resources

External functions have specific settings that need to be set within the compiler 
ronment. This section explains generically what these settings are and specifica
how to set them within the Metrowerks environment. Metrowerks projects are pr
vided with Transform with the settings already defined. These working examples
be found in the 'External Functions' folder which is part of the default Transform
installation. Similar instructions could be used for other Macintosh compiler envir
ments. Refer to the specific compiler documentation for information on how to cre
code resources with non-Metrowerks compilers.

There are several settings required to set up an external function. Within the Met
erks environment, many of these will be set up in the Target Settings Panel by c
ing the PPC target pane.

The first setting that needs to be made is the external function must be created 
code resource. This is done in Metrowerks by going to the Target Settings Pane
choosing the PPC Target pane, and selecting the Code Resource menu item on
Project Type popup menu.

It is recommended that the code resource be given the same name as the functio
is to be called. Within the same pane, set the file name and resource name edit
to have the same name as your desired function.

There are four more resource specific fields that need to be set within this pane
Creator of the code resource must be set to FRtr, the Type must be set to DSff,
ResType must be set to DSfn, and each external function must be given its own
unique resource ID number or ResID. It is recommended to start numbering at 1
and number consecutively thereafter 1002, 1003, ....

Note that you may place more than one CODE resource into a resource file.  Ho
ever, in doing so each module must have a unique ID and name.
Transform Part 4: Appendices Using External Functions
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Creating an External Function in C

External functions are limited in the number and types of arguments they can acc
Each external function is called with either one or two arguments. If there are tw
arguments, the first is called the 'left' argument, the second called the 'right' argum
The first argument is always a Transform dataset, the second argument either a T
form dataset or a constant. The result of the function can either be a Transform
dataset or a constant. Each of these parameters is defined by a structure of typ
scope_array which is listed below. This is the format for the data that is passed to
from the external function. An example of an empty function is given below. In y
function, take information from the left and/or right parameters and place the res
ing information into the structure provided for the answer. It is important that the
name of each module is “main” and must return a long integer, as shown in the e
ple files “stdev.c” and “rotate.c”

long main(left,right,answer)
scope_array *left,*right,*answer;
{
/* contents of function */
}

The named function of the code resource must be the first executable code in th
file

Structure Definition

~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
Data structure for external functions.
The field 'kind' determines whether an argument is of constant or
array type.
kind is set to DS_CONSTANT or 0 if the structure contains a constant
value. The value of the constant will be stored in the cval field.
'kind' is set to DS_ARRAY or 1 if the structure contains an array. An
array is described by the set of ncols, nrows, rows, cols, and vals
fields.

External functions are called as:
your_fn(left,right,answer)
scope_array
*left, /* left parameter */
*right, /* right parameter */
*answer;  /* place to put the answer */

Answer will always contain pre-allocated space for an array of
resulting values, including the rows and cols arrays. You can
change any value in the rows,cols and vals arrays.
Using External Functions Transform Part 4: Appendices
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Do not change any values in the left or right storage.
If your routine returns only a constant, set kind == DS_CONSTANT
and put the answer in cval.
DON'T allocate anything you don't free yourself.
FREE everything you allocate.
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
*/
#define DS_ERROR -1
#define DS_CONSTANT 0
#define DS_ARRAY 1

typedef struct
{float cval, /* constant value when we are carrying a constant */

*rows, /* row labels, scale values: count = ncols */
*cols, /* col labels, scale values: count = nrows */
*vals; /* data values in the array, if there is an
array size = ncols*nrows */
int ncols,nrows; /* dimensions of the array */

char kind; /* ERROR, CONSTANT, ARRAY */
}
scope_array;
Transform Part 4: Appendices Using External Functions
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Troubleshooting
rans-
This chapter is intended to be of assistance should you have problems running T
form on your system.
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Video (Windows only)

Transform demands a high standard of performance for the video driver and so
drivers do not meet the required standards.

You may want to consult the Technical Support System Information dialog to de
mine the current state of your video adapter; this dialog can be activated by pre
theSupport... button on the About Transform dialog, which is available from the
Help menu.

TheSave... button on this dialog will save the technical information as a text file,
suitable for printing, faxing, or electronic mail.

There are two recommended options for getting an improved video driver. One op
is to contact the maker of your video board and get the most up-to-date video d
for your board. Another option is to get a copy to Microsoft's Super VGA driver, 
high quality driver that works with a variety of video boards. This driver is availa
by anonymous ftp from ftp.microsoft.com and is located in /Softlib/MSL-
FILES/SVGA.EXE. The SVGA.EXE file is a self-extracting archive.

Figure G-1: Technical Support Information Dialog
Video (Windows only) Transform Part 4: Appendices
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Color Palette

Images generated in Transform are optimally displayed when your system is co
ured in at least 8-bit mode (256 colors). If not, you will still be able to view datase
attributes and labels, but images requiring color may either be degraded or may
be generated.

To ensure your display is set correctly in Windows, go to the Start menu and se
Control Panel from the Settings submenu. Double-click theDisplay icon from the
Control Panel folder and select theSettings tab. Select the256 Color or greater set-
ting from the Color palette pull-down menu.

You will receive a message asking you to restart your machine so that the new s
tings will take effect.

Figure G-1: Windows Display Properties Dialog
Transform Part 4: Appendices Color Palette
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Slow Performance

Transform is a computational-intense application that relies heavily on floating-p
arithmetic and large amounts of memory. Should you find Transform to be excep
ally slow, please check the following:

• Does your system have a math coprocessor?

Though Transform will run on systems without a math coprocessor, performa
will be extremely slow. Therefore, a coprocessor is strongly recommended.

486DX, 486DX2, and Pentium™ systems have floating-point hardware built i
the CPU. Other CPUs, such as the 386SX, 386DX, and 486SX, require a sep
coprocessor chip.

If you are unsure whether your system has a coprocessor, you may find out
using the Microsoft Diagnostics program, MSD.EXE, located in your WIN-
DOWS directory. You should exit Windows before attempting to run this pro-
gram.

• Does your system have sufficient physical memory?

Depending upon the size of your datasets, Transform can consume large am
of memory. We recommend that your system have at least 8MB of physical m
ory. Transform can run with less memory, but with reduced performance.
Expanding your paging space will allow you to load larger datasets or maint
more windows, but will not compensate for performance loss due to insuffici
physical memory.

If your datasets are very large or you wish to work with many of them at the sa
time, you may want to consider adding additional memory to your system.
Slow Performance Transform Part 4: Appendices
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HDF Libraries

Saving to Full Disks

When saving a file, make sure there is enough disk space available. Trying to sa
HDF file when there is not enough disk space may cause HDF file corruption.

Compressed Datasets

Transform 3.4 uses the latest 4.1r1 HDF libraries; however, Transform is not com
ible with compressed, or chunked and compressed HDF datasets.
Transform Part 4: Appendices HDF Libraries
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Frequently Asked Questions

1. How can I create an image without a color bar?

You can create images with axes but without color bars by using a macro. F
create an image with the attributes you want, then selectCreate Macro from the
Macros menu. Next, selectEdit Macro  from the macros menu, and edit the
macro you just created.

As you scroll down the list of variable definitions, you will notice several sec-
tions starting with the line "*axes record", and ending with the line "call add-
axis(currentplot,#)" Delete the third set of these axes definitions that end in 
line

"call addaxis(currentplot,4)"

From this point on, you can create an image without a color bar by selecting
macro you previously created from the Macros menu.

2. What doesvar() do? When and how do I usevar()?

The subroutinevar() will return the actual dataset (the numbers) from a string
representing the dataset name or a window name. The subroutinevar() is most
commonly used with the reserved variablecurrentdataset. Usingvar() will
allow you to use currentdataset within a function that expects a numerical ar
ment. Note that in the manual where it lists a parameter q, it requires the ac
data, and where it lists a parameter name (e.g., datasetname or windownam
requires a string.

Consider the following example:

sinx = sin(var(currentdataset))

Since the function sin expects an numerical argument you use var() to conver
string stored in currentdataset to the actual data. A new dataset named sinx i
ated such that each element in sinx is the sine of the corresponding elemen
currentdataset. Without the use of var() the sin function would return an ans
of zero, since the value of the string represented bycurrentdataset is zero. Func-
tions may also return an error “This function requires an array.” Most likely y
need to usevar() here too.
Frequently Asked Questions Transform Part 4: Appendices
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3. In my macro I have a line that reads

 "new = smooth(currentdataset, 2) "

When I execute it, I get an error message, "This expression requires an arra
What is causing this error?

The variablecurrentdataset is a string variable that is set to the window name o
an array and is not actually equal to the array itself. The functionsmooth()
requires the array to be passed as an argument. Use the “var” command to a
the array that the variablecurrentdataset refers to. The correct syntax is:

"new = smooth(var(currentdataset), 2) "

4. How can I import an Excel spreadsheet into Transform?

It is very simple to import spreadsheets from Excel into Transform. In Excel,
under the File menu, selectSave As... Choose "Text (Tab delimited)" from the
Save File as Type menu. Note that this will only save the active sheet in your
Excel notebook. Now, you can open the file in Transform as ASCII Text Colum
or ASCII Text Matrix. You will have to specify the type of delimiter used to sav
the file in Excel (in this case Tab delimited).

Other popular spreadsheets, such as Lotus 1-2-3 and Quattro Pro have sim
methods for saving spreadsheets to ASCII text.

5. How can I open a series of slices from a 3D file, image each slice and save 
make an animation?

Power Macintosh: please refer to the Anim3DData.txt macro in the Advance
Macros section of Chapter 22.

Windows: this is available from the Research Systems web site (www.rsinc.c
under “Tech Tips.”

6. How can I let Transform automatically calculate the axis minimum and maxi
mum, but allow me to select my own label spacing?

There is a way to have Transform calculate the axis min and max and still let
specify the label interval. It can be done using the macros. In order to execute
macro properly, it is recommended that you create an image and save it as 
macro. Then, you edit the image macro by inserting the following lines in the
appropriate place.
Transform Part 4: Appendices Frequently Asked Questions
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***********************************************
         *Turn axis_auto and axis_autospacing off
         axis_auto = false
         axis_autospacing = false

***********************************************
         *Transfer X axis information to dataset
         xaxis_scale = x(Untitled)

         *Extract X axis min & max values
         xaxis_min = min(xaxis_scale)
         xaxis_max = max(xaxis_scale)

         *Set X axis_min and max
         axis_min = xaxis_min
         axis_max = xaxis_max

         *Round X axis min & max values for labeling
         xaxis_labelmin = ceiling(xaxis_min)
         xaxis_labelmax = floor(xaxis_max)

         *Set X axis_labelmin and max
         axis_labelmin = xaxis_labelmin
         axis_labelmax = xaxis_labelmax

***********************************************
         *Transfer Y axis information to dataset
         yaxis_scale = y(Untitled)

         *Extract Y axis min & max values
         yaxis_min = min(yaxis_scale)
         yaxis_max = max(yaxis_scale)

         *Set Y axis_min and max
         axis_min = yaxis_min
         axis_max = yaxis_max
          *Round Y axis min & max values for labeling
         yaxis_labelmin = ceiling(yaxis_min)
         yaxis_labelmax = floor(yaxis_max)

         *Set Y axis_labelmin and max
         axis_labelmin = yaxis_labelmin
         axis_labelmax = yaxis_labelmax

***********************************************
         *Close temporary datasets without saving
         user_interactive = false
         call close("xaxis_scale")
         call close("yaxis_scale")
         user_interactive = true

**************************************************
Frequently Asked Questions Transform Part 4: Appendices
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7. How can I automatically locate and draw (with a dot) the maximum (or maxim
in a contour plot?

While it is not possible to automatically locate and draw a symbol on a conto
plot for the maximum value in the dataset, there is a way to produce a black
for the maximum value in a contour image. To make the image, use the follow
procedures:

• Create your contour image and turn off the axes.

• SelectCopy from the Edit menu.

• Apply the following macro to your dataset.

maximum = max(Your Dataset Name)
x = LTmask(Xvel, maximum)

• From the new 'x' dataset, create an image.

• With the new image active, select Paste from the Edit menu.

8. In Transform, how can I translate matrix data to column data?

Using the macro Matrix-Column, described in the Advanced Macros section
Chapter 22 you can turn your matrix data into column data.

9. I often spend over an hour making a plot/image exactly as I want it. How do
make a second  image that is 98% similar to the first?

Once you make a plot/image that you like, chooseCreate Macro from the Mac-
ros menu. This will create a macro that records all of the attributes of your c
rent plot. To apply this macro/image to another dataset bring that dataset to
front, making it the active window. Then go to the Macros menu and choose
macro you have just made. If you want to change some of the labels, or cus
ize each one, you can edit the macro you made and use variables, or user pro
to customize each image/plot.Note:  If you give a new macro the name of an
existing macro, it will automatically overwrite the existing macro.

10. How can I make an animation with Transform?

To create an animation, make a series of images and save them as HDF file
animate a series of HDF files they must be numbered sequentially (e.g.,File1
File2.hdf, File3.hdf). For an example macro on how to create a series of HD
files, see the Advanced Macros section of Chapter 22.
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11. I'm trying to open a 2 MB TIFF image in Transform. I've given Transform 10 M
of RAM.  Why do I run out of memory before it opens?

You need to give Transform more memory. When Transform opens a TIFF, i
requires a great deal of RAM to process the image. Transform creates and d
plays a dataset that corresponds to the image and it displays the image. A 2
TIFF file requires about 15 MB of RAM to open and process. A good rule of
thumb to use when opening TIFF images is to give Transform RAM equal to
roughly 8 times the size of the TIFF you are opening. Transform stores numb
in 32-bit format, while some TIFF files can store numbers in as little as 4 bits

12. (Windows only) I have an image file that contains a picture of a map. When 
open the file and overlay it onto an image in Transform, the results look grea
However, when I try to print it, my machine crashes. Why?

It is not possible to print an image that has been overlaid onto another imag
order to print, the overlay must be displayed as a contour plot. To accomplis
this, follow these steps:

• Open the image file into Transform. You will get your image and a data
that is all zeros and ones.

• In the Notebook type:Overlay = your_image_datasetname * 255

• This will make a new dataset called "Overlay with all zeros and 255".

• Using the "Overlay" dataset, make a contour plot. In the Contour dialog,
"Number of Automatic Levels" to1, and choose "Set Auto Levels", then
OK .

• Create another new dataset by choosingNew from the File menu. Make it
3x3 and all zeros.

• Create a contour plot from this new dataset. The plot is blank.

• Remove the axis on the Overlay.contour plot, then copy it.

• ChoosePaste Overlay from the Edit menu to paste onto your blank
New.contour1 image.

• Save the new file with the contour image and overlay to an HDF file.

• Open the HDF file, copy the overlay of the map and paste onto your ima
You will now be able to print your image and overlay.
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13. When printing, I would like my image to be 4"x2" and centered on an 11"x8.
page. How can I do that?

This is best achieved using macros. Specifically, the "image_h", "image_v",
"image_marginleft", and "image_margintop" reserved variables can be used
create a custom macro with this functionality. See the description of the Prin
ing.txt macro in the Advanced Macro section of Chapter 22.

14. I have a set of files in a directory that I want to open, make an image from a
then save into a new directory. Is there a way I can automate this process?

The Transform macro language allows you to automate this process. Please
to the FileLoop.txt macro in the Advanced Macros section of Chapter 22. If yo
files do not automatically import into Transform, you may also need to look a
the ImportMacro.txt file.

15. I have a set of directories/folders that contain sets of files that I want to ope
make an image from and then save in new directories/folders. Is there a way I
automate this process?

The Transform macro language allows you to automate this process. Please
to the DirLoop.txt macro in the Advanced Macros section of Chapter 22. If yo
files do not automatically import into Transform, you may also need to look a
the ImportMacro.txt file.

16. I have a series of TIFF files that I want to convert to HDF files so that I can u
them in T3D to make a 3D visualization. How can I do this?

The Transform macro language allows you to automate this process. Please
to the Tiff to HDF.txt macro in the Advanced Macros section of Chapter 22.

17. I have a series of files that are not automatically imported into Transform. Is th
a way to avoid filling in all of the import information for each file?

The Transform macro language can automate the import of non-HDF files fo
you. Please refer to the ImportMacro.txt macro in the Advanced Macros sec
of Chapter 22.
Transform Part 4: Appendices Frequently Asked Questions



424 Appendix G: Troubleshooting

".

is is
d
ill

c
.
s cor-
 use
ans-
le

re-
oft-

text
18. Previously I was able to import my Matlab files into Transform for Windows,
now I get an error:

"Matlab files containing VAX/VMS D-float or G-float records are not supported

The header in the Matlab file shows:

MATLAB 5.0 MAT-file, Platform: PCWIN, Created on: Wed Apr 2 12:05:45 1997

How can I import this file into Transform?

The output format in Matlab Version 5 has undergone significant changes. Th
most likely why you get an error trying to import into Transform. To work aroun
this you can export files from Matlab 5 with a -v4 (version 4 flag) and the file w
load into Transform. The save command looks like this:

save \path\filename variable_name -v4

19. (Power Macintosh only)I have HDF files that are generated from Park Scientifi
instrumentation. When I open the files in Transform 3.4 the data is all wrong
When I open the files in the latest Noesys version, the dataset values appear
rect (the scale values are all the same number and appear to be wrong). If I
Save or Save As from the Noesys File menu and then try to open the file in Tr
form, again the data is still wrong. How can I look at my Park Scientific HDF fi
in Transform for Power Macintosh?

Park Scientific files are not written out with standard HDF library calls and the
fore do not import entirely correctly into HDF based programs from Fortner S
ware. To look at your Park Scientific HDF files in Transform you can use the
converter located in the ‘Extras’ folder of the Noesys CD. See the Read Me 
file provided for more details.
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20. (Power Macintosh only)In Transform 3.02 for the Macintosh, I used to be ab
to add entries to the Tables menu by using View Utility 3.01. Now, when I try
add a new color table to the Color Tables menu using View 3.03 it doesn't g
added to the Transform 3.4 Color Tables menu. How do I do this?

To add a View Utility color table directly onto the Transform Color Tables men
follow these steps:

• Create the color table in the View Utility (found in the‘Transform:Extras'
folder).

• Go to the Colors menu and choose Save Color Table... and save the fil
'Color.bin' as binary. The View Utility saves color tables as 8-bit unsigne
integers of 3 rows and 256 columns.

• Open the Color.bin file into Transform as a binary matrix, unsigned 8-b
integer, no skip bytes, 3 rows and 256 columns.

• Choose See Notebook from the Numbers menu.

• In the Notebook type these two lines and save them as a macro by choo
Create Macro... from the Macro menu.

mycolortable = transpose(var(currentdataset))
call savecolortable(var(currentdataset), "mycolortable")

• Select your macro from the Macro menu.

You have added the color table “mycolortable” to the Color Tables menu in
Transform for this session. If you always want this color table to appear on t
menu, create a Startup_Macro that automates this process. See Chapter 22
more information on Startup_Macros.
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hat
Other Problems

Please refer to the Transform Release Notes for additional help or information t
was not available when this manual was printed.
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The following list includes publications that you may find useful for background 
reference purposes.

• MathLink® Reference Guide (1990-1993). Wolfram Research.

• Firebaugh, M.W. (1993).Computer Graphics: Tools for Visualization. Wm. C.
Brown.

• Fortner, B.I. (1996).The Data Handbook: A Guide to Understanding the Organ
zation and Visualization of Technical Data.

• Fortner, B.I. and Meyer, T.E. (1996).Number by Colors: A Guide to Using Color
to Understand Technical Data.

• Franke, R. (1982). Scattered Data Interpolation: Tests of Some Methods. Mathe-
matics of Computation, Vol. 38, Number 157, (January 1982) pp. 181-195.
American Mathematical Society.

• Friedhoff, R.M, & Benzon, W. (1989).Visualization: The Second Computer Re
olution. W.H. Freeman.
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• Isaaks, E.H., & Srivastava, R. M. (1989).An Introduction to Applied Geostatis-
tics. Oxford University Press.

• Johnston, C. (1986).Contour Plots of Large Data Sets. Computer Language
(May 1986), 63-67.

• Kay, D.C., & Levine, J.R., (1992).Graphics File Formats. McGraw-Hill.

• Russ, J.C. (1992).The Image Processing Handbook. CRC Press.

• Sabin, M. (1986).Data Representation Graphics: A Survey of Contouring Me
ods. Survey paper of a Eurographic (UK) tutorial in the North Holland Comput
Graphics Forum 5 (September 1986), pp. 325-340.

• Tufte, E.R. (1983).The Visual Display of Quantitative Information. Graphics
Press.

• Wolff, R.S., & Yaeger, L. (1993).Visualization of Natural Phenomena.
Telos/Springer-Verlag.

• Wolfram, S. (1991). Mathematica: A System for Doing Mathematics by Com-
puter (2nd ed.). Addison-Wesley.
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A
Animation

line graph, 197
AppleEvents, 387
Aspect ratio, 92
Attributes, 39, 128
Axes, 164

color bar, 164
display, 164
font and size, 165
image title, 165
labels, 164, 165

C
Color, 169

binary color tables, 177, 178

change, 158, 172
color bar, 156, 164
Color Bar window, 180
color tables, 174, 178
compatibility, 182
contour plots, 179
copy color tables, 183, 252, 256
custom color table, 176
drag, 158
fiddle, 157
HDF, 177, 178
histograms, 180, 233
import color tables, 177
information, 181
KLUTZ color table, 178
load color table, 178
Macintosh System color table, 178
manipulate, 44
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new color table, 425
outliers, 50, 172, 183, 234
overlay, 163
paste color table, 256
restore, 158
rotate, 157
save color bar settings, 183
scaling, 171, 181
settings, 182
surface plots, 179, 222
View Utility , 186
visual data analysis, 170

Column data, 86, 129
Composite plot, 70, 71
Contour plots, 66

auto levels, 206
Contour tool, 202, 204
copy and paste, 208
labels, 68, 201
levels, 67, 203, 205
lines, 202, 206
macro, 296
min/max, 206
overlay, 69
resolution, 207

Copy As, 99, 251

D
Data

ASCII, 109
binary, 109
column, 110
manipulate, 135
matrix, 110
min/max, 94, 183
outliers, 183
region of interest, 181, 183, 185
samples, 28
set range, 184

web sites, 396
Dataset, 125

attributes, 128
change value, 52, 131, 136
close, 261
copy, 250
copy as, 251
display format, 38, 129
exchange data, 250
extract selection, 136
fill missing data, 97, 141
generate scales, 137
interactive selection, 40
interpolate, 139
MinMax tool, 131
missing data, 143
new, 127
number range, 126
open, 38, 127
paste, 254
properties, 126
range, 46
resample, 138
resample data, 239
save as, 257
scales, 129, 137
select grid, 139
Select tool, 131
selection, 131, 236
smooth, 138
tools, 131
window, 38

E
Expansion factor, 192, 352
Export

color tables, 177
file, 257

External functions, 407
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F
File

ASCII, 109
ASCII Special, 105
binary, 109
BMP, 106
column, 110
export, 257
GIF, 106
HDF, 103, 104, 105
import, 103
MATLAB , 112
matrix, 110
open, 104
PICT, 107
save, 260
types, 103

Fill missing data, 97, 141
kernel smoothing, 97, 142
Kriging, 146
linear interpolation, 142
methods, 141
nearest neighbor, 142
weighted fill, 142, 144

Format, 38, 129
exponential, 129
floating-point, 129
integer, 129
specifications, 129

H
HDF, 103, 104, 393

color tables, 177, 178
images, 105
libraries, 394
SDS record, 260
Vset, 105
web site, 396

HDF-EOS, 395
documentation, 395
libraries, 395
web site, 396

Histograms, 47, 231
outliers, 234

I
Image, 40, 151

aspect ratio, 92, 160
Axis tool, 164
circle size, 191
color, 179
color bar, 156
composite plot, 70, 71
contour plot, 66, 199
Contour tool, 202
copy, 250, 250, 252
copy as, 99, 251, 252
copy bitmap, 253
Fiddle tool, 157
fit to window, 76, 159
HDF, 105
histograms, 47, 231
interactive selection, 40
interpolated, 43, 189
line graphs, 61, 193
macro, 82
MinMax tool, 155
move, 160
overlay, 69, 98
paste, 254, 255
paste as, 255
paste overlay, 255
polar, 190
raster, 187
Resize tool, 159
save as, 259
Select tool, 154
simple, 152, 188
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size, 159, 160
surface plots, 73, 215
title, 165
tool palette, 41, 153
vector plot, 70, 209
Vector tool, 213

Image menu, 70
Import

3D matrix, 114, 115
ASCII Special, 105, 105, 112
automatic file types, 104
binary columns, 112, 119
binary matrix, 111, 115
BMP, 106, 106
color tables, 177
columns, 86, 114, 116
data placement, 89
delimiters, 116, 118
estimate sizes, 114, 118
files, 103
fill matrix, 122
FITS, 106
fixed field column, 117
GIF, 106, 106
HDF, 104
HDF images, 105
header lines, 114, 118
header titles, 118
MATLAB , 112, 112
multiple records, 108
number type, 115, 119
PBM, 107
PICS, 107
PICT, 107, 107
rows, 114, 116
select columns, 120
skip bytes, 116, 119
slices, 108
swap bytes, 116, 119
table format, 114
target matrix, 88, 121

text columns, 111, 116
text matrix, 111, 113
TIFF, 107
view file, 87, 123
XWD, 112

Installation, 24
Interpolated image, 189

K
Kernel convolutions, 400
Kernel functions, 399
Kernel smoothing, 97, 142
Kriging, 146

L
Line graphs, 61, 194

animation, 197
compare, 63
horizontal and vertical, 62
lock, 196
synchronize, 63

Linear interpolation, 142

M
Macros, 263, 305

advanced, 301
constants, 272
create, 294
custom, 289
data manipulation functions, 279, 310
dataset arrays, 273
delete, 295
deviation calculation, 58
difference calculation, 57
edit, 83, 294
errors, 270
execute, 267
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export, 296
external functions, 407
Fast Fourier Transforms, 315
Fourier Transform, 282
function commands, 275
functions, 306
image, 82
import, 295
kernel functions, 317
literals, 307
Mathematica, 382
mathematical functions, 308
mathematical operators, 271, 306
Print command, 269
rename, 295
reserved variables, 288, 325
scalar variables, 272
Startup_Macro, 291
subroutines, 285, 318
surface plot, 297
variables, 307
wave function, 59

Mathematica, 373
Transform for Macintosh, 381
Transform for Windows, 374

MathLink, 373
Transform for Macintosh, 381
Transform for Windows, 374

Menus, 361
Color Tables, 368
Edit, 363
File, 362
Help, 371
Image, 365
Macros, 367
menuID numbering, 392
menuItem calculation, 392
Numbers, 366
Tools, 369
Windows, 370

N
Nearest neighbor fill, 142
Noesys application, 110
Notebook, 55, 133, 264

calculations, 57, 57
comments, 56
copy, 250
font, 133
paste, 254

Number of Automatic Levels box, 206

O
Organize data, 31
Outliers

histograms, 234
Overlay, 161

contour plot, 69
create, 162
delete, 162
double, 163
fit to window, 161
macro, 296
Overlay tool, 99, 161
paste, 255
size to match, 161

P
Polar image, 190, 192
Preferences, 242, 244

upgrade, 24
Print, 345, 353

bitmap, 356
fonts, 353
headers and footers, 348
images, 354
interrupt, 351
line graphs, 357
line width, 354
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margins, 348
overlays, 356
page setup, 348
preview, 349
range, 347
setup, 346
to a file, 358
Transform for Macintosh, 352
Transform for Windows, 346
vector plots, 356
windows, 355

R
Raster image, 187
Resample data, 138
Rows, 129

S
Sample data, 28, 28
Saving, 260
ScriptEditor, 388
Selection, 236

extend, 238
synchronize, 238

Simple image, 188
Startup macro, 291
Surface plot, 73, 215

animation, 298, 300
average colors, 219
axes, 78, 218, 226
backstop, 78, 228
black & white, 221
color, 219, 222
decoration, 227
framed color, 223
grid lines, 77, 78, 219, 228
hi-res black & white, 77, 221

hi-res color, 77, 223
label, 80
macro, 82, 297
orientation, 216
parallax, 219
parameters, 218
resize, 75, 76
rotate, 74
scaling, 225
sizing, 76, 229
skirt, 78, 228
spacing, 77
surface decorations, 78
types, 77, 80, 220
wireframe, 77, 220

Synchronize
data, 238
windows, 53, 63

T
Tile windows, 240
Transform

launch, 37
preferences, 25
upgrade, 24

Troubleshooting, 413
color palette, 415
frequently asked questions, 418
HDF libraries, 417
slow performance, 416
video driver, 414

U
Upgrade

Transform, 24
Upgrading Transform, 24
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V
Vector plots, 209

arrow size, 210
arrow type, 214
origin, 210
Vector tool, 213

View Utility , 186, 425

W
Web sites

download data, 396
Earth Science Enterprise, 396
HDF, 396

HDF-EOS, 396
Weighted fill, 142

parameters, 144
Windows

hide, 240
menu, 240
multiple, 53
name, 240
organization, 31
select, 240
selection, 236
synchronize, 53
tile, 53, 240
update, 132
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